# Table of Contents

1 **Introduction** ................................................................. 1  
   1.1 Welcome to DPL 7 ..................................................... 1  
   1.2 How to get Help with DPL ......................................... 3  
   1.3 Installation ............................................................... 4  
   1.4 A Brief Tour of DPL .................................................. 4  
   1.5 What's New in DPL 7 ................................................ 12  

2 **Building Decision Analysis Models** ........................... 15  
   2.1 Value Nodes and Node Data ......................................... 15  
   2.2 Arcs ........................................................................... 24  
   2.3 Running a Model ......................................................... 27  
   2.4 Decision Nodes .......................................................... 29  
   2.5 Value Tornado Diagram .............................................. 43  
   2.6 Discrete Chance Nodes ............................................... 50  
   2.7 Base Case Tornado Diagram ....................................... 59  
   2.8 Initial Decision Alternatives Tornado ......................... 64  

3 **Decision Analysis Results** ............................................ 67  
   3.1 Policy Tree™ ............................................................. 71  
   3.2 Risk Profile .............................................................. 78  
   3.3 Policy Summary™ ..................................................... 85  
   3.4 Expected Value of Perfect Information / Control ............. 107  
   3.5 Value Correlations ...................................................... 109  
   3.6 Rainbow Diagram on a Value ..................................... 112  
   3.7 Rainbow Diagram on a Probability ............................. 116  

4 **Building Models from Spreadsheets** ........................... 121  
   4.1 Creating a Model from Excel ....................................... 121  
   4.2 Running a Model ....................................................... 133  
   4.3 Running a Value Tornado to Identify Key Value Drivers .... 137  
   4.4 Creating a Probabilistic Model .................................... 142  
   4.5 Adding Decision Nodes to a Model Created from Excel .... 162  
   4.6 Running the Model with Decision Node Added .............. 183  
   4.7 Adding Initialization Links to the Model ...................... 196  

5 **Building and Analyzing Monte Carlo Simulation Models** .... 205  
   5.1 The Excel Cash Flow Model .......................................... 206  
   5.2 Creating Linked Values .............................................. 208  
   5.3 Arranging the Influence Diagram .................................. 213  
   5.4 Running a Value Tornado Diagram ............................... 215  
   5.5 Using the Workspace Manager .................................... 219  
   5.6 Running a Monte Carlo Simulation ............................... 221  
   5.7 Comparing Risk Profiles ............................................ 227  
   5.8 Modeling an Up-Front Decision ................................. 232  
   5.9 Performing a Sensitivity Analysis ................................. 240  
   5.10 Modeling a Downstream Decision ............................... 243
Table of Contents

Syncopation Software

6  Asymmetric Trees ................................................................. 249
   6.1  Eliminating Redundant Paths .............................................. 249
   6.2  Using Multiple Get/Pay Expressions .................................. 265
   6.3  Adding a Downstream Decision ........................................... 272

7  Conditioning and Learning in Decision Models ..................... 285
   7.1  Incorporating Imperfect Information in a Model .................. 286
   7.2  Summary of DPL Influence Arcs ......................................... 304

8  Risk Tolerance ....................................................................... 307
   8.1  Incorporating a Risk Tolerance ............................................ 307
   8.2  Advanced Utility Functions .................................................. 314

9  Sensitivity Analyses ............................................................. 317
   9.1  Two-Way Rainbow Diagrams .............................................. 317
   9.2  Event Tornadoes ................................................................. 326
   9.3  When to Use Which DPL Sensitivity Output ......................... 332

A  Overview of Spreadsheet Linking .......................................... 335
   A.1  Types of Spreadsheet Links in a DPL Model ....................... 335
   A.2  Calculation Links ............................................................... 336
   A.3  Initialization Links ............................................................. 344
   A.4  Managing Spreadsheet Links ............................................... 352

B  System Requirements and Compatibility with Older Releases .... 355

C  Keyboard Shortcuts ............................................................ 357

D  Glossary of DPL and Decision Analysis Terms ....................... 359

Index ....................................................................................... 383
1 Introduction

1.1 Welcome to DPL 7

Welcome to the growing family of DPL users!

If you're a new user, we're confident that DPL's power and flexibility will exceed your expectations. If you've used DPL in the past, we think you'll enjoy discovering the new features and capabilities we've added in DPL 7.

The DPL modeling environment was designed to give you the capabilities you need to focus on the problem at hand -- the task and not the tools. This guide is an extension of that perspective, teaching you essential DPL skills in the context of simple but realistic decision models.

This *DPL Standard Manual* is divided into 9 tutorial chapters plus an Appendix. If you are new to DPL, you should find that these chapters provide a thorough introduction to the skills you will need to use DPL 7 Standard effectively.

The remainder of this section briefly describes what is contained within this manual. The subsequent sections of this chapter describe how to get online help and technical support, DPL installation, and a brief tour of DPL. The final section lists new features in DPL 7.

This manual focuses on DPL's graphical model development environment. It is intended to be read while working with DPL. The chapters in this manual contain tutorials that will give you the essential tools needed to develop real world decision problems in DPL. These chapters are written with a new user to DPL in mind. Various sections of these chapters do, however, assume a basic knowledge of decision analysis, Excel, valuation techniques and Monte Carlo simulation.

Chapters 2 and 3 contain a tutorial focused on building and analyzing a decision analysis model in DPL. Even if you intend to use DPL for risk analysis or valuation purposes many of the topics covered in these chapters will be useful to you.
Chapter 4 contains a tutorial focused on building a model primarily for valuation purposes. This tutorial also demonstrates how to build a DPL model from an Excel spreadsheet financial model. Topics related to how to build a DPL model from Excel will be of interest even if you don't intend to build valuation models in DPL.

Chapter 5 contains a tutorial focused on building and analyzing a Monte Carlo simulation risk analysis model in DPL based on an Excel cash flow model.

Chapters 6 through 9 cover more advanced topics and assume that you are already familiar with DPL or have read one or more of the earlier chapters in this guide.

Chapter 6 demonstrates how to build and run asymmetric decision trees. Although simple symmetric trees are useful in some situations, many real-world problems are best modeled and communicated using asymmetric tree structures.

Chapter 7 is an introduction to the more complex decision models and situations that can be handled using DPL's modeling environment, including probabilistic conditioning, Bayesian updating, and learning models.

Chapter 8 shows you how to use DPL to model attitudes toward risk and make decisions based on criteria beyond expected value. Utility functions are introduced in this chapter.

Chapter 9 covers advanced sensitivity analysis features in DPL, including two-way Rainbow Diagrams and Event Tornado Diagrams. Chapter 9 also contains guidance about when to use each type of sensitivity analysis.

A few conventions have been used in the text that follows. An instruction to you in a tutorial will be contained in a bulleted paragraph. Information to be entered in edit boxes, Excel cells, etc. is contained within double-quotes. Do not include the double-quotes when entering the information.
1.2 How to get Help with DPL

Online help contains detailed descriptions of DPL features as well as a reference section for DPL dialogs. Descriptions of how DPL performs various calculations and how to interpret each of DPL’s outputs are also in online help.

Online help also contains a listing of common error and warning messages that may be generated by DPL.

You can also obtain technical and installation support by emailing support@syncopation.com. Support resources such as technical notes, case studies, and an extensive glossary of terms pertaining to DPL and decision analysis, are available on our website: www.syncopation.com.

Perpetual licenses of DPL include 90 days of maintenance and technical support (MTS) to help you get started with DPL. MTS includes phone and email support, maintenance releases and upgrades to major product releases. Following the first 90 days, MTS can be purchased on an annual basis. If you anticipate needing longer-term support with DPL and/or you wish to stay current with all product upgrades, we recommend you consider purchasing MTS. More information is available at www.syncopation.com or by emailing sales@syncopation.com. Annual licenses include MTS.

The quickest, most efficient way to become proficient with DPL is to attend a training course. Syncopation offers DPL training courses a few times a year at various locations. Custom training seminars can be provided as well. Please contact us at sales@syncopation.com if you are interested in DPL training.
1.3 Installation

If you have not already installed DPL, do so now.

⇒ If you purchased a DPL 7 installation CD, insert it into your CD/DVD drive.

⇒ If the setup program does not launch automatically, double-click on DPL7.msi in the root directory of the CD from Windows Explorer.

⇒ Follow the on-screen instructions.

1.4 A Brief Tour of DPL

Load DPL by double-clicking the icon on your desktop (Desktop icon), double-clicking the icon in Windows Explorer, or launching it from the Start Menu.

DPL will load with an empty Model Window maximized on the right-hand side of the screen. On the left-hand side will be the Workspace Window. At the bottom of the Workspace Window are two tabs: 1) the Workspace Manager ("Manager"), and 2) the Session Log ("Log"). See Figure 1-1.
Chapter 1: Introduction

Figure 1-1. New Workspace with Empty Model Window

The Workspace Manager displays all the documents in the open Workspace in a Windows Explorer style folder structure. The top level is the Workspace. Below the Workspace will be displayed all the models in the Workspace. Below each model will be displayed the outputs and other items associated with each model. Currently there is only one model (Model1) in the Workspace.

Right-click on the icon for Model1 to see the context menu for a model. Notice that you can delete, rename or duplicate a model, or you can make it Main.

Within a DPL Workspace, you can develop, run, and store results and outputs from multiple models. However, only one model can be the Main model at a given time. The Main model is the model currently selected to be run (using Run | Decision Analysis or another Run command from the main menu).
The ability to run, analyze, and save certain types of results from multiple models simultaneously within a single Workspace is new to DPL 7. If you have used previous versions of DPL, you will find it much easier to work with multiple models. Model output documents, including Policy Trees™, Policy Summaries™, Risk Profiles and others, can be saved by simply right-clicking on the document and renaming it.

The Session Log displays information about the current session. Currently, it displays information about the version of DPL you are running and to whom the software is licensed. See Figure 1-2. As you build models and run analyses, further information such as compilation messages and the expected value of a model are written in the Session Log. Error messages are also written in the Session Log. The Session Log is cleared each time you close DPL and each time you open a new Workspace.

The Workspace Window can be undocked and left floating or moved and docked to the right-hand side of the screen.
To undock the Workspace Window, click and drag on the top gripper bar of the Workspace Window. Drag it away from its location. Once you have dragged it far enough to undock, the drag window outline will change.

Once the drag window outline has changed, release the mouse button. The Workspace Window will float.

Re-dock the toolbar at the left by clicking and dragging on the window title bar.

Drag it to the left.

Once the dragging window outline has changed to a thin border, release the mouse button. The Workspace Window will re-dock.

The Workspace Window can also be hidden / unhidden by using View | Workspace Window.

The Model Window is divided into two different panes: 1) the Influence Diagram Pane at the top and 2) the Decision Tree Pane at the bottom. The two panes are divided by a splitter, which can be moved up or down. You can also change the splitter to split the screen vertically by using View | Split Vertically.

To change back and forth between panes, press the Tab button or use View | Decision Tree (Influence Diagram). The active pane is indicated by a magenta outline around the edge of the pane.

At the top of the screen are two sets of toolbars. The one on the left is the Main Toolbar. It contains standard buttons for creating a new Workspace, opening Workspaces, saving Workspaces, copying, pasting, printing and zooming. The zooming buttons, their names and the action associated with each are described in the table below.
### Table 1-1. Zoom Buttons on the Main Toolbar

The toolbar on the right is called the Model Toolbar and contains a number of buttons for actions that are specific to DPL. The buttons, their names and the action associated with each are described in the table below.

<table>
<thead>
<tr>
<th>Button or Drop-down Box</th>
<th>Name</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Zoom In</td>
<td>Zoom the active pane of the Model Window in to make the nodes larger and see less of the influence diagram/decision tree.</td>
</tr>
<tr>
<td></td>
<td>Zoom Out</td>
<td>Zoom the active pane of the Model Window out to make the nodes smaller and see more of the influence diagram/decision tree.</td>
</tr>
<tr>
<td></td>
<td>Zoom Full</td>
<td>Zoom the active pane of the Model Window so that all of the influence diagram / decision tree is visible.</td>
</tr>
<tr>
<td></td>
<td>Zoom Previous</td>
<td>Return to the previous zoom.</td>
</tr>
<tr>
<td></td>
<td>Zoom Drop-down Box</td>
<td>Click to select or enter a custom zoom level (e.g., 95%).</td>
</tr>
<tr>
<td>Button</td>
<td>Name</td>
<td>Action</td>
</tr>
<tr>
<td>--------</td>
<td>-----------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td><img src="image1.png" alt="Button" /></td>
<td>Create Decision</td>
<td>Create a new decision node in the Influence Diagram Pane.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Button" /></td>
<td>Create Discrete Chance</td>
<td>Create a new discrete chance node in the Influence Diagram Pane.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Button" /></td>
<td>Create Continuous Chance</td>
<td>Create a new continuous chance node in the Influence Diagram Pane.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Button" /></td>
<td>Create Value</td>
<td>Create a new value node in the Influence Diagram Pane.</td>
</tr>
<tr>
<td><img src="image5.png" alt="Button" /></td>
<td>Create Strategy Table</td>
<td>Create a new strategy table node in the Influence Diagram Pane.</td>
</tr>
<tr>
<td><img src="image6.png" alt="Button" /></td>
<td>Change Node Type</td>
<td>Change the type of a node in the Influence Diagram Pane.</td>
</tr>
<tr>
<td><img src="image7.png" alt="Button" /></td>
<td>Create Text Block</td>
<td>Create a text block in the active pane of the Model Window.</td>
</tr>
<tr>
<td><img src="image8.png" alt="Button" /></td>
<td>Create Influence</td>
<td>Create a new influence arc in the Influence Diagram Pane.</td>
</tr>
<tr>
<td><img src="image9.png" alt="Button" /></td>
<td>Edit Node Definition</td>
<td>Edit a node's definition.</td>
</tr>
<tr>
<td><img src="image10.png" alt="Button" /></td>
<td>Add Decision to Tree</td>
<td>Add a decision node instance to the Decision Tree Pane.</td>
</tr>
<tr>
<td><img src="image11.png" alt="Button" /></td>
<td>Add Chance to Tree</td>
<td>Add a chance node instance to the Decision Tree Pane.</td>
</tr>
<tr>
<td><img src="image12.png" alt="Button" /></td>
<td>Edit Get/Pay</td>
<td>Edit the branch definition of a node in the Decision Tree Pane.</td>
</tr>
<tr>
<td><img src="image13.png" alt="Button" /></td>
<td>Branch Control</td>
<td>Control a node to a state in the Decision Tree Pane.</td>
</tr>
<tr>
<td><img src="image14.png" alt="Button" /></td>
<td>Reorder Nodes</td>
<td>Reorder Nodes in the Decision Tree Pane.</td>
</tr>
<tr>
<td><img src="image15.png" alt="Button" /></td>
<td>Perform Subtree</td>
<td>Perform a subtree in the Decision Tree Pane.</td>
</tr>
<tr>
<td><img src="image16.png" alt="Button" /></td>
<td>Detach Node</td>
<td>Detach a node in the Decision Tree Pane.</td>
</tr>
</tbody>
</table>

Table 1-2. Model Toolbar Buttons
At any given time, not all of these buttons will be enabled since some of them are context specific. For example, the Edit Node Definition button is only enabled when you have a node selected in either the Influence Diagram or Decision Tree Pane.

You will now check that several options are set in specific ways so that as you work with DPL, what you see on your screen will be similar to the images in this manual. In DPL 7, there are two places to set options: Tools | Options, which are global options, and Model | Options, which are specific to each model. We will discuss Model | Options later in this manual.
Select Tools | Options. The Options dialog appears as shown in Figure 1-3.

Figure 1-3. Options Dialog with General Tab Selected

- Make sure that Show Tips is checked.
- Select the Outputs tab.
- Make sure that Decimal places is set to 3.
- Make sure that Display probabilities as percentages is checked.
- Make sure that Decimal places for probabilities is set to 0. The Outputs tab should look like Figure 1-4.
1.5 What's New in DPL 7

This section is intended as a reference for users of previous versions of DPL. A list of some of the new features of DPL 7 is provided below. If you are a new DPL user, you may skip this section.

Please note that DPL 7 Professional contains all of the features of DPL 7 Standard, as well as the features shown on the DPL 7 Professional list. The new features included in DPL 7 Professional are provided in Section 1.2 of the DPL Professional Manual. If you are a DPL 7 Standard user with questions about what is provided in DPL 7 Professional, please consult Syncopation's website: www.syncopation.com, or email Syncopation Sales: sales@syncopation.com.
1.5.1 New Features in DPL 7 Standard

- DPL models can now be imported from a saved .DA file into your current Workspace using File | Import.

- Setting up and running Value and Base Case tornado diagrams is quicker and more intuitive with new dialog boxes.

- There is a new type of tornado diagram, Initial Decision Alternatives Tornado, which helps you to understand the relative impacts of value drivers on alternative strategies.

- Detailed distribution statistics, including variances and percentiles, are now available for Risk Profiles.

- Policy Trees™ and Policy Summaries™, as well as Risk Profiles, can be renamed, saved, and used for comparison with future model runs.

- There is a new output called Value Correlations which helps you understand and visualize the relationships between values in your model and the objective function.

- Get/Pay expressions are now easier to set up and edit.

- You can now select multiple nodes in the influence diagram to move them, delete them, copy and paste them or even change their type.

- Convenient new formatting options are available to make Policy Trees™, Time Series Percentiles, and other outputs easier to interpret and use in presentations.

- The above features, and many other new features, are demonstrated and explained throughout the chapters of this manual.
www.syncopation.com
2 Building Decision Analysis Models

This tutorial focuses on building a stand-alone DPL model for a simple decision analysis application. The tutorial will familiarize you with key DPL features by providing step-by-step guidance on how to create a DPL model from scratch, modify the model and generate results.

2.1 Value Nodes and Node Data

You will start to develop a decision model by adding value nodes to the influence diagram. A value node is a constant (i.e., a number) or calculated quantity (i.e., a formula) in a DPL decision model. Value nodes are represented by rounded blue rectangles in the Influence Diagram Pane.

Load DPL.

DPL will load in a maximized state with an empty Model Window maximized on the right-hand side of the screen as shown in Figure 2-1.
Drag the splitter down so that the Influence Diagram Pane occupies approximately three quarters of the Model Window (for the moment, you will be mostly working in the Influence Diagram Pane).

To create a value node, make sure the Influence Diagram Pane is active (you can tell it is active by looking for a magenta border around the pane; if it isn't active click anywhere in it or press Tab).

Click the Create Value toolbar button (see Table 1-2) or select Node | Create Value.

The mouse cursor will turn into a crosshair with the outline of a value node to indicate that you are about to place a value node into the Influence Diagram Pane. See Figure 2-2.
Click the mouse anywhere in the Influence Diagram Pane.

The Node Definition dialog appears with the General tab selected. See Figure 2-3. The Name edit box will have the focus and the default name "Value1" will be selected for editing.
Chapter 2: Building Analysis Models

Syncopation Software

Type "Sales" and click the Data tab. See Figure 2-4.

The Data tab displays a data input tree for the value node and allows you to enter the data for this node. There are a number of buttons on the Data tab which allow you to change items such as the node's conditioning; to view things differently by changing the zoom or going to full screen; or to help you input the data for this node by selecting values. You will learn more about these buttons later.

Type "40" into the Value edit box below the buttons at the top of the dialog as indicated in Figure 2-4.

Click OK to close the dialog.
Repeat the above create value node process to create three more value nodes with names and data as indicated in Table 2-1.

<table>
<thead>
<tr>
<th>Name</th>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Per Unit Costs</td>
<td>0.8</td>
</tr>
<tr>
<td>Marketing Costs</td>
<td>15</td>
</tr>
<tr>
<td>Price</td>
<td>2</td>
</tr>
</tbody>
</table>

Table 2-1. Value Node Names and Data
When you are done creating the three additional value nodes your model should look something like Figure 2-5.

![Model with Four Value Nodes](image)

**Figure 2-5. Model with Four Value Nodes**

- Create another value node.
- Name it "Production Costs".
- Select the Data tab. This time you will enter a formula for the node's data.
- Click the select Variable button ( ). The Select Variable dialog will come up with a list of all the variables currently defined in the model.
- Select Per_Unit_Costs from the list. See Figure 2-6.

Note: DPL replaces spaces and punctuation marks with underscores "_" in multiple word names so the value Node "Per Unit Costs" is referred to as "Per_Unit_Costs" by DPL. Using the Select Variable dialog saves typing, reduces errors from misspellings and prevents you from having to remember the names of all the variables in your model. DPL variable names are case sensitive; "Costs" is different from "costs".
Click OK to close the Select Variable dialog. You will be returned to the Data tab of the Node Definition dialog. Per_Unit_Costs will be filled into the Value edit box.

Type "*" after Per_Unit_Costs for multiplication.
Click ( ) for the Select Variable dialog.

Double-click on Sales in the list. The Select Variable dialog closes and the Data for Production Costs should now read Per_Unit_Costs*Sales.

Click OK to close the Node Definition dialog.

Repeat the above process to create three more nodes with names and data as indicated in Table 2-2.

<table>
<thead>
<tr>
<th>Name</th>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revenues</td>
<td>Price*Sales</td>
</tr>
<tr>
<td>Costs</td>
<td>Marketing_Costs+Production_Costs</td>
</tr>
<tr>
<td>Profit</td>
<td>Revenues-Costs</td>
</tr>
</tbody>
</table>

Table 2-2. Value Nodes and Formula Data

Your model should now look something like Figure 2-7. Note that if you hold your mouse cursor over one of the nodes you just created, you will see a box containing the node data (the value or formula it represents).
At this point, you may want to name your model and save your Workspace file.

- Select the item for the model in the Workspace Manager.
- Press F2 or click on the model item again to edit the name.
- Type "License vs. In-house" or any other name you’d like.
- Press Enter to save the edit.
- Save the Workspace and give it a name of your choice.
2.2 Arcs

You will now add some influence arcs to the decision model. Influence arcs indicate one or more of three things to DPL: 1) dependency 2) conditioning and/or 3) timing. (Note: see the Glossary of DPL and DA Terms for definitions of dependency and conditioning.) You saw an example of dependency when you created the Production Costs node. The data for Production Costs depends on the data for Per Unit Costs and Sales. Influence arcs are useful because they indicate to anyone looking at an Influence Diagram which nodes depend on or are conditioned by other nodes. You will start by creating an influence arc between Sales and Production Costs.

To create an influence arc, click the Create Influence button on the toolbar (see Table 1-2) or select Influence | Create. The mouse cursor changes to the begin arc cursor (\(\rightarrow\)).

Place the cursor over the Sales node and click. Now the cursor changes to the end arc cursor (\(\rightarrow\)) and an arc is anchored at the Sales node. Sales is called the predecessor node for this arc.

Place the cursor over the Production Costs node and click. An influence arc is drawn from Sales to Production Cost. See Figure 2-8. Production Cost is called the successor node for this arc.
Figure 2-8. Model with Influence Arc from Sales to Production Costs

An influence arc that points from node A to node B indicates that node B depends on, is conditioned by and/or occurs before node A. In Figure 2-8, the influence arc you just added indicates that Production Costs depends on Sales.

Note: DPL indicates which arc is selected by coloring it magenta. In general, DPL indicates which item is selected in the Influence Diagram Pane or Decision Tree Pane by coloring the item magenta.

Since you have already entered formulas into a number of nodes in your model, there is an easy way for you to have DPL automatically generate influence arcs.
Select Influence | Construct from Formulas. See Figure 2-9.

**Figure 2-9. Influence | Construct from Formulas**

DPL generates the influence arcs from the formulas found in the node data. Your model should now have all the arcs shown in Figure 2-10.
2.3 Running a Model

You are now at the point where you can run the model. You may wish to save your Workspace before running the model.

Select Run | Decision Analysis. The Model Get/Pay dialog appears as shown in Figure 2-11. There is one last piece of information you must confirm for DPL: which is the variable in the model that should be used as the output of the model. DPL suggests Profit, which is correct.
Chapter 2: Building Analysis Models

Figure 2-11. Model Get/Pay Dialog

Click OK to close the Model Get/Pay dialog.

The Decision Analysis Options dialog appears as shown in Figure 2-12. There are a number of different settings on the Decision Analysis Options dialog. We will cover them later. For now, uncheck Risk Profile (this output would be uninteresting now).

Figure 2-12. Decision Analysis Options Dialog

Click OK to close the Decision Analysis Options dialog.

DPL runs the model and brings up the Analysis Complete dialog. See Figure 2-13.
You will not normally see the Analysis Complete dialog since it is only displayed if no other outputs are requested in the Decision Analysis Options dialog. In this instance, the model is deterministic; it does not yet include any uncertainty (i.e., it contains no chance nodes, which you will learn about in Section 2.6) so the expected value is just the calculated value of Profit, which you specified as the output of the model in the Model Get/Pay dialog.

⇒ Click OK to close the Analysis Complete dialog.

2.4 Decision Nodes

You will now enhance your decision model by adding a decision node. A decision node has two or more alternatives. DPL will choose the decision alternative that maximizes the output of the model (referred to as the objective function). A decision node is represented in the influence diagram by a yellow square.

⇒ To create a decision node, click the Create Decision button (see Table 1-2) on the toolbar.

⇒ Click anywhere in the Influence Diagram Pane. The Node Definition dialog appears.

⇒ Type "Product Strategy" for the Name of the node. DPL will automatically split the node name into multiple lines.

Note: there is an Alternatives list box on the General tab of the Node Definition dialog for a decision node. You can add, delete, insert or rename decision alternatives. By default, DPL has created two decision alternatives and named them "Yes" and "No". These settings can be changed in the Tools | Options dialog on the General tab (Tools | Options | General).
Also, the first decision alternative ("Yes") is designated as the "default" alternative. You don't need to worry about this right now. Default alternatives are relevant in some asymmetric models, which are discussed later in this manual.

Select the Yes alternative, type "In-house" to rename it. Note: you may also click the Rename button or press F2 to edit an alternative name.

Rename the No alternative to "License".

Your node definition dialog should now look like Figure 2-14.

![Node Definition Dialog](image)

Figure 2-14. Node Definition Dialog for a Decision Node

Click OK to close the Node Definition dialog. Your model should now look something like Figure 2-15.
In the Decision Tree Pane, DPL has begun to build a decision tree for you. This decision tree is called the Default Tree. Up to this point, your model had no decision nodes in it (and no chance nodes, which we will cover soon) so DPL did not build a Default Tree for you. If you do not modify the decision tree in the Decision Tree Pane yourself, DPL will continue to build a Default Tree for you. If you build your model entirely from the Influence Diagram Pane and find once it is completed that the nodes in the Default Tree are in the right sequential order and that it has the structure you want, then there is no need to change the Default Tree. Once you modify the Default Tree, you have taken control and DPL will no longer build a Default Tree for you. However, you can always ask DPL to create the Default Tree from the current influence diagram by selecting Model | Rebuild Default Tree.

As in the Influence Diagram Pane, DPL uses yellow squares to represent decisions in the Decision Tree Pane. DPL uses blue triangles to indicate endpoints (sometimes called leaf nodes) in the Decision Tree Pane.

In order to incorporate the new decision into your model, you will need to add one additional node.
Click the Create Value button (see Table 1-2) on the toolbar.

Click anywhere in the Influence Diagram Pane. The Node Definition dialog appears.

Type "License Fee" for the node name.

Switch to the Data tab.

Type "0.75" for the node data.

Click OK to close the Node Definition dialog.

Click the Create Influence button on the toolbar (see Table 1-2).

Draw an influence arc from License Fee to Revenues: click on License Fee, then click on Revenues.

Note: Another way to draw an influence arc is to hold down the Shift key, click on the first node (such as License Fee), and then click on the second node (such as Revenues).

You will now edit the definition of Revenues to incorporate the Product Strategy decision.

Double-click the Revenues node. The Node Definition dialog appears with the Data tab selected.

Click the Conditioning button. The Conditioning dialog appears. See Figure 2-16.

![Conditioning: Revenues](image)

**Figure 2-16. Conditioning Dialog**
Click the checkbox next to Product Strategy so it is checked as shown in Figure 2-16.

Click OK to close the Conditioning dialog.

The Node Definition dialog Data tab now indicates that two values are required for Revenues: one for the In-house alternative of the Product Strategy decision and a second for the License alternative. DPL has copied the formula that was specified when the Revenues node was not conditioned on anything to both entries. See Figure 2-17. DPL indicates the currently selected entry by coloring it magenta in the data input tree.

**Figure 2-17. Node Definition Data Tab for Revenues after Conditioning**

Use the down arrow to move the selection to the entry for License.

Select Price in the Value edit box.
Click the select Variable button ( страны ) and double-click License_Fee in the list in the Select Variable dialog. DPL replaces Price with License_Fee.

Press Enter. Your data input tree for Revenues should now look like Figure 2-18.

Figure 2-18. Final Data Input Tree for Revenues Node

You have now told DPL that when Product Strategy is in the In-house alternative, Revenues is equal to Price * Sales, whereas when Product Strategy is in the License alternative, Revenues is equal to License_Fee * Sales.

Click OK to close the Node Definition dialog. Your model should now look something like Figure 2-19.
Note that DPL has drawn an influence arc from Product Strategy to Revenues to indicate that Product Strategy conditions Revenues. Also note that the arrowhead of the arc is colored. DPL uses a blue arc arrowhead to indicate that the values of Revenues depend on which state or alternative Product Strategy is in. Arc arrowhead colors are covered in more detail in Sections 3.3 and 7.2.

![Figure 2-19. Model with Influence Arc from Product Strategy to Revenues](image)

DPL has also updated the Default Tree. It has added Profit as a get/pay expression for the decision node Product Strategy. A get/pay expression tells DPL what value to get (i.e., you receive) or pay (i.e., you pay out) at each point in the tree. Get/pay expressions will be covered in more detail in Chapter 6. By creating an influence arc from Product Strategy to Revenues, DPL determines that your get/pay expression should be Profit. In the Decision Tree Pane, the get/pay expression is displayed below the branch on which it occurs in the decision tree. For now, leave the get/pay expression as is. Value nodes are not displayed directly in the Decision Tree Pane; rather, the names of value nodes appear in get/pay expressions on branches in the decision tree.
You will now neaten up your model by bending the arc from Product Strategy to Revenues.

Select the influence arc with the left mouse button and without releasing the mouse button begin to drag the arc. The mouse cursor will change to the arc bend cursor (\(\bigcirc\)).

Continue dragging and your arc will look something like the arc in Figure 2-20. Release the mouse when the arc is bent how you want.

![Figure 2-20. Bending an Influence Arc](image)

Release the mouse button. Your model should now look like Figure 2-21.
You will now use a slightly different procedure to condition Costs on Product Strategy.

1. Click the Create Influence button on the toolbar (see Table 1-2).
2. Draw an arc from Product Strategy to Costs: click on Product Strategy, then click on Costs.
3. Double-click the new influence arc. The Value Influence Type dialog appears.
4. Check the Different values for each conditioning event state check box as shown in Figure 2-22.
5. Click OK to close the Value Influence Type dialog.
You have now told DPL that Costs is conditioned by Product Strategy.

Double-click Costs. The Node Definition dialog appears with the Data tab selected.

Note that DPL has changed the node data input tree so that it is conditioned on Product Strategy and has copied the initial formula for Costs to each of these data entry slots.

Arrow down to select the License alternative.

Type "0" and press Enter. Your node data input tree should look like Figure 2-23. (This is a very simple model; if Product Strategy is in the License alternative, Costs equal zero.)
Click OK to close the Node Definition dialog.

If you wish, bend the influence arc from Product Strategy to Costs. Your model should now look something like Figure 2-24.
Chapter 2: Building Analysis Models

Syncopation Software

Figure 2-24. Model with Conditioning from Product Strategy Decision

Now that you have added a decision to your model, you will run it again. You may wish to save the workspace first.

Select Run | Decision Analysis or press F10 (F10 is the shortcut for Run | Decision Analysis). The Decision Analysis Options dialog appears.

Note that now a number of additional items are enabled.

Make sure Evaluation method is set to Fast sequence evaluation.

If Risk Profile is checked, uncheck it.

If Policy Tree™ is unchecked, check it. The dialog should look like Figure 2-25.
Click OK. DPL runs the model with the newly added decision node and produces the Policy Tree™ output that you requested. See Figure 2-26.
DPL has created an item in the Workspace Manager for the Policy Tree™, which displays information in a decision tree format about the results of the decision analysis. The first thing to note is the structure of the Policy Tree™. It displays the Product Strategy decision you added to the model with each of its branches and a blue triangle at the end of each branch. As mentioned previously, the blue triangle is DPL’s representation for an endpoint. As the model currently stands and given the settings in the Decision Analysis Options dialog, the Policy Tree™ has two endpoints: one for the In-house branch and one for the License branch.

The Policy Tree™ also displays the expected value (or rolled back expected value) at each point in the tree in square brackets ([ ]). The [33.000] next to Product Strategy is the expected value of the objective function for the complete model or tree. Look further down the tree to the two rolled back expected values that appear next to each blue triangle and you see that the expected value at the endpoint for In-house is 33 and the expected value for the endpoint at License is 30. As mentioned in Section 2.4, DPL maximizes the objective function of a model. Therefore when confronted with a decision with two alternatives, one of which has a rolled back expected value of 33 and the other a rolled back expected value of 30, DPL
chooses the alternative with a rolled back expected value of 33. This can be seen in the Policy Tree™, not only by the [33.000] next to Product Strategy, but also by the In-house branch of Product Strategy being displayed with a thick branch. DPL indicates the optimal alternative of a decision at each point in the Policy Tree™ by displaying the optimal alternative with a thick branch. Recall that 33 is the same expected value result from when you ran the model in Section 2.3. So the model has not changed much from how it was originally constructed. The optimal decision alternative is to produce the product in-house.

Policy Trees™ will be covered in more detail in Section 3.1.

2.5 Value Tornado Diagram

You may want to know how sensitive the decision to produce the product in-house is to changes in value for the variables in your model. This can be accomplished by running a Value Tornado.

Select Run | Tornado Diagram or press F8 (F8 is the shortcut for Run | Tornado Diagram). You will see the Value Tornado Setup dialog as shown in Figure 2-27.
Chapter 2: Building Analysis Models

Syncopation Software

Chapter 2: Building Analysis Models

Syncopation Software

Figure 2-27. Value Tornado Setup Dialog

Note that since the model is deterministic (has only value nodes), the Value Tornado diagram is the only type of tornado diagram available at this point. The Value Tornado Setup dialog provides a table in which to enter the low and high settings (range) for each value node that is not a formula in the current model. DPL has also filled in the Current setting for each variable in the table.

You will now enter the range for each of the value nodes shown in Figure 2-27.

⇒ Click the blank cell in the Low column for the first value: License_Fee.
⇒ Type 0.7 for the Low value of License_Fee.
⇒ Press Enter.
⇒ Click the blank cell in the High column for License_Fee.
⇒ Type 0.8 for the High value of License_Fee.
⇒ Press Enter.
Continue to fill in the Value Tornado Setup dialog with the rest of the High and Low values shown in Table 2-3. Note that you can use the arrow keys to move around the Value Tornado Setup dialog.

<table>
<thead>
<tr>
<th>Value</th>
<th>Low</th>
<th>High</th>
</tr>
</thead>
<tbody>
<tr>
<td>License_Fee</td>
<td>0.7</td>
<td>0.8</td>
</tr>
<tr>
<td>Marketing_Costs</td>
<td>5</td>
<td>20</td>
</tr>
<tr>
<td>Per_Unit_Costs</td>
<td>0.8</td>
<td>0.9</td>
</tr>
<tr>
<td>Price</td>
<td>1.95</td>
<td>2.1</td>
</tr>
<tr>
<td>Sales</td>
<td>20</td>
<td>60</td>
</tr>
</tbody>
</table>

Table 2-3. Variables and Settings for a Value Tornado

When you are done, the Value Tornado Setup dialog should look like Figure 2-28.
Note that the Low value for Per Unit Costs is the same as the current value. Assume you have reliable information that your Per Unit Costs will not be less than 0.8.

You have now selected the values to include in the Value Tornado and specified ranges for each. Click OK to run the Value Tornado. DPL generates the Value Tornado as displayed in Figure 2-29.
Figure 2-29. Value Tornado Diagram

The x-axis (horizontal axis) of the Value Tornado diagram displays the change in the objective function of the model as each of the variables on the left is changed from the low setting you specified to the high setting you specified. For a given variable (e.g., Sales) it is changed from the low setting to the high setting while all other variables are held at their current settings. DPL runs the model once to establish the value of the objective function with all variables at their current setting (for a model with only value and decision nodes). This is called the Base Result and is indicated by the vertical line in the Value Tornado. See Section 2.7 for a further discussion of the Base Result. Note that the vertical line on the diagram is at 33, which is the value you obtained running the model previously. DPL sorts the bars so that the variable that results in the biggest change in the objective function is on top.

The changes in color indicate that for either the low or high setting of the variable a policy change has occurred. In this model, a policy change occurs when a different decision alternative is optimal for the upfront decision (the decision at the head, i.e., far left, of the decision tree) from that which is optimal for the Base Result policy. We will discuss more about policy changes in Sections 2.7 and 3.6.
DPL indicates that a policy change has occurred for the low setting of the variable by displaying a portion of the bar for that variable in blue. The legend on the tornado diagram helps to explain this. DPL indicates that a policy change has occurred for the high setting of the variable by displaying a portion of the bar for that variable in magenta. For different values, the blue and/or magenta may occur on the same side of the vertical line representing the Base Result. In Figure 2-29, magenta and blue both occur to the left of the Base Result. This is because a low setting of Sales decreases the objective function (Profit) while a high setting of Marketing Costs also decreases the objective function. Note that DPL displays the change in color from green to blue (or magenta) midway between the value of the objective function for the current setting and the value for the low (or high) setting. The change in color does not indicate the precise value at which the change in policy occurs. If you would like more exact information on when the change in policy occurs, you could run a Rainbow Diagram (see Section 3.6) to help determine this information.

You can change the formatting of the Value Tornado by using the View menu.

⇒ Select View | Values. The Value Tornado is updated as shown in Figure 2-30.
With View | Values on, DPL displays the low and high settings for each variable as well as the expected value of the objective function when the variable is at its low and high setting. The variables' low or high settings appear before the "/" character and the expected values appear after. In addition, DPL displays the expected value for the Base Result at the top of the vertical line in the Value Tornado. If a variable has no impact on the objective function as it is changed from its low to high setting, DPL does not display anything for that variable (as is the case for License Fee in Figure 2-30).

The Value Tornado indicates that three variables result in a change in policy if they are at either their low or high setting. These variables are called decision sensitive. In this sample model, there is only one decision with two alternatives, so we know that a policy change implies that rather than producing the product In-house the optimal alternative is to License it. For more information on determining what policy change has occurred, see Section 3.6, Rainbow Diagram on a Value.
You have just discovered that several of the variables in your model are decision sensitive. Assume you do not know the value of these variables for certain. You may want to know what the optimal policy is when these variables are treated as uncertainties. You will now change your model in order to treat these variables as uncertain quantities.

The change you are about to make to the model is significant, so you will create a copy of the model as it is and edit the copy.

⇒ To do this, right mouse-click on the item for the model in the Workspace Manager. The Workspace Manager context menu appears.

⇒ Select Duplicate. The model is duplicated with the same name plus "–copy" appended to it. The item for new model is selected in the Workspace Manager.

⇒ Press F2 or click the item to edit the name of the new model.

⇒ Rename it "License vs. In-house prob".

⇒ Press Enter.

The new model is now the active Model Window. You may wish to save the workspace at this point.

2.6 Discrete Chance Nodes

You will modify the model by changing some of the value nodes to discrete chance nodes. In DPL, a discrete chance node has two or more outcomes which occur with a specified probability. DPL evaluates each chance outcome to calculate the expected value of the decision model when rolling back the decision tree. A discrete chance node is represented in the influence diagram by a bright green oval.

You will now change the value nodes that are decision sensitive into discrete chance nodes.

⇒ Select Sales.

⇒ Click the Change Node Type button on the model toolbar (see Table 1-2) (or select Node | Change Type or press Ctrl+T). The Node Type dialog appears.
Click Discrete Chance as shown in Figure 2-31 to change Sales to a discrete chance node.

Click OK. The Node Definition dialog appears as shown in Figure 2-32.
Chapter 2: Building Analysis Models

Syncopation Software

Figure 2-32. Node Definition Dialog General Tab for a Discrete Chance Node

The General tab of the Node Definition dialog for a discrete chance node contains an Outcomes list box. You can add, delete, insert or rename chance outcomes. DPL has created three chance outcomes and named them "Low", "Nominal" and "High". These settings can be changed in the Tools | Options dialog on the General tab (Tools | Options | General).

Note: As you saw with decision node alternatives in Section 2.4, DPL has designated one of the outcomes ("Nominal") as the "default" outcome. You don’t need to change this setting for the purposes of this tutorial.

Leave the settings as they are on the General tab and select the Data tab. The Data tab for the Sales discrete chance node is shown in Figure 2-33.
Figure 2-33. Node Definition Dialog Data Tab for a Discrete Chance Node

There are a number of elements on the Data tab for a discrete chance node. You have already used the Conditioning button to condition Revenues. The Conditioning button for a discrete chance node works in a similar way. In addition to the Value edit box, there is a Probability edit box and a Distribution type dropdown box. You can specify numbers or formulas in the Probability edit box in a similar manner to specifying data for values. You can change the type of the distribution using the Distribution type dropdown box. The Distribution type dropdown box will be discussed in Chapter 5.
DPL assigns default probabilities to the three chance outcomes. Like the outcome names, these probabilities can be changed in Tools | Options | General. DPL also assigns the low and high values that you specified in the Value Tornado to the Low and High outcomes (as well as the value that was specified for the value node to the Nominal outcome).

让她


click anywhere in the Influence Diagram Pane or press ESC to deselect Sales. Your model should look something like Figure 2-34.

Note that DPL has updated the Default Tree by adding the Sales discrete chance node to it and moving the Profit get/pay expression to the branches for Sales. In the Decision Tree Pane, DPL displays discrete chance nodes as bright green circles.

Figure 2-34. Model with Sales Changed to a Discrete Chance Node
Select Per Unit Costs and change it to a Discrete Chance Node (Ctrl+T or Change Node Type button or select Node | Change Type).

Select Discrete Chance in the Node Type dialog.

Click OK. The Node Definition dialog appears with the General tab selected.

You will now remove one of the chance outcomes that DPL provides by default. On the General tab of the Node Definition dialog, select the Low outcome in the Outcomes list box.

Press Delete.

DPL will issue a warning in the Warning dialog that Node data will be lost. When you delete a chance outcome (or decision alternative), the data that goes with it will also be deleted. DPL is warning you of this.

Click OK. The Node Definition dialog should now look like Figure 2-35.
Figure 2-35. Node Definition Dialog General Tab for Per Unit Costs

Select the Data tab of the Node Definition dialog.

As shown in Figure 2-36, no probabilities are specified for the Nominal and High outcomes. When you delete a default chance outcome, DPL no longer fills in default probabilities. However, the Nominal and High value data that you specified when you ran the Value Tornado are filled in.
Type "0.6" in the Probability edit box for Nominal.

Arrow down twice to select High.

Type "0.4" in the Probability edit box for High.

Click OK to close the Node Definition dialog.

Change the Node Type of Marketing Costs to Discrete Chance Node.

Accept the default outcomes and select the Data tab.

Accept the default probabilities and previously specified values.

Click OK to close the Node Definition dialog.
Note: If you don't select the Data tab and click OK to accept the default probabilities, DPL will warn you that default probabilities have been used when you first run the model and will ask whether you wish to continue the run with those probabilities.

Your model should now look something like Figure 2-37. DPL has updated the Default Tree further by adding the discrete chance nodes for Per Unit Costs and Marketing Costs and by moving the Profit get/pay expression to the end of the tree on the branches for Marketing Costs.

Figure 2-37. Model with Three Discrete Chance Nodes

You are now almost ready to run the modified model with uncertainty incorporated into it. Now that there are two models in the Workspace, DPL needs to know which one to run. This is done by telling DPL which model in the Workspace is the Main Model. You may have noticed previously that the first model you created was prefixed with the word "Main:" in the Workspace Manager. By looking at the Workspace Manager, you can tell which model is the Main Model. You can also look at Model | Main. If there is a check next to Main then the model in the active window is the Main Model.
To specify the modified model to be the Main Model, right mouse-click the item for the model in the Workspace Manager. The Workspace Manager context menu appears.

Select Make Main.

Note: If the active model (the model currently open for editing) is not the Main model, and you select Run | Decision Analysis or another Run command, DPL will ask you whether you want to run the Main model, or make the currently active model the Main model and run it. You can change the settings for this warning using the Tools | Options | Workspace menu command.

2.7 Base Case Tornado Diagram

You are now ready to run another sensitivity analysis on your model: the Base Case Tornado Diagram. The Base Case Tornado Diagram sets all discrete chance nodes to a state that you define to be Nominal for each node to calculate a Base Case. It then varies each discrete chance node individually to a state you specify to be Low and to a state you specify to be High while keeping all other discrete chance nodes at their Nominal states. The Base Case Tornado Diagram is useful for understanding the impact of each discrete chance node on the model's objective function.

To run a Base Case Tornado Diagram, select Run | Tornado Diagram or press F8 (F8 is the shortcut to run a Tornado Diagram). The Select Tornado Type dialog appears as shown in Figure 2-38.
Figure 2-38. Select Tornado Dialog with Base Case Selected

Now that you have added chance nodes to your model, there are several alternative Tornadoes that you can run. DPL defaults to a Base Case Tornado if you have chance nodes in your model. The differences between types of tornado diagrams are discussed later in this section.

⇒ Click OK to accept the default selection of Base Case. The Base Case Tornado Setup dialog appears as shown in Figure 2-39.
To run a Base Case Tornado Diagram, you must tell DPL which state (state is a generic term used to refer to either chance outcomes or decision alternatives) is Low, Nominal and High for each discrete chance node (also referred to as a chance event). For three outcome discrete chance nodes, this is usually straightforward. If you have used the default discrete chance node settings provided by DPL, the exercise is easy, as is the case for Marketing Costs and Sales. Figure 2-39 indicates that the states specified to be Low, Nominal and High for Marketing_Costs and for Sales are Low, Nominal and High, respectively.

- Click in the cell for the Low State of Marketing_Costs. You can see that there is a drop-down box that lets you select the setting for this state of this chance node.

- Use the arrow keys to move around the other cells for each state of each chance node, leaving the settings as DPL has suggested.

You will also notice that since Per Unit Costs is a two-outcome discrete chance node, one of its outcomes will have to be repeated for the Low, Nominal or High state specification. DPL has suggested using the Nominal state for both the Low and Nominal tornado diagram setting. Leave this setting as is.

- Click OK to run the Base Case Tornado Diagram.
DPL produces the Base Case Tornado Diagram as shown in Figure 2-40. In this example the Base Case Tornado is very similar to the Value Tornado that you ran on the deterministic model (i.e., the model with no discrete chance nodes) in Section 2.5 (with the exception that it does not include Price). This will not always be the case for several reasons. First, the Base Result of a Value Tornado may not be the same as the Base Case for the Base Case Tornado if the states chosen as Nominal for the Base Case Tornado do not match what was used as the current values in the Value Tornado. Second, if you change the high or low values for value nodes that you have changed to discrete chance nodes, the two tornado types will differ.

Further, if you run a Value Tornado on a probabilistic model (i.e. a model with chance nodes), the Base Result run is based on the full model outcome incorporating the uncertainty of the chance nodes. The Base Result in a Value Tornado from a probabilistic model will not necessarily match the Base Case of a Base Case Tornado from the same model. Lastly, there is no reason that a policy change that occurs in one type of tornado will necessarily occur in the other. For example, in the Base Case Tornado Diagram in Figure 2-40, when Sales is in its Low state there is a change in policy. In a Base Case Tornado when Sales is in its Low state the other two discrete chance nodes are fixed at their Nominal states. However in a Value Tornado run on the same model, when Sales takes on the value of its Low state, the other two uncertainties are allowed to vary across all of their states. A policy change may not necessarily occur.
Figure 2-40. Base Case Tornado Diagram

Base Case Tornado Diagrams are useful for understanding how the chance nodes in your model impact the objective function. They are also useful because you can add bars to a Base Case Tornado Diagram for values in your model. This allows you to compare the impact of chance nodes across their range of states to the impact of changes in values across a range of settings. Lastly, Base Case Tornado Diagrams are very quick to run which may be helpful for larger models.

Base Case Tornado Diagrams do not provide as complete a picture as Value Tornado Diagrams do of how a value impacts the objective function in a probabilistic model. This is because Base Case Tornado Diagrams effectively remove uncertainty from your model by setting all chance nodes to their nominal states.

Value Tornado Diagrams provide a better understanding of when policy changes occur given the uncertainty incorporated into the model. However, Value Tornado Diagrams do not allow you to include chance nodes and take longer to run for probabilistic models than do Base Case Tornado Diagrams.
2.8 Initial Decision Alternatives Tornado

The Initial Decision Alternatives Tornado diagram is an extension of the Base Case tornado that you ran in Section 2.7. To create an Initial Decision Alternatives Tornado, DPL sets the initial decision to each of its possible alternatives and runs a Base Case tornado for each alternative. The resulting Base Case tornadoes are then shown on one diagram.

You will now run an Initial Decision Alternatives tornado using the model you built in the previous sections. Chapter 4, Building Models from Spreadsheets, also addresses Initial Decision Alternatives Tornado diagrams.

⇒ Make sure the "License vs. In-house prob" model is still the active model.

⇒ Select Run | Tornado Diagram or press F8. The Select Tornado Type dialog appears.

⇒ Select Initial Decision Alternatives.

⇒ Click OK.

The Initial Decision Alternatives Tornado Setup table appears. It should be identical to the Base Case Tornado Setup table you examined in Section 2.7.

⇒ Leave the settings as they are.

⇒ Click OK. An Initial Decision Alternatives tornado appears as shown in Figure 2-41.
Figure 2-41. Initial Decision Alternatives Tornado Diagram

Figure 2-41 is an example of a very simple Initial Decision Alternatives tornado. There are only two initial decision alternatives (In-house and License), so the tornado diagram essentially consists of two Base Case tornadoes on one chart. The diagram shows that the chance event Sales has the greatest impact on the objective function value, regardless of which initial alternative is pursued. It also shows that the impact on the objective function of Sales is less for the License alternative than it is for the In-house alternative (the Sales bar for License is narrower). Also, the diagram shows that if the License alternative is pursued (despite the fact that it is not the optimal policy), the chance events Marketing_Costs and Per_Unit_Costs have no effect on the objective function. This makes sense based on how you set up this model. If the product is licensed, there are no marketing costs or per unit costs in the formula for Profit.
Initial Decision Alternatives tornadoes are helpful for comparing the impact of each chance event on the objective function across the possible alternatives of the initial decision in the model. Although the tornado you ran in this section is simple and illustrative, Initial Decision Alternatives tornadoes can be quite powerful when used with models that incorporate several strategic alternatives and several chance events.

You may want to save the workspace before you proceed to Chapter 3, Decision Analysis Results.
3 Decision Analysis Results

The model you built in Chapter 2, Building Decision Analysis Models, is now ready to produce the full suite of results that are available when you run a decision analysis.

Now we will discuss each option in the Decision Analysis Options dialog in more detail. See Tables 3-1 through 3-3 below.

<table>
<thead>
<tr>
<th>Evaluation method</th>
<th>This section determines how DPL will analyze the decision tree.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fast sequence evaluation</td>
<td>Provides the exact expected value of the objective function but optimizes run time by not visiting every endpoint of the tree. The Risk Profile may be approximate.</td>
</tr>
<tr>
<td>Full tree enumeration</td>
<td>Provides exact expected value of the objective function and visits every endpoint of the tree. Results in a smoother looking risk profile.</td>
</tr>
<tr>
<td>Discrete tree simulation</td>
<td>Provides an estimate of expected value by sending a specified number of samples down paths in the tree. Useful to reduce runtime when an exact expected value is not required.</td>
</tr>
<tr>
<td>Settings</td>
<td>Settings for discrete tree simulation.</td>
</tr>
</tbody>
</table>

Table 3-1. Evaluation Method Options
### Distributions

This section controls the distribution related outputs that DPL will provide for a model run.

<table>
<thead>
<tr>
<th><strong>Risk Profile</strong></th>
<th>Creates a graph showing the full range of possible outcomes from the model. The format of the graph (cumulative or frequency) can be changed after the model run.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Initial Decision Alternatives</strong></td>
<td>Creates risk profile graphs for each of the initial decision alternatives.</td>
</tr>
<tr>
<td><strong>Value Correlations</strong></td>
<td>Creates a bar chart showing the correlation coefficient between each value in the model, and the objective function.</td>
</tr>
</tbody>
</table>

**Table 3-2. Distribution Output Options**
Table 3-3. Policy Output Options

<table>
<thead>
<tr>
<th>Policy outputs</th>
<th>This section controls the distribution related outputs that DPL will provide for a model run.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Policy Tree™</td>
<td>Creates an output tree that displays the optimal decision alternative for each decision in the tree, the probability of each outcome for each discrete chance node in the tree, get / pay values and rolled-back expected values.</td>
</tr>
<tr>
<td>Policy Summary™</td>
<td>Creates a view that summarizes the information in the Policy Tree™.</td>
</tr>
<tr>
<td>Expected Value of Perfect Information / Control</td>
<td>Creates a chart showing the expected value of perfect information for (value of perfect information) or control (value of control) over each discrete chance in the model.</td>
</tr>
<tr>
<td>Number of levels</td>
<td>Tells DPL how many levels (i.e., nodes) down the tree to gather policy information. Must be set to all for Expected Value of Perfect Information / Control</td>
</tr>
</tbody>
</table>

⇒ If you haven't already done so, start DPL and open the workspace you saved from Chapter 2 by using File | Open Workspace or pressing Ctrl+O.

⇒ Make sure the "License vs. In-house prob" model is Main.
Select Run | Decision Analysis or press F10. The Decision Analysis Options dialog appears as shown in Figure 3-1.

Figure 3-1. Decision Analysis Dialog for Full Model

- Leave Evaluation method at Fast sequence evaluation.
- Make sure Risk Profile is checked.
- Do not click the Initial Decision Alternatives button (it should be pressed in).
- Make sure Policy Tree™ is checked.
- Make sure Number of levels is set to "5 (all)".
- Make sure Policy Summary™ and Expected Value of Perfect Information/Control are not checked.
- Click OK to close the Decision Analysis Options dialog and start the run.

DPL produces the requested outputs.
Chapter 3: Decision Analysis Results

3.1 Policy Tree™

The Policy Tree™ output will be active after the run is complete as shown in Figure 3-2. Before discussing the Policy Tree™, take another look at the Workspace Manager. Note that DPL has drawn double inward pointing chevrons (”»»...««”) around the Main Model. This is the Compiled Indicator and it tells you that this model has been compiled and is ready to run. Once you modify the model, the Compiled Indicator is removed.

![Figure 3-2. Policy Tree™ for Full Probabilistic Model](image)

The Policy Tree™ indicates with a thick branch that In-house is still the optimal decision alternative. The expected value of the model has changed from 33.0 to 32.9. Note that this is the first time that you have a true expected value that incorporates uncertainty, since there are now chance events in the model. The Policy Tree™ in Figure 3-2 also differs from the previous Policy Tree™ in Figure 2-26 because the current Policy Tree™ now contains more levels. DPL indicates this by displaying discrete chance
nodes at the end of each decision alternative branch of the Product Strategy decision. Recall in the previous Policy Tree™ that there were endpoints at the end of each of the decision alternative branches. To look further at the Policy Tree™ you will expand the discrete chance node at the end of the In-house branch.

Right mouse-click the Sales discrete chance node at the end of the In-house decision alternative branch. The node is selected and the Policy Tree™ node context menu appears as shown in Figure 3-3.

![Figure 3-3. Policy Tree™ Node Context Menu](image)
The Policy Tree™ node context menu contains four menu commands for changing the state of expansion of the Policy Tree™ as summarized in Tables 3-4 below.

<table>
<thead>
<tr>
<th>Menu command</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expand</td>
<td>Expands / Collapses the currently selected node. If the node is currently collapsed, then it expands one level if the node has never been expanded before or to the previously expanded state if several nodes have been expanded down this path. If the node is expanded, then it collapses it. This can also be accomplished by double-clicking the node.</td>
</tr>
<tr>
<td>Note: this item will read Collapse if the node is already expanded.</td>
<td></td>
</tr>
<tr>
<td>Expand and Zoom</td>
<td>Does the same thing as Expand but then zooms the Policy Tree™ so that the whole tree can be seen. This can also be accomplished by shift-double-clicking the node.</td>
</tr>
<tr>
<td>Note: this item will read Collapse and Zoom if the node is already expanded.</td>
<td></td>
</tr>
<tr>
<td>Expand to Level...</td>
<td>Brings up the Expand Policy Tree™ dialog box in which you can specify level to which you want the subtree expanded. The Policy Tree™ is expanded from the node selected.</td>
</tr>
<tr>
<td>Expand Subtree</td>
<td>Expands the entire subtree in the Policy Tree™ from the selected node.</td>
</tr>
</tbody>
</table>

Table 3-4. Policy Tree™ Node Context Menu Commands

⇒ Select Expand to Level. The Expand Policy Tree™ dialog appears.
⇒ Enter 5 in the Expand to Level edit box in the dialog. Leave Zoom full after expanding checked.
Click OK. The Policy Tree™ should now look similar to Figure 3-4.

Figure 3-4. Policy Tree™ with In-house Subtree Expanded
Nodes in the Policy Tree™ are displayed using the same symbols as in the Decision Tree Pane. Decision nodes are yellow squares. Discrete chance nodes are bright green circles. Endpoints are blue triangles. Tables 3-5 and 3-6 below describe all the information displayed in the Policy Tree™.

<table>
<thead>
<tr>
<th>Data element</th>
<th>Location / format</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node Name</td>
<td>Above and to the left of the node.</td>
<td></td>
</tr>
<tr>
<td>Rolled-back expected values</td>
<td>Above and to the left of the node The rolled-back expected value is displayed in square brackets, e.g., [32.9].</td>
<td>The expected value of the objective function for the subtree headed by the node adjacent to the value. For example, if the value appeared at a discrete chance node in the Policy Tree™ where the only subsequent items were two endpoints that each could occur with a 0.5 probability and the objective function equaled 1 for the first outcome and 0 for the second, then the rolled back expected value for the subtree headed by this chance node would be 0.5 (0.5 * 1 + 0.5 * 0).</td>
</tr>
</tbody>
</table>
## Table 3-6. Branch Information displayed in the Policy Tree™

<table>
<thead>
<tr>
<th>State name</th>
<th>At the &quot;elbow&quot; of the branch above the branch (i.e., at the left end of the horizontal part of the branch).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Branch probability (discrete chance nodes only)</td>
<td>At the elbow of the branch below the branch (i.e., below the state name). The probability can either be displayed as a percent between 0%-100% or as a number between 0-1. The conditional probability of this discrete chance outcome occurring on this path. If the discrete chance is conditioned by other nodes, this is the probability of the chance outcome occurring given the outcome states on this path of the nodes that condition it.</td>
</tr>
<tr>
<td>Get/pay values</td>
<td>To the left of the subsequent node below the right end of the horizontal part of the branch. If there is no get/pay value at this point in the tree, then nothing is displayed. The value of the get/pay expression (if any) that occurs at this point in the tree.</td>
</tr>
</tbody>
</table>

In the model you have developed so far, there is only one get/pay expression (Profit) in the tree on the branches of Marketing Costs. Marketing Costs is the last discrete chance node in the tree (furthest to the right). In the Policy Tree™, the endpoints follow it. Therefore, you will see the get/pay value for Profits below each branch of each Marketing Costs node. Note that the value of a get/pay expression at the endpoint is the same as the rolled-back expected value which is why the same number appears above and below the branch at the end of the tree.
You can use the Policy Tree™ to find out a number of things about your model. For example, the expected value of the model is 9.7 given that you develop the product in-house and that sales turn out to be low (9.7 is the rolled-back expected value adjacent to the node Per Unit Costs on the Low branch of the Sales node which is on the In-house branch of the Product Strategy decision).

- Try manipulating the Policy Tree™ by expanding / collapsing different parts of it. You can do this by double-clicking a node, using the context menu or using the Node menu in the main menu.

- You can also control the data elements that are displayed in the Policy Tree™. Select Format | Display with the Policy Tree™ active. The Format Policy Tree™ dialog appears as shown in Figure 3-5.

![Format Policy Tree™ Dialog](image)

You can use the two spin buttons to increase or decrease the Branch length and Branch offset percentages to alter the shape and appearance of the tree.

- Experiment with using the check boxes to turn on and off the different data elements the tree displays.
3.2 Risk Profile

As shown in Figure 3-4, DPL creates an item in the Workspace Manager for each of the outputs it created. To be exact, DPL creates one or more items for each output. For Risk Profiles, DPL creates an item for the Risk Profile chart and an item for each Risk Profile dataset that is created. In the decision analysis run that you requested previously, you did not select Initial Decision Alternatives for the Risk Profile output. Therefore DPL created one Risk Profile dataset. Had you requested Initial Decision Alternatives, DPL would have created two Risk Profile datasets: one for In-house, and one for License. In addition, DPL would have created a Risk Profile chart showing the risk profiles for both alternatives. In the Workspace Manager, a Risk Profile chart is indicated by the icon (▕) and a Risk Profile dataset by the icon (▏). When you request a Risk Profile for the best alternative only, DPL names the Risk Profile chart and dataset "Expected Value". DPL encloses items in the Workspace Manager that do not correspond to windows (such as the Risk Profile datasets) with curly braces i.e., {Expected Value}.

⇒ Double-click on the item for Risk Profile chart called Expected Value (▕) in the Workspace Manager to activate the window. You may also select it and press Enter. The Expected Value Risk Profile chart becomes active as shown in Figure 3-6.

Note: you can also double-click on the Risk Profile dataset called Expected Value. DPL activates the Risk Profile chart that displays it. If you double-click on a Risk Profile dataset that is not displayed in a Risk Profile chart, DPL creates a chart for the dataset and activates the chart.
By default, DPL creates a cumulative Risk Profile chart. A cumulative Risk Profile chart displays the objective function on the x-axis (horizontal axis) and cumulative probability on the y-axis (vertical axis). A cumulative Risk Profile chart can be read by choosing a value on the x-axis, determining where the Risk Profile intersects with the vertical line "drawn" from the value, and then "drawing" a horizontal line over to the y-axis. The value where the horizontal line meets the y-axis is the probability that the objective function is less than or equal to the chosen value on the x-axis. For example, if you choose the value 20, you see that the vertical line drawn from 20 intersects the Risk Profile at a probability value of approximately 30%. Therefore, in 30% of the scenarios the objective function is 20 or less.

To create a Risk Profile chart, DPL calculates all the endpoint values (objective function values and probabilities) associated with the model, and then aggregates the endpoints into a user-determined number of intervals for display. The number of intervals used can significantly affect the appearance of the Risk Profile chart. The number of intervals has no impact on the expected value of the Risk Profile.
The accuracy of the percentiles from a Risk Profile chart is affected by the number of intervals. In the example in the previous paragraph, 20 is the 30th percentile. The 10th percentile is the x-axis value such that a vertical line drawn from it intersects the curve at 10%. If you are interested in percentiles and wish to increase their accuracy, you should set the number of intervals to be larger. A larger number of intervals does require more memory and has a slight performance impact.

The number of intervals can be changed using Model | Options.

⇒ Double-click on the Main model (or press Ctrl+F12).
⇒ Select Model | Options and click on the Run tab. You should see that the Risk Profile Number of intervals is 500.
⇒ Click Cancel.

In general, 250 to 500 is usually a reasonable setting for most models. (Note: in the model as it currently stands there are only 36 paths in the tree – 18 of which are in the optimal policy and displayed in the Risk Profile. Setting the number of intervals to greater than 500 will not affect how the Risk Profile charts looks since there are many fewer scenarios than intervals.) If you have distributions with very long tails, you may wish to increase the number of intervals.

A Risk Profile chart can be formatted in a number of ways. You will now change the format of the Risk Profile chart in two ways.

⇒ Select Format | Display. The Format Diagram dialog appears with the Display tab selected as in Figure 3-7.
Figure 3-7. Format Diagram Dialog

- Check Expected Value / Certain Equivalent Lines.
- Check EV / CE Values.
- Click OK. DPL updates the Risk Profile chart as shown in Figure 3-8.
Chapter 3: Decision Analysis Results

DPL displays the expected value (EV) of the objective function on the Risk Profile chart. Recall from section 3.1 that the expected value of the objective function is 32.9. Displaying the expected value of the model is particularly useful when comparing multiple Risk Profiles. It is also helpful to display the expected value if the Risk Profile of the model is less symmetric, because it may be difficult to estimate the expected value from the risk profile.

- Select Format | Display.
- In the Format Diagram dialog, uncheck Expected Value / Certain Equivalent Lines.
- Change the Graph Type to Frequency histogram.
- Click OK. DPL updates the Risk Profile chart as shown in Figure 3-9.

Figure 3-8. Risk Profile Chart with Expected Value and EV Line
Figure 3-9. Frequency Histogram Type Risk Profile Chart

A frequency histogram displays the Risk Profile information in a different format. The x-axis still displays the objective function and the y-axis still displays probability values. The height of each bar in the frequency histogram Risk Profile chart indicates the probability that the objective function falls within the range determined by the horizontal position and width of the bar. For example, in the frequency histogram Risk Profile chart in Figure 3-9 there is approximately a 5.5% chance that the objective function falls in the range 3.75 to 5 (the height of the second bar from the left is 5.5% on the y-axis, it starts at 3.75 on the x-axis and ends at 5).

⇒ If you like, experiment with some of the other formatting options available via the Format menu.

Finally, you will examine the statistics available for the Risk Profile.

⇒ Select View | Statistics. The Statistics dialog appears as shown in Figure 3-10.
Chapter 3: Decision Analysis Results

Syncopation Software

The Statistics dialog gives you a standard statistical description of the distribution around your objective function, including the minimum and maximum values, the variance and standard deviation, the higher moments (skewness and kurtosis), and selected percentiles of the distribution. For example, the percentiles table shows that the 10\textsuperscript{th} percentile of the distribution is 7; 10\% of the time, the objective function will be less than or equal to 7. Similarly, 90\% of the time, the objective function will be less than or equal to 57. You may enter other percentiles into the Percentile list box and then click Update Percentile Values.

⇒ Click Close to close the Statistics dialog.
3.3 Policy Summary™

We will now examine DPL's Policy Summary™ output. Before running this output, you will make some modifications to the model in order to demonstrate more clearly the information that a Policy Summary™ provides. Specifically, you will add a downstream decision (i.e., a decision that occurs after one or more discrete chance nodes), create a new discrete chance node and condition the new node on another discrete chance node.

⇒ Right mouse-click the item for the model "License vs. In-house prob" (or whatever you named it earlier) in the Workspace Manager. The Workspace Manager context menu appears.

⇒ Select Duplicate to make a copy of the model.

⇒ Rename the new model "License vs. In-house downstream".

⇒ Right mouse-click the item in the Workspace Manager for the new model.

⇒ Select Make Main from the Workspace Manager context menu.

⇒ In order to add the nodes mentioned earlier, re-arrange your influence diagram to give yourself some space between Sales, Revenues, Production Costs and Profit as indicated in Figure 3-11.

⇒ One way to quickly re-arrange the influence diagram is to select multiple nodes at once. While holding down the Ctrl key, click on the Sales, Marketing Costs, Per Unit Costs, Production Costs and Product Strategy nodes. All these nodes turn magenta because they are selected as a group.

⇒ Use the mouse to drag this group of nodes to the left, freeing up space in the center of the diagram.

You may have to adapt these steps slightly depending on how your diagram is drawn.
Figure 3-11. Re-arranged Influence Diagram

- Click the Create Decision button on the model toolbar (see Table 1-2) or select Node | Create Decision to create a new decision node.
- Click somewhere in the space you created. The Node Definition dialog appears with the General tab selected.
- Name the node "Price Change".
- Rename the default "Yes" alternative to "Raise".
- Rename the default "No" alternative to "Keep same". The General tab should look like Figure 3-12.
Select the Data tab.

Type "2.1" for the Raise alternative.

Arrow down to select the Keep same alternative.

Type "2" for the Keep same alternative.

Press Enter. The Data tab should look like Figure 3-13.
Figure 3-13. Node Definition Data Tab for Price Change Decision

- Click OK.
- Double-click Sales to edit its definition.
- Change the value for each outcome to half its previous value. The Data tab should look like Figure 3-14 when you are done.
Click OK.

You have divided the sales in half because you are about to introduce a new node called Sales 2. To do this you are going to take advantage of DPL's node copy and paste capability. By the time you are done modifying the model, you will have created a two time period model. Sales will represent sales in the first period and Sales 2 will represent sales in the second period. You have divided the values in half for Sales to reflect the fact that previously Sales represented total sales.

With the Sales node selected (it should be magenta), make a copy of it by pressing Ctrl+C or selecting Edit | Copy.

Paste the new node by pressing Ctrl+V or selecting Edit | Paste.

Select the new node and drag it away from Sales. Your model should look something like Figure 3-15.
Note: You can also select and copy multiple nodes by holding down Ctrl and selecting the nodes to be copied, as you did earlier when you moved multiple nodes.

Figure 3-15. Model with Copy of Sales Node

Before editing the copy of Sales, you need to turn on an advanced feature.

Select Model | Options. The Model Options dialog appears. This dialog lets you set various options associated with the model you are editing.
Check Chance/value node features under Advanced settings, as shown in Figure 3-16.

⇒ Figure 3-16.

⇒ Click OK.
Double-click Sales (copy) to edit it.
Select the General tab.
Change its name to "Sales 2".
Note there is now a new check box on the General tab.
Check Separate probability and value input trees as shown in Figure 3-17.
Note that there are now two tabs in place of the Data tab called Values and Probabilities, respectively. Among other things, Advanced chance / value node features enables separate data input trees for probabilities and values. This is convenient if you have a discrete chance node whose probabilities are conditioned by one or more nodes and whose values are conditioned by a different set of nodes, or whose probabilities are conditioned but values aren’t or vice versa. As you will see in the sample model you are building, the probabilities for Sales 2 will be conditioned by one node while the values will be conditioned by another node.

![Node Definition General Tab for Sales 2](image)

**Figure 3-17. Node Definition General Tab for Sales 2**

→ Select the Values tab.

→ Click Conditioning. The Conditioning dialog appears.
Check Price Change as shown in Figure 3-18.

Figure 3-18. Conditioning Dialog for Sales 2 Values

Note that the Conditioning dialog tells you how many data expressions are required given the nodes selected. Since Sales 2 is a three-outcome discrete chance node and Price Change is a two-alternative decision node, six data expressions are required.

Click OK.

The Values tab updates as shown in Figure 3-19. The value input tree now has six input slots: one set of three for the outcomes of Sales 2 for each of the two alternatives of Price Change.
Change the Low, Nominal and High values for the Raise alternative of Price Change to be "8", "18" and "29", respectively. You are assuming that demand (sales) is slightly sensitive to price. Leave the values for the Keep same alternative as is. The value input tree should look like Figure 3-20.
Select the Probabilities tab.

Click Conditioning. The Conditioning dialog appears.

Click Sales as shown in Figure 3-21.

Click OK.
As the Node Definition probability tab now indicates, nine data expressions are required. The probability input tree for this is rather small.

⇒ Click Full Screen to make inputting the data easier. Your screen should look like Figure 3-22.
Enter probabilities for Sales 2 according to Table 3-7. Your probability input tree should look like Figure 3-23 when you are done.
## Table 3-7. Probability Data for Sales 2

<table>
<thead>
<tr>
<th>Sales Outcome</th>
<th>Sales 2 Outcome</th>
<th>Probability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low</td>
<td>Low</td>
<td>.6</td>
</tr>
<tr>
<td></td>
<td>Nominal</td>
<td>.3</td>
</tr>
<tr>
<td></td>
<td>High</td>
<td>.1</td>
</tr>
<tr>
<td>Nominal</td>
<td>Low</td>
<td>.3</td>
</tr>
<tr>
<td></td>
<td>Nominal</td>
<td>.4</td>
</tr>
<tr>
<td></td>
<td>High</td>
<td>.3</td>
</tr>
<tr>
<td>High</td>
<td>Low</td>
<td>.1</td>
</tr>
<tr>
<td></td>
<td>Nominal</td>
<td>.2</td>
</tr>
<tr>
<td></td>
<td>High</td>
<td>.7</td>
</tr>
</tbody>
</table>
Note that the probabilities for Sales 2 given that Sales is Nominal are unchanged. The probability data in Table 3-7 reflects the belief that if sales in the first period are low (i.e., if the outcome of the Sales chance node is Low) then sales in period two are more likely to be low (i.e., the outcome of the Sales 2 chance node is more likely to be Low). Similarly if sales in the first period are high they are more likely to be high in the second period.

⇒ Click Full Screen. The Node Definition dialog returns to normal dialog mode.

⇒ Click OK. Your model should now look something like Figure 3-24.
Figure 3-24. Model After Editing Sales 2

DPL has indicated the changes that you have just made with colored arc arrowheads. A green arc arrowhead indicates that the influencing node (i.e., Sales) conditions the probabilities of the influenced node (i.e., Sales 2). As you have seen previously a blue arc arrowhead indicates that the influencing node (i.e., Price Change) conditions the values of the influenced node (i.e., Sales 2). If the influencing node conditions both the probabilities and the values of the influenced node, DPL indicates this with a burgundy arc arrowhead. Arc arrowhead colors are covered in more detail in Section 7.2.

Note that DPL continues to update the Default Tree in the Decision Tree Pane as you make changes in the Influence Diagram Pane. The Default Tree is not yet correct, but for now ignore it. There are several more changes to make to the Influence Diagram.

⇒ Double-click Production Costs to edit it.
⇒ Edit the expression in the Data edit box to read "Per_Unit_Costs * (Sales + Sales_2)".
Press Enter. Your data input tree should now look like Figure 3-25.
You have incorporated Sales 2 into the expression for Production Costs.

Figure 3-25. Updated Data Input Tree for Production Costs

Click OK.

Double-click Revenues to edit it.

Edit the expression in the Data edit box for the In-house branch to read "Price * Sales + Price_Change * Sales_2".

Arrow down to select the input for the License branch.

Edit the expression in the Data edit box for the License branch to read "License_fee * (Sales + Sales_2)".

Press Enter. Your data input tree should look like Figure 3-26.
If the data is cut off in the input tree, right mouse-click on the tree to get the context menu and select Lengthen Branch.

Note that you do not have to press Enter before clicking OK in the Node Definition dialog. DPL makes the edits even if you don't, but to see the new data you specified in the input tree you must press Enter.

You have now incorporated Sales 2 and Price Change into the expressions for Revenues. In particular, if In-house is chosen then Revenues in the second period is equal to Sales 2 times Price Change.

Figure 3-26. Updated Data Definition for Revenues
Your model is nearly complete. However the Default Tree is not yet correct. The model you are developing is a two time period model. You have an upfront decision to produce the product In-house or License it. You then have a downstream decision to change the price or not. The downstream decision occurs after you have observed sales in the first period. To reflect this, you need to have the Sales discrete chance node appear before (to the left of) Price Change in the tree. As shown in Figure 3-24, Price Change is currently before Sales in the Default Tree. You will now add some information to the model so that DPL will correct this. Specifically, you will add two influence arcs: one from Sales to Price Change and one from Sales 2 to Revenues. As mentioned in Chapter 2, an influence arc can represent a dependency, conditioning and / or timing. In this case, the influence arc from Sales to Price Change is a timing arc (Price Change does not depend on and is not conditioned by Sales). The arc tells DPL that Sales occurs before Price Change. The arc from Sales 2 to Revenues is a dependency arc. It tells DPL that Revenues depends on Sales 2.

- Click the Create Influence toolbar button (see Table 1-2).
- Create an arc from Sales to Price Change: click on Sales, then on Price Change.

Note that DPL has moved Sales to before Price Change in the tree.

- Click the Create Influence toolbar button.
- Create an arc from Sales 2 to Revenues: click on Sales 2, then on Revenues.

Note that DPL has removed the get/pay expression on Sales 2 and moved the get/pay expression on Marketing Costs ("Profit") to Sales 2.

- For completeness, select Influence | Construct from Formulas.

DPL creates two more arcs indicating the relationships in the formulas you entered. These arcs are not necessary for DPL to create the correct Default Tree; however, they do document the relationships in the influence diagram.

You may want to move some nodes around again and/or bend some influence arcs to make the influence diagram neater. Your model should look something like Figure 3-27. You will now run your updated model.
Select Run | Decision Analysis or press F10.

If you get a warning about making the current model the Main model, click Yes. Only one model at a time can be the Main model, which is the default model to be run.

Make sure the following are checked: Risk Profile, Policy Tree™, Policy Summary™ and Expected Value of Perfect Information / Control.

Leave Evaluation method at Fast sequence evaluation.

Click OK. DPL produces the requested outputs.

Double-click on the Policy Summary™ item in the Workspace Manager to activate the window. The Policy Summary™ as shown in Figure 3-28 is displayed.
Chapter 3: Decision Analysis Results

Figure 3-28. Policy Summary™

The Policy Summary™ displays summary information about the optimal policy in the Endpoint Database™. For each node, it displays the policy dependent probabilities for each state of the node at the end of the state branch. A policy dependent probability is the fraction of optimal scenarios in which the state (either decision alternative or chance outcome) occurs.

You will note that DPL also "adds" a state for each node called "(does not occur)" and displays the probability of this state as well. The "(does not occur)" state will have a non-zero policy dependent probability if there are scenarios in which the node does not occur. This could happen in an asymmetric tree (a tree where not every node appears on every path). An example of an asymmetric tree might be one in which you have a downstream decision to build a new plant. If you build the plant, you face some uncertainty as to the cost of building it. If the optimal policy in certain scenarios is to not build the new plant, then you would not encounter the chance node (or nodes) relating to the uncertainty of the costs to build the plant.

For initial decisions (those that appear before any chance nodes in the decision tree), the policy dependent probabilities will always be equal to 1.
(or 100%) for one decision alternative and zero (0%) for the rest. So in the Policy Summary™, the optimal decision alternative for each initial decision is the one that is selected 100% of the time. For example, Figure 3-28 indicates that In-house is selected 100% of the time.

For downstream decisions, the Policy Summary™ displays the percent of scenarios for which each downstream decision alternative is optimal. In your updated model, Price Change is a downstream decision because it occurs after the Sales discrete chance node. As indicated in Figure 3-28, Raise is the optimal alternative in 30% of the optimal policy scenarios while Keep same is the optimal alternative in 70% of the optimal policy scenarios.

The Policy Summary™ also displays the policy dependent probabilities of the outcomes for discrete chance nodes. For discrete chance nodes that are not conditioned by others and that do not depend on the optimal policy, the policy dependent probabilities are equal to the input probabilities. This is true of Sales, Per Unit Costs and Marketing Costs. However, Sales 2 is conditioned by another node (namely Sales). You can see that the policy dependent probabilities for Sales 2 are not the same as the input probabilities.

### 3.4 Expected Value of Perfect Information / Control

The expected value of perfect information / control is actually two outputs which both indicate how important it is to reduce the uncertainty associated with each discrete chance node in a model. The expected value of perfect information indicates how valuable it would be to have perfect information for a chance node before making a decision. The expected value of control indicates how valuable it would be to have complete control over the uncertainty.

You will now examine the expected value of perfect information / control results.

⇒ Double-click on the Value of Info/Control item in the Workspace Manager to activate the window. The Value of Information / Control output as shown in Figure 3-29 is displayed.
Chapter 3: Decision Analysis Results

DPL displays the value of perfect information for each chance node as a red vertical bar and the value of control as a yellow vertical bar. By default, both sets of bars are displayed and the nodes are sorted in descending order by their value of perfect information.

DPL calculates the expected value of perfect information for each chance node by moving it to the front of the decision tree (or as far to the front as it can) while keeping all other nodes fixed in position and, in essence, "re-running" the model. Note that DPL's solution algorithms allow it to calculate the expected value of perfect information without actually having to re-run the model. DPL calculates the expected value of the objective function for the modified model. The expected value of perfect information for a chance node is the difference in the expectation of the objective function of the modified model and the expectation of the objective function of the base model.

It is called the expected value of perfect information because the modified model simulates the situation in which you have perfect information about the uncertainty before you need to make a decision. For example, in the base model you must make the decision to develop the product in-house...
vs. license it before you know what sales are. However, in the modified model, you have the benefit of knowing what sales are before making this decision. The difference in value between the modified model and the base model is due to the information gained.

In the example model, the value of perfect information for Sales is approximately 1. This means that if you had the luxury of knowing which state Sales was in before deciding on Product Strategy you would choose to License in certain scenarios. Overall In-house is the better alternative, but with information on Sales you would choose to License for those scenarios in which license is optimal.

DPL calculates the expected value of control for a chance node in a similar manner to the way in which it calculates the value of perfect information, except that in addition to moving the chance node to the front of the tree it also turns it into a decision node. It is called the value of control because not only do you know which state the node is in before having to make a decision, but you also get to choose which state is optimal.

The value of control for Sales is approximately 19. This means that the expected value of the objective function would increase by 19 if you could choose the optimal outcome upfront for Sales (undoubtedly High in this case) and then decide on Product Strategy rather than deciding on Product Strategy and gambling on Sales.

### 3.5 Value Correlations

In this section you will examine a simple example of Value Correlations. Value Correlation charts are bar charts that display the correlation coefficients between each value and event in the model and the objective function.
Correlation coefficients are measures of statistical association between two variables. Correlation coefficients can vary between 1.0 (perfect positive correlation) and -1.0 (perfect negative correlation). Perfect positive correlation (1.0) means that as one of the two variables increases, the other variable always increases linearly. Perfect negative correlation (-1.0) means that as one variable increases, the other variable always decreases linearly.

Correlation does not always imply causation; that is, even if two variables are correlated, it does not necessarily mean that one variable is actually causing the outcome of the other variable. This happens, for example, if both variables are influenced by some other variable which is not in the model.

You will now re-run the model from Section 3.4 to generate Value Correlations. You have to tell DPL to run Full tree enumeration to do this.

⇒ Make sure the "License vs. In-house downstream" model (or whatever you named it earlier) is still Main.
⇒ Select Run | Decision Analysis or press F10. The Decision Analysis Options dialog appears.
⇒ Select Full tree enumeration. Value Correlations now becomes an option.
⇒ Select Value Correlations.
⇒ Leave the other outputs selected if you would like to re-generate them.
⇒ Click OK.

DPL creates an item for Value Correlations in the Workspace Manager.

⇒ Double-click on the Value Correlations item to activate the window. The Value Correlations chart is displayed as in Figure 3-30.
Chapter 3: Decision Analysis Results

The Value Correlations chart assumes that the optimal decision policy is followed. It tells you which values in your model tend to vary in the same direction (positive correlation) or in the opposite direction (negative correlation) as the objective function, which in this case is Profit. Positive correlations are shown as purple bars, while negative correlations are royal blue. A correlation (bar) is shown for each value in the model for which the correlation coefficient can be calculated. Each value corresponds to either a decision node, a chance node, or a value node in the model. If a chance node or decision node has no values associated with it, DPL correlates the state numbers with the objective function. E.g., for a decision node with two alternatives, the first alternative has a state number of 1 and the second alternative has a state number of 2.

As Figure 3-30 shows, several of the values are highly correlated with the objective function. The first bar (Profit) simply indicates that the objective function is perfectly correlated with itself. Revenues, Production Costs, Sales, and Sales2 are all highly positively correlated with the objective function. This makes sense because the higher the product sales are, the higher the revenues and profits (and also, production costs) are. On the
other hand, Per Unit Costs and Marketing Costs are negatively correlated with the objective function (Profit). License Fee and Price are not correlated with the objective function at all because they are fixed (deterministic) values.

In decision analyses with complex value models, Value Correlations charts are useful for understanding how the variability in the objective function is related to the variability in individual values such as chance nodes and downstream decisions.

3.6 Rainbow Diagram on a Value

The rest of this chapter addresses Rainbow Diagrams, which are another form of sensitivity analysis. A Rainbow Diagram provides more detailed information on how the objective function of the model and the optimal policy change as a single variable is varied across a range of settings. You will now create a Rainbow Diagram for a value node in the model.

Select Run | Rainbow Diagram. The Run Rainbow Diagram dialog appears as shown in Figure 3-31.

![Figure 3-31. Run Rainbow Diagram Dialog]
压迫Select按钮以选择对话框中的变量。

选择License_Fee作为灵敏度下拉菜单中的值，如图3-32所示。

图3-32. 选择Rainbow图对话框

点击OK。

在运行Rainbow图对话框中，将From:和To:值分别设置为"0.7"和"0.9"。

将步长设置为"0.025"。运行Rainbow图对话框应如图3-33所示。

图3-33. 运行License Fee的Rainbow图

点击OK运行Rainbow图。
A Rainbow Diagram displays the value of the model's objective function on the y-axis and the values of the selected variable on the x-axis. The diagram shows how the objective function value changes as the variable setting changes across the specified range. The Rainbow Diagram for License Fee should look like Figure 3-34. The diagram indicates that as License Fee increases from 0.7 to 0.825 there is no change in the objective function value, but as License Fee increases from 0.825 to 0.9 there is an increase in the objective function value.

Rainbow Diagrams also indicate policy changes by changes in color. Since the Rainbow Diagram in Figure 3-34 changes color between 0.825 and 0.85, you know that a policy change occurs in that region. As with Tornado diagrams, the vertical line where the color changes does not indicate the precise point at which the policy changes. The vertical line is drawn halfway between the two settings of the variable between which a policy change has occurred. In this instance, License Fee is tested at 0.825, which results in one policy, and again at 0.85, which results in a second policy.
Therefore the vertical line is drawn at 0.8375. If you want more precise information on where the policy change occurs you can run another Rainbow Diagram with finer increments.

In a Rainbow Diagram, DPL starts with a color and changes to a new color every time there is a policy change. The color of the region does not relate to the value of the variable, i.e., blue does not mean that the high setting of the variable resulted in a policy change. It only indicates that a policy change has occurred. You can use your mouse to find out which policy applies in each colored region if you have Show Tips turned on. You turned these on earlier but you may need to check that they are on.

⇒ To check if Show Tips is on, select Tools | Options. The Options dialog appears.
⇒ Select the General tab.
⇒ Make sure Show Tips is checked.
⇒ Click OK.
⇒ Place your mouse cursor over one of the markers on the boundary of the region. A policy tip will appear as indicated in Figure 3-35.
The policy tip tells you the expected value of the model given the value of the variable that the marker represents. For example, the policy tip in Figure 3-35 indicates that the expected value of the model is 34.3 when License Fee is 0.85. The policy tip also tells you the policy dependent probabilities for each decision in the model given the value of the variable that the marker represents. The decision alternatives are displayed in the policy tip by using the decision node name followed by a colon followed by the decision alternative. E.g., "Product Strategy: License". The policy dependent probability for the alternative follows the equal sign. As Figure 3-35 indicates, the policy when License Fee is 0.85 is to License out production of the product and to keep price the same in time period 2. To keep the policy tip compact decision alternatives with a policy dependent probability of zero are not displayed.

You have completed a Rainbow Diagram on one value in your model, namely License Fee. You will now see how to run a Rainbow Diagram on a probability.

3.7 Rainbow Diagram on a Probability

When you ran the Rainbow Diagram in Section 3.6, you may have noticed that the only variables you could select in the Select Value for Rainbow dialog were values. What if you would like to run a sensitivity analysis on a probability? You will need to modify your model slightly to do so.

- Double-click on the item for the "License vs. In house downstream" model in the Workspace Manager. The Model Window becomes active.
- Add a value node to the model by clicking on the Create Value toolbar button (see Table 1-2).
- Click anywhere in the Influence Diagram Pane. The Node Definition dialog comes up with the General tab selected.
- Name the value "p".
- Click the Data tab.
- Type "0.6" as shown in Figure 3-36.
Figure 3-36. Node Definition Dialog Data Tab for $p$

- Click OK.
- Double-click the Per Unit Costs node to edit it. The Node Definition dialog appears with the Data tab selected.
- In place of "0.6" for the probability of Nominal, type "p".
- Press the down arrow twice to select the probability for High.
- Delete the "0.4" that is there for the Probability of High.
- Press Enter. Your node data for Per Unit Costs should now look like Figure 3-37.
Figure 3-37. Node Definition Data Tab for Per Unit Costs

Note: in the changes you just made you left the probability of the last outcome of the discrete chance node blank. You can always do this. DPL will assign one minus the sum of the rest of the outcome probabilities to the last outcome. In this instance, you must do this. Rather than entering a number for the probability of Nominal, you have now entered a value. The use of a value such as "p" in the probability expression of an outcome is called a non-constant probability expression. When you use a non-constant probability expression for any of the chance outcomes in a node, you must leave the last probability expression blank. This helps to ensure that the probabilities of all the outcomes sum to one.

⇒ Click OK to close the Node Definition dialog.
Select Run | Rainbow Diagram. The Run Rainbow Diagram dialog appears.

Click the Select button.

Select p in the Select Value for Rainbow dialog.

Click OK.

In the Run Rainbow Diagram dialog, specify the From: and To: values to be "0.3" and "0.9", respectively.

Set the Step size to be "0.05". The Run Rainbow Diagram dialog should now look like Figure 3-38.

Click OK to run the Rainbow Diagram.

DPL produces the Rainbow Diagram for p as shown in Figure 3-39. The Rainbow Diagram indicates that while the objective function increases from approximately 32.4 to 34.6, no policy changes occur as p varies from 0.3 to 0.9. In this instance, you can be comfortable with your estimation of the probability of Nominal for Per Unit Costs. Over a fairly wide range of probability, it does not change the optimal strategy. Note, however, that the Rainbow Diagram in Figure 3-37 still assumes that the value for Per Unit Costs is no lower than 0.8 and no higher than 0.9. The Rainbow Diagram tests the sensitivity of the optimal policy to the probability that Per Unit Costs is Nominal or High given the specified Nominal and High values of the outcomes.
Figure 3-39. Rainbow Diagram for p

You have now reached the end of the tutorial on building and analyzing DPL decision analysis models. Though the model you developed in this tutorial is fairly simple, you now have the essential skills needed to develop realistic models of more complex decisions.
4 Building Models from Spreadsheets

This tutorial focuses on building a DPL model that is linked to a spreadsheet. This model might be typical of a model developed for valuation purposes. The tutorial will familiarize you with key spreadsheet-related features of DPL by providing step-by-step guidance on how to create a DPL model from Excel, modify the model and generate results from it.

If you haven't already, please refer to Chapter 1 for a quick overview of DPL's interface.

4.1 Creating a Model from Excel

- Load DPL by double-clicking the icon on your desktop, double-clicking the icon in Windows Explorer or launching it from the Start Menu.

DPL will load in a maximized state with an empty Model Window maximized on the right-hand side of the screen as shown in Figure 4-1.

- Drag the splitter down so that approximately three-quarters of the Model Window is occupied by the Influence Diagram Pane (for the moment, you will be mostly working in the Influence Diagram Pane).
A sample Excel file was delivered with DPL. You will use this file to create a DPL model.

 ⇒ Select Model | Create from Excel as shown in Figure 4-2.
Chapter 4: Building Models from Spreadsheets

Figure 4-2. Selecting Model | Create from Excel

The Create Model from Excel dialog appears as shown in Figure 4-3.

Figure 4-3. Create Model from Excel Dialog

Click Browse... to select the input file.

Navigate to the Examples folder underneath where you installed DPL. If the default location was used for installing, the path is C:\Program Files\Syncopation\DPL7\Examples.

Select "Cash Flow.xls" as shown in Figure 4-4.
Chapter 4: Building Models from Spreadsheets

Syncopation Software

Figure 4-4. File Dialog to Select Input File Name

Click Open. You are returned to the Create Model from Excel dialog with the name and path of the spreadsheet filled in the Spreadsheet name edit box as shown in Figure 4-5.

Figure 4-5. Create Model from Excel with Spreadsheet Selected

Leave the Hide intermediates checkbox checked.

Leave the Select radio button selected.
When you build a DPL model from Excel, you will typically want to have DPL send different sets of input values to Excel and have Excel send back to DPL one or more output values. Nodes in DPL that send data to Excel are called export nodes. Nodes that receive data back from Excel are called import nodes. Export nodes in DPL are typically linked to cells in Excel that contain numbers and not formulas. (Note: you can export numbers to Excel cells that contain formulas. If you have Reset Excel values/formulas after run turned on in Model | Options | Spreadsheet, the formulas in the cells will be restored after the run.) Import nodes in DPL are typically linked to cells in Excel that contain formulas and not numbers.

There will usually be a number of intermediate calculations in Excel that are neither appropriate for export nodes nor import nodes. These are referred to as intermediates. For example, if you had more than one revenue stream in your financial model, you might have a cell or range called Total Revenues. Total Revenues would not be appropriate to link to an export node, since it will have a formula in it and you would likely have DPL send data for the individual revenue components to Excel rather than the total. It is also unlikely to be linked to an import node, since your financial model is likely to be calculating something like net present value (NPV) which takes into account costs and the timing of cash flows.

By default, the Hide intermediates checkbox is checked. Hide intermediates will be discussed further below.

The Select radio button will allow you to select which nodes/cells to include in your model. If you select the Include all radio button, then DPL will include all non-intermediate nodes/named cells in the model you are creating. (If the Hide intermediates checkbox is not checked, DPL will include all nodes/named cells.)

→ Click OK. The Cell Names dialog appears as shown in Figure 4-6.
Figure 4-6. Cell Names Dialog

The Cell Names dialog displays all named cells in the spreadsheets that have values in them and all named cells that have formulas in them and that are not intermediate calculations. (If Hide intermediates were not checked in the Create Model from Excel dialog, then DPL would also display named cells that contain intermediate calculations in the Cell Names dialog. Intermediate cells have formulas in them.)

Important note: DPL only displays named cells in the Cell Names dialog. Before creating a model from Excel in DPL, you should ensure that cells you wish to include in the model are named in Excel. If you select a named cell in Excel, the name will appear in the drop-down list to the left of the formula bar. Please consult your Excel documentation if you are not familiar with named ranges, as they are essential for using DPL with Excel.
The Cell Names dialog displays three pieces of information in the list box. The variable Name of the node/cell as it will be referred to in DPL is displayed in the Name column. The variable name in DPL differs slightly from the name of the node that will be created. A node name can have spaces and other special characters (such as punctuation marks) but a variable name cannot. In variable names, DPL uses the underscore ("_") character for any spaces and special characters that might be in the node name. For example, Initial_license will be the variable name for the node called Initial license. The Location of the cell in the spreadsheet is displayed in the Location column. The type (formula/value) of the cell is displayed in the Type column.

The list of nodes/cells shown in Figure 4-6 is typical for an Excel financial model that uses one numeraire or criterion (e.g., NPV) to calculate the value of an asset, project, business unit or business. The list is typical in that it contains a number of cells of type value and one cell of type formula. As you develop your DPL model further, you will see that DPL sends data to Excel for each of the value cells and receives data back from Excel for the formula cells.

⇒ Click Select All to select all the cells in the list as shown in Figure 4-7.
Figure 4-7. Cell Names Dialog with All Cells Selected

⃕ Click OK.

DPL uses the information and relationships contained in the spreadsheet to create an influence diagram with only value nodes and influence arcs in the Influence Diagram Pane. Your model should now look like Figure 4-8. Note in the Workspace Manager that DPL gives the model the same name as the spreadsheet without the file extension.
A value node represents a quantity in a DPL decision model that is not uncertain. It can be a constant (i.e., a number) or a formula. Value nodes are represented by rounded blue rectangles in the Influence Diagram Pane. When you build a model from Excel (if you exclude intermediates), the value nodes will all be constant values.

An influence arc indicates one or more of three things to DPL: 1) dependency, 2) conditioning and / or 3) timing. An influence arc that points from node A to node B indicates that node B depends on, is conditioned by and / or occurs before node A. In the model that you just created from Excel, all of the arcs lead into NPV. In this instance the arcs are indicating dependency. Therefore NPV depends on all the nodes in the influence diagram. This makes sense since in the Excel spreadsheet the calculation for NPV depends on the settings of all the input variables.

Double-click on the Initial license value node in the Influence Diagram Pane to edit its definition. The Node Definition dialog comes up with the Data tab selected. See Figure 4-9.
Note that the data filled in for Initial license is 13000. This is the value of the cell that the node is linked to in the spreadsheet. You will confirm this in a moment.

![Figure 4-9. Node Definition Data Tab for Initial License](image)

Switch to the Links tab of the Node Definition dialog. See Figure 4-10.
The Links tab contains information about the links between the node and Excel. There are two categories of links that a node can have with Excel: calculation links and initialization links. Calculation links are used to send data to or receive data from Excel during the course of a run. Initialization links are used to initialize the possible set of values (or probabilities) for a node once at the beginning of each run. Initialization links are discussed more in Appendix A.

The radio buttons near the top of the Calculation links section of the dialog indicate whether the node is linked and if so, to what (Excel or a DPL Program). The workbook as well as the sheet and cell that the node is linked to are displayed in edit boxes. The sheet and cell syntax is the same as Excel's syntax (i.e., Sheet1!Cell_name).
The Calculation links section also contains a number of buttons. Table 4-1 below summarizes what these buttons do.

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browse</td>
<td>Finds a spreadsheet or allows you to change to which spreadsheet this node is linked.</td>
</tr>
<tr>
<td>Cell Names…</td>
<td>Brings up the Cell Names dialog which can be used to change the sheet/cell to which this node is linked.</td>
</tr>
<tr>
<td>Go to Cell</td>
<td>Takes you to the cell in Excel to which this node is linked.</td>
</tr>
<tr>
<td>Paste Link</td>
<td>Pastes a link to a cell from Excel.</td>
</tr>
</tbody>
</table>

Table 4-1. Calculation Links Buttons

⇒ Click the Go to Cell button.

DPL loads the spreadsheet to which the node is linked if it is not already loaded, activates Excel and selects the sheet and cell to which the node is linked. As you can see in Figure 4-11, the cell named Initial_license contains the value 13000 which is what DPL filled in for the node's data.
4.2 Running a Model

You will now run the model you have just created from Excel.

⇒ Select Run | Decision Analysis (or press F10 which is the shortcut for Run | Decision Analysis). The Model Get/Pay dialog appears as shown in Figure 4-12.
DPL is asking you to confirm which of the variables in the model should be used as the output of the model. DPL suggests NPV. This is correct and is the only logical output value in this model. However, if your Excel model not only calculated NPV but also calculated internal rate of return (IRR), payback period or other financial measures and you had selected them to be included in the DPL model when you created it from Excel, then IRR or payback period, etc. might be your desired output of the model. DPL needs to know which variable to use and asks you to confirm its selection, even if there is only one logical choice.

As you continue to build your model, you will see it is called a get/pay expression because in certain instances, rather than getting a value (i.e., receiving it) you might pay a value.

 ⇒ Click OK. The Decision Analysis Options dialog appears as shown in Figure 4-13.
The Decision Analysis Options dialog allows you to specify a number of settings for a decision analysis run. You will cover these settings on the dialog in more detail later.

- For now, uncheck Risk Profile.
- Click OK.
- DPL runs the model and brings up the Analysis Complete dialog. See Figure 4-14.
You will not normally see the Analysis Complete dialog; however, the model you have just created from Excel is deterministic (i.e., it has no chance nodes, which you will learn more about soon). Many of the usual outputs in the Decision Analysis Options dialog are not appropriate for a deterministic model; in fact, most of them were unavailable in the dialog. Since you did not ask for any of the outputs, DPL displays the expected value of the model in the Analysis Complete dialog. In this instance, expected value is a slight misnomer because the model you have built is deterministic. What is displayed in the Analysis Complete dialog is NPV given the data in all the export nodes of the model. This NPV matches the NPV in Excel, assuming you haven't changed any of the cells in Excel so that they don't match the values in the export nodes.

⇒ Click OK to close the Analysis Complete dialog.
⇒ If you'd like, switch to Excel and confirm that the NPV is the same as in the Analysis Complete dialog.
⇒ Switch back to DPL.

Typically when you create a DPL model from Excel, you do so because you are interested in understanding the range of the value measure (called the objective function in DPL) for your model (e.g., NPV) under different scenarios or sets of inputs to the model. You accomplish this in DPL by changing value nodes into chance nodes and running a probabilistic model. The probabilistic model will provide you with the range of outcomes of your objective function as well as the expected value of the objective function.

A useful first step in creating a probabilistic model from your deterministic model is to run a Value Tornado.

⇒ Before you run a Value Tornado, save your Workspace. Select File | Save Workspace As and give the file a name.
4.3 Running a Value Tornado to Identify Key Value Drivers

A Value Tornado helps you identify which variables have the biggest impact on your objective function. You can use this information to help you decide which variables in your model should be modeled probabilistically and which can be left at a fixed setting.

Select Run | Tornado Diagram (or press F8 which is the Run | Tornado Diagram shortcut).

Because there are no uncertain variables (chance nodes) in your model yet, the Value Tornado is the only tornado diagram available. The Value Tornado Setup Dialog appears as shown in Figure 4-15.

Figure 4-15. Value Tornado Setup Dialog
The Value Tornado Setup dialog provides a table in which to enter the low and high settings (range) for each value node that is a constant in the current model. DPL has also filled in the Current setting for each variable in the table.

You will now enter the range for several of the value nodes shown in Figure 4-15. First, you will remove some of the value nodes from the table, since you don’t need all of them to appear in the tornado.

- Click the cell in the Low column of the value Discount rate. The cell will turn magenta.
- Click the Remove button. Discount rate will disappear from the setup table.
- Repeat these steps to remove Payment fee, Wages phase 1, and Wages phase 2 from the setup table.

The Value Tornado Setup dialog should now look like Figure 4-16.
⇒ Click the blank cell in the Low column of the first value node, Consulting phase 1 growth.
⇒ Type 0.1 for the Low value of Consulting phase 1 growth.
⇒ Press Enter.
⇒ Click the blank cell in the High column of Consulting phase 1 growth.
⇒ Type 0.2 for the High value of this value node.
⇒ Press Enter.
⇒ Using the arrow keys, continue selecting the cells and specifying the high and low values as indicated in Table 4-2 below.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Low</th>
<th>High</th>
</tr>
</thead>
<tbody>
<tr>
<td>Consulting_phase_2_growth</td>
<td>0.06</td>
<td>0.14</td>
</tr>
<tr>
<td>Initial_consulting</td>
<td>5000</td>
<td>7000</td>
</tr>
<tr>
<td>Initial_license</td>
<td>10000</td>
<td>16000</td>
</tr>
<tr>
<td>Initial_training</td>
<td>6000</td>
<td>10000</td>
</tr>
<tr>
<td>License_phase_1_growth</td>
<td>0.15</td>
<td>0.25</td>
</tr>
<tr>
<td>License_phase_2_growth</td>
<td>0.08</td>
<td>0.16</td>
</tr>
<tr>
<td>Marketing_phase_1</td>
<td>5000</td>
<td>15000</td>
</tr>
<tr>
<td>Marketing_phase_2</td>
<td>8000</td>
<td>20000</td>
</tr>
<tr>
<td>Training_phase_1_growth</td>
<td>0.1</td>
<td>0.2</td>
</tr>
<tr>
<td>Training_phase_2_growth</td>
<td>0.06</td>
<td>0.14</td>
</tr>
</tbody>
</table>

Table 4-2. Value Tornado Variables
When you are done, the completed Value Tornado Setup dialog should look like Figure 4-17.

![Figure 4-17. Completed Value Tornado Setup Dialog](image)

After you have specified the range for the last variable in Table 4-2, click OK. DPL creates the Value Tornado diagram and displays it as shown in Figure 4-18.
The x-axis (horizontal axis) of the Value Tornado displays the change in the objective function of the model as each of the variables on the left is changed from the low setting you specified to the high setting you specified. Each variable is changed from its low setting to its high setting while all other variables are held at their current settings. DPL runs the model once to establish the value of the objective function with all variables at their current setting. This is called the Base Result and is indicated by the vertical line in the Value Tornado. Note that the vertical line on the diagram is placed at the expected value that you obtained when you ran the model in Section 4.2.

As the tornado diagram legend indicates, DPL displays policy changes by a change in color of the bar. In the tornado diagram in Figure 4-18, there are no policy changes indicated. Since there are no decisions in your model at this point, policy changes are not relevant. See Section 2.5 for more information on Value Tornado diagrams and policy changes.

⇒ If you’d like to see the exact value of the Base Result, select View | Values.
The Base Result is displayed at the top of the vertical line.

⇒ If you'd like, try out some of the other commands under the View menu.

DPL sorts the bars in a Value Tornado so that the variable that results in the biggest change in the objective function is on top. When considering which value nodes to treat as uncertainties, variables at the top of the Value Tornado are good candidates.

You will now change the type of several of the value nodes in the model to treat them as uncertainties.

4.4 Creating a Probabilistic Model

To turn the deterministic model that you created from Excel into a probabilistic model, you will change several of the value nodes in the model into discrete chance nodes. A discrete chance node represents a value that you are uncertain about. It takes on one of a finite number of settings. Each of these settings occurs with a specified probability. See Section 2.6 for a further discussion of discrete chance nodes.

Before you make changes to the model, you will duplicate it so that you can preserve the deterministic model.

⇒ Right-mouse click the item for the model in the Workspace Manager. It should read "Main: cash flow" unless you renamed it.

⇒ Select Duplicate in the Workspace Manager context menu as shown in Figure 4-19.
Figure 4-19. Workspace Manager Context Menu with Duplicate Selected

DPL makes a copy of the model and calls it cash flow – copy. It becomes the active Model Window as shown in Figure 4-20.
Select the item for "cash flow – copy" in the Workspace Manager.
Press F2 to edit the name.
Rename the model "cash flow – prob" as shown in Figure 4-21.
If necessary, drag down the splitter bar between the Influence Diagram Pane and the Decision Tree Pane so that you have more room to work in the Influence Diagram Pane.

Select the Initial license node by clicking on it. It will turn magenta to indicate it is selected.

DPL uses magenta to indicate that an object in the Influence Diagram Pane or Decision Tree Pane is selected.

Click the Change Node Type button in the model toolbar (see Table 1-2). (Or press Ctrl+T or select Node | Change Type.) The Node Type dialog appears as shown in Figure 4-22.
Select Discrete Chance as shown in Figure 4-23.

Click OK.

The Node Definition dialog appears with the General tab selected as shown in Figure 4-24. The General tab of the Node Definition dialog for a discrete chance node contains an Outcomes list box. You can add, delete, insert or rename chance outcomes. DPL has automatically created three chance outcomes and named them "Low", "Nominal" and "High". These settings can be changed in the Tools | Options dialog on the General tab (Tools | Options | General).
Leave the settings as they are on the General tab and select the Data tab as shown in Figure 4-25.

The Data tab displays a data input tree for the discrete chance node. The Data tab contains a Probability edit box and a Value edit box above the data input tree. The magenta highlight in the data input tree indicates which outcome of the discrete chance node is selected for editing. The numbers that appear in the Probability and Value edit boxes are the data for the selected outcome.
Chapter 4: Building Models from Spreadsheets

Syncopation Software

Figure 4-25. Node Definition Dialog Data Tab

There are a number of buttons on the Data tab which allow you to change items such as the node's conditioning, to view things differently by changing the zoom or going to full screen or to help you input the data for this node by selecting values or functions. The Select Variable button ( ), Conditioning button and Full Screen button are covered in Chapters 2 and 3 of this manual.

DPL assigns probabilities of 0.3, 0.4, and 0.3 to the three chance outcomes. These default probabilities can be changed in Tools | Options | General. DPL also assigns the low and high values that you specified in the Value Tornado to the Low and High outcomes, as well as the value that was initially set for the value node when the model was created from Excel to the Nominal outcome.
Click OK to accept the probabilities and the low, nominal and high values.

Click anywhere in the Influence Diagram Pane or press ESC to de-select Initial license.

Your model should look something like Figure 4-26. A discrete chance node is represented as a bright green oval in the Influence Diagram Pane.

Figure 4-26. Cash Flow Model with One Discrete Chance Node

In the Decision Tree Pane, DPL has begun to build a decision tree for you. This decision tree is called the Default Tree. Up to this point, your model had no chance nodes in it (or decision nodes, which we will discuss soon) so DPL did not build a Default Tree for you. If you do not modify the decision tree in the Decision Tree Pane yourself, DPL will continue to build a Default Tree for you. If you build your model entirely from the Influence Diagram Pane and find once it is completed that DPL's Default Tree has the correct sequence of events and structure for the model, then there is no need to change the Default Tree. Once you modify the decision tree, you have taken control and DPL will no longer modify your tree. However, you
can always ask DPL to discard the current tree and re-create the Default Tree from the current influence diagram. To do this, you select Model | Rebuild Default Tree.

Note that DPL displays NPV on the branches of the Initial license node in the Decision Tree Pane. DPL displays get/pay expressions below the branches of the node on which they occur.

In the Decision Tree Pane, DPL displays discrete chance nodes as bright green circles.

The decision tree in the Decision Tree Pane indicates the timing of events, whereas the influence diagram in the Influence Diagram Pane largely indicates the relationships between variables (though as discussed earlier, influence arcs can indicate timing). The Default Tree in the Decision Tree Pane as it currently stands indicates to DPL to gamble on Initial license and then to get NPV. Gambling on a discrete chance node and then getting NPV means DPL will run the model once for each outcome of the discrete chance node using the value of the node associated with that outcome (e.g., 10000 for the Low outcome of Initial license) to calculate NPV. DPL then rolls back the tree by multiplying the probability of each outcome by the NPV in each case. The rolled back tree produces an expected NPV in this example.

You will now change five additional value nodes into discrete chance nodes using one DPL command.

Select five value nodes at once as follows. Hold down the Ctrl key and click each of the nodes listed in Table 4-3. The five value nodes will turn magenta, indicating that they are selected.
Table 4-3. Variables to Change to Discrete Chance Nodes

- Once again, click the Change Node Type button in the model toolbar (see Table 1-2), or press Ctrl+T or select Node | Change Type.
- Click on Discrete Chance as shown in Figure 4-27.
- Click OK.
- Double-click on any of the five nodes you just changed. You will see that DPL has changed each value node into a discrete chance node with three states, the default probabilities (0.3, 0.4 and 0.3), and the High and Low values that you specified earlier in the Value Tornado for the Low and High outcomes.
This multiple node change type feature can be used whenever you wish to change more than one value node to a discrete chance node with three states. DPL assigns the default settings to the new chance nodes, and you can change these settings if necessary by simply editing the newly changed nodes as usual. (Note that if you had not already set up a Value Tornado Diagram using these value nodes, you would have had to specify the High and Low values for the newly changed chance nodes.)

When you are done changing the types of the nodes in Table 4-3, your model should look like Figure 4-28.

Figure 4-28. Cash Flow Model with Six Discrete Chance Nodes

Note that DPL has continued to build the Default Tree for you. With each additional value node that you change to a discrete chance node, it adds that to the tree and moves the get/pay expression to the branches of the last (or rightmost) node. DPL moves the get/pay expression for NPV to the branches of the last node in the tree because it cannot calculate NPV until all chance nodes are in a known state. The Default Tree in the Decision
Tree Pane indicates to DPL to gamble on the six discrete chance nodes and then get NPV. There are 3 to the 6th power (or 729) paths (a path is a single combination of outcomes for each node in the tree) in the Default Tree as it stands.

You are almost ready to run the modified model. Now that there are two models in the Workspace you need to indicate to DPL which one is the Main Model. When you ask DPL to do a run, DPL runs the current Main Model.

Seek Select Model | Main.

If the active Model Window contains the Main Model, DPL indicates this by placing a check next to Main in the Model menu.

Seek Click the Model menu item again to see this as indicated in Figure 4-29.

Note: DPL also indicates which model is the Main Model in the Workspace Manager by prefacing the item for the Main Model with "Main:". You can also see this in Figure 4-29. Another way to make a model Main is to right-click on the model name in the Workspace Manager and select Make Main from the context menu.
Figure 4-29. Main Model Indicator in Menu

⇒ Select Run | Decision Analysis.

If as you were changing value nodes to discrete chance nodes you did not review the value and probability data, then DPL will display the question shown in Figure 4-30. DPL wants to make sure you are aware that default probabilities will be used for the nodes for which you did not review their data. If you reviewed each node’s data, you will not see this question. Note: if you looked at the data but clicked Cancel to close the Node Definition dialog, you will also see the question in Figure 4-30.

Figure 4-30. Default Probability Review Warning
If the question in Figure 4-30 appears, click Yes. The Decision Analysis Options dialog appears as shown in Figure 4-31.

![Decision Analysis Options Dialog](image)

Figure 4-31. Decision Analysis Options Dialog

A number of additional items will be enabled on the Decision Analysis Options dialog. For a description of all the settings on the Decision Analysis Options dialog, see Table 3-1.

For our purposes here, we will reduce the number of policy levels to 2 and produce a Risk Profile and a Policy Tree™.

- Make sure Risk Profile is checked.
- Check Policy Tree™.
- Set Number of levels to 2.
- Make sure the following are not checked: Policy Summary™ and Expected Value of Perfect Information / Control. See Figure 4-32.
Chapter 4: Building Models from Spreadsheets

Syncopation Software

Figure 4-32. Decision Analysis Options Dialog Before Probabilistic Run

⇒ Click OK.

The DPL Analysis dialog appears as shown in Figure 4-33. The status bar indicates the progress of the analysis.

Figure 4-33. DPL Analysis Dialog

⇒ If you'd like to see the progress of the analysis on the decision tree in the Decision Tree Pane, slide the Status Display Levels slider to the right.

DPL indicates with magenta which branch of each node it is currently analyzing. Having the Status Display Levels set to a high number can have
a significant negative impact on performance. For shorter runtime, slide the slider all the way to the left.

When the run is complete, DPL produces the requested outputs and displays the Policy Tree™ output as shown in Figure 4-34.

![Policy Tree™ Output for Probabilistic Cash Flow Model](image)

**Figure 4-34. Policy Tree™ Output for Probabilistic Cash Flow Model**

At the front or root (far left) of the Policy Tree™, DPL displays the expected value of the objective function of the model (NPV in this case) given the chance nodes that have been incorporated into the model. The expected value of the objective function is displayed in square brackets (e.g., [5892.567]).

The rolled back expected value at each point further "down" (i.e., to the right) in the Policy Tree™ is also displayed in square brackets next to the node for which it applies (e.g., [-39703.521]). These rolled back expected values are the expected value of the subtree headed by the node below and to the right of the value. They indicate the expected value given the outcomes that precede them in the tree. For example, given that Initial
license is in its Low outcome, then the expected value of the objective function is -39703.521 (i.e., NPV is -39703.521).

As discussed earlier, DPL rolls back the tree by multiplying the probability of an outcome by the rolled back expected value of the objective function for the outcome. So 5892.567 equals 0.3 * -39703.521 + 0.4 * 5892.567 + 0.3 * 51488.656.

You can rename the Policy Tree™ with a new name if you like. Right-click on the item for the Policy Tree™ and select Rename.

If you rename the Policy Tree™ DPL will then save the Policy Tree™ under the new name below the model to which it belongs. The next time you run this model a new Policy Tree™ will be created.

For a further discussion of the Policy Tree™ output, see Section 3.1 of Chapter 3.

As shown in Figure 4-34, DPL creates an item in the Workspace Manager for each of the outputs it created. To be exact, DPL creates one or more items for each output. For Risk Profiles, DPL creates an item for the Risk Profile chart and an item for each Risk Profile dataset that is created. For the run you just requested, DPL created one Risk Profile dataset and a Risk Profile chart to display it. In the Workspace Manager, a Risk Profile chart is indicated by the icon ( ) and a Risk Profile dataset by the icon ( ). By default, DPL names the Risk Profile chart and dataset "Expected Value" (see Section 3.2 and Table 3-1 for more information). Note: For items in the Workspace Manager that do not correspond to windows (e.g., a Risk Profile dataset), DPL indicates these with curly braces around the name, i.e., "{Expected Value}".

Every time you run a model, DPL will replace the Expected Value Risk Profile dataset with the one from the current run. You will learn how to save Risk Profile datasets at the end of this section.

Double-click on the item for Risk Profile chart called Expected Value ( ) in the Workspace Manager to activate the window. You may also select it and press Enter. The Expected Value Risk Profile chart becomes active as shown in Figure 4-35.
Note: you can also double-click on the Risk Profile dataset called Expected Value. DPL activates the Risk Profile chart that displays it. If you double-click on a Risk Profile dataset that is not displayed in a Risk Profile chart, DPL creates a chart for the dataset and activates the chart.

![Risk Profile Chart for Probabilistic Cash Flow Model](image)

**Figure 4-35. Risk Profile Chart for Probabilistic Cash Flow Model**

By default, DPL creates a cumulative Risk Profile chart. A cumulative Risk Profile chart displays the objective function on the x-axis (horizontal axis) and cumulative probability on the y-axis (vertical axis). A cumulative Risk Profile chart can be read by choosing a value on the x-axis, determining where the Risk Profile intersects with the vertical line "drawn" from the value, and then "drawing" a horizontal line over to the y-axis. The value where the horizontal line meets the y-axis is the probability that the objective function is less than or equal to the chosen value on the x-axis. For example, if you choose the value 0, you see that the vertical line drawn from 0 intersects the Risk Profile at a probability value of just less than 50%. Therefore, in nearly 50% of the scenarios the objective function is 0 or less (i.e., NPV is 0 or less).
A Risk Profile chart can be formatted in a number of ways. You will now add an expected value line to the chart.

- Select Format | Display. The Format Diagram dialog appears with the Display tab selected.
- Check Expected Value / Certain Equivalent Lines.
- Check EV / CE Values.
- Click OK. DPL updates the chart to show the expected value of the Risk Profile dataset displayed in the chart as shown in Figure 4-36.

Since the Risk Profile dataset displayed in the chart is the distribution of outcomes of the objective function, the expected value line (and the value displayed below the line) is the expected value of the objective function. In this example, the expected value is approximately the median or 50% percentile of the distribution; this is not always the case.
See Section 3.2 for more information on formatting Risk Profile charts. You will use the Risk Profile dataset you just created again later. In order to prevent it from being overwritten when you next run the model, you need to save it under a different name.

⇒ Select the Expected Value dataset in the Workspace Manager.
⇒ Press F2 to edit its name.
⇒ Name it "With Consulting" as shown in Figure 4-37 (it will become clear later why you are calling it With Consulting).
⇒ Press Enter.

DPL creates a copy of the Risk Profile dataset and calls it With Consulting as shown in Figure 4-38. Note: now that you have copied the Expected Value Risk Profile dataset to With Consulting, if you rename the new dataset again DPL will rename it. DPL will not create another copy of it.
You will now modify the probabilistic model you have developed to incorporate a decision node.

4.5 Adding Decision Nodes to a Model Created from Excel

If you have reviewed the Cash Flow.xls spreadsheet model, you may have noticed that the revenues from the fictitious software company come from several different sources. The decision you are about to add will examine whether one of the revenue streams, Consulting, has positive net present value or not. In order to do this, you will add a decision node to your model.
In DPL, a decision node has two or more alternatives which DPL will choose among based on which decision alternative maximizes the objective function of the model. A decision node is represented in the influence diagram by a yellow square.

Before you make any modifications to DPL, you will link your model to a different Excel cash flow model that has the logic included to evaluate a decision whether to Pursue Consulting. You will start from a copy of the model you have built thus far.

1. Make a copy of cash flow – prob by right-mouse clicking the item for it in the Workspace Manager and selecting Duplicate.
2. Rename the duplicated model "cash flow – decision" as indicated in Figure 4-39.

Next you will re-link your model to a slightly revised cash flow model.

Figure 4-39. Workspace with Newly Duplicated Model Renamed to cash flow - decision
Select Model | Links. The dialog shows you that the nodes in your model are linked to the Cash Flow.xls spreadsheet.

You may need to drag the column separator to the right to see the full path and name of the linked spreadsheet.

Click Browse.

Navigate to the Examples folder where you installed DPL. The default location is C:\Program Files\Syncopation\DPL7\Examples.

Select "Cash Flow with Decision.xls".

Click Open. You are returned to the Model Links dialog. The Model Links dialog should look like Figure 4-40.

Click Close.

Now you will add the decision node to your model.

To create a decision node, click the Create Decision button (see Table 1-2) on the toolbar as shown in Figure 4-41.
Figure 4-41. Create Decision Button on the Model Toolbar

The mouse cursor changes to a crosshair with an outline of a decision node to help you place the decision node in the Influence Diagram Pane. See Figure 4-42.
Figure 4-42. Mouse Cursor as Crosshair with Decision Node Outline

- Click below and to the left of the Consulting phase 1 growth value node as indicated in Figure 4-42. The Node Definition dialog appears.
- Type "Pursue Consulting" in for the Name of the node. Your node definition dialog should now look like Figure 4-43.

Note that there is an Alternatives list box on the General tab of the Node Definition dialog for a decision node. You can add, delete, insert or rename decision alternatives. By default, DPL has created two decision alternatives and named them "Yes" and "No". These defaults can be changed in the Tools | Options dialog on the General tab (Tools | Options | General). You will use the defaults for this decision node.
Select the Data tab of the Node Definition dialog.

Type "1" into the data edit box for the Yes alternative as shown in Figure 4-44.
Figure 4-44. Node Definition Data Tab for Pursue Consulting Decision

- Arrow down to select the No branch in the data input tree.
- Type "2" in the edit box for the No branch.
- Arrow up. Your data input tree should now look like Figure 4-45.
Select the Links tab as shown in Figure 4-46.

Note: the decision node that you created is not currently linked; it is local. As it is, DPL will not send the data (if it is an export node) or receive data back (if it is an import node) for this node. You will now link this node to the Cash Flow with Decision spreadsheet.
Select Microsoft Excel in the Calculation links section as shown in Figure 4-47.

Note that the Workbook and Sheet/Cell edit boxes as well as the Browse..., Cell Names..., and Paste Link button are all enabled. Also, DPL fills in the name and path of the spreadsheet to which the other nodes in the model are linked. Although it is possible to have nodes linked to more than one spreadsheet, it is typically not necessary to do so.
Click the Cell Names... button. The Cell Names dialog appears as shown in Figure 4-48.

When you click the Cell Names... button on the Node Links tab, the Cell Names dialog by default only displays named cells in the spreadsheet that are not already linked, since you typically would not link two nodes to the same cell. If the node you are editing contains data (and hence is an export node), the Cell Names dialog by default will not display named cells with formulas in them since you typically do not link an export node to a cell with a formula. You can check either Show cells already linked or Show cells with formulas to see either of these types of cells. If you were editing a linked node that did not contain data (and hence was an import node), the Cell Names dialog would appear with the Show cells with formulas checkbox already checked and it would display cells with formulas by default. There is only one new named cell that is not already linked and
that does not contain a formula in the spreadsheet: "Pursue_Consulting". DPL selects this cell for you.

![Cell Names Dialog](image)

**Figure 4-48. Cell Names Dialog**

⇒ Click Select.

The Cell Names dialog closes and the link to Pursue_Consulting is put in the Sheet/Cell edit box on the Node Definition dialog Links tab. See Figure 4-49.
Click OK to close the Node Definition dialog.

Note that DPL has updated the Default Tree in the Decision Tree Pane by adding Pursue Consulting to the head of it. By default DPL assumes the decision occurs before any of the chance nodes. You can use timing influence arcs to alter where DPL places the decision. See Section 3.3. In this instance, you want to leave the decision at the head of the tree. DPL has also created a get/pay expression for Pursue Consulting, by default, but you will change this in a moment.
You will now make further edits to the DPL model to incorporate fully the Pursue Consulting decision node into the model. Specifically, you will tell DPL to send different values for the value nodes Wages phase 1 and Wages phase 2 depending on which alternative of Pursue Consulting is being evaluated. You will do this by conditioning these two value nodes on Pursue Consulting.

Double-click Wages phase 1 in the influence diagram to edit its definition. The Node Definition dialog appears with the data tab selected as shown in Figure 4-50.

![Figure 4-50. Node Definition Data Tab for Wages phase 1](image)

Click the Conditioning button.
In the Conditioning dialog, check the checkbox next to Pursue Consulting as shown in Figure 4-51.

Figure 4-51. Conditioning Dialog with Pursue Consulting Checked

Click OK.

The data input tree for Wages phase 1 has been updated to provide entry slots for both the Yes and No alternative of Pursue Consulting. The value previously specified for Wages phase 1 has been copied to both alternatives.

Arrow down to select the input for the No alternative.
Type "22000" in the data edit box. Figure 4-52.
Figure 4-52. Data Input Tree for Wages phase 1 after Conditioning

⇒ Click OK.

Your model should now look like Figure 4-53. Note that an influence arc has been added from Pursue Consulting to Wages phase 1, and the default get/pay expression for Pursue Consulting has been removed. The color of the arc arrowhead is blue which indicates that Pursue Consulting conditions the values of Wages phase 1. For more information on the color of arc arrowheads, see Section 7.2.
You will repeat this procedure for Wages phase 2.

⇒ Double-click Wages phase 2 in the influence diagram to edit its definition.

⇒ Click the Conditioning button.

⇒ In the Conditioning dialog, check the checkbox next to Pursue Consulting.

⇒ Click OK.

⇒ Arrow down to select the input for the No alternative.

⇒ Type "30000" in the data edit box.

⇒ Arrow up. Your data input tree should look like Figure 4-54.
Chapter 4: Building Models from Spreadsheets

Figure 4-54. Data Input Tree for Wages phase 2 after Editing

⇒ Click OK.

Your model should now look like Figure 4-55.
In the above example, you added a single node to the DPL model after linking the DPL to a different Excel spreadsheet. If there were several changes made to the Excel model and wished to add a number of nodes to the DPL model at once, you would use Node | Create Linked Values | From Excel. See Appendix A for more information on spreadsheet linking. Also see the last section of this chapter for an example of initialization links.

Before continuing, you will neaten up your model a little by bending the influence arc from Pursue Consulting to Wages phase 1.

- Select the influence arc with the left mouse button and without releasing the mouse button begin to drag the arc. The mouse cursor will change to the arc bend cursor (\(\Rightarrow\)).
- Continue dragging until the arc is bent how you would like. See Figure 4-56.
Release the mouse button.

Repeat the procedure for the influence arc from Pursue Consulting to Wages phase 2.

Click an empty space in the Influence Diagram Pane or press ESC to deselect the influence arc. Your model should now look something like Figure 4-57.

**Figure 4-56. Bending an Influence Arc**
Figure 4-57. Cash Flow Model with Bent Arcs

Finally, make sure you have all the influence arcs you need in order to run the model.

⇒ Select Influence | Construct from Formulas as shown in Figure 4-58.
DPL adds an influence arc from Pursue Consulting to NPV, because NPV (the import node) depends upon all the export nodes in the model. Your completed model should look similar to Figure 4-59.
4.6 Running the Model with Decision Node Added

You are nearly ready to run the modified model (cash flow – decision). First you must tell DPL it is the Main Model.

Select Model | Main (or right mouse click the item for the model in the Workspace Manager and select Make Main from the context menu).

Select Run | Decision Analysis or press F10. The Decision Analysis Options dialog appears as shown in Figure 4-60.

Note that the number of levels that can be saved has increased to eight. This reflects the fact that the decision node was added to the head of the tree.
Make sure the following are checked: Risk Profile and Policy Tree™.

Make sure the following are not checked: Policy Summary™ and Expected Value of Perfect Information / Control.

Leave Number of levels at 8 (all).

Click OK.

The DPL Analysis dialog appears. When the run is complete, DPL produces the requested outputs and displays the Policy Tree™ output as shown Figure 4-61.
The Policy Tree™ for the model including the decision on whether or not to pursue consulting indicates that the software company should not pursue consulting. This is displayed in the Policy Tree™ by the branch for the No alternative of the Pursue Consulting decision being drawn with a thick line. You can also see that No is the optimal alternative because the rolled-back expected value at the Pursue Consulting node ([12350.862]) is equal to the rolled-back expected value at the Initial license node at the end of the No branch. When rolling back the tree to calculate the expected value of the objective function, at a decision node DPL chooses the alternative that maximizes the objective function.

Note that the expected value at the Initial license node at the end of the Yes branch is 5892.567. This is the same as the expected value that you obtained when you ran the model before adding the decision. This makes sense because the Excel spreadsheet was initially set up assuming that the company would pursue consulting.

Figure 4-61. Policy Tree™ for Cash Flow Model with Decision
The difference in expected value of the objective function (i.e., the difference in expected NPV) between if the company pursues consulting (and presumably hires consultants to do so) and if it doesn't is approximately 6458 (12350.862 – 5892.567). This implies that pursuing consulting would be value-destroying.

For a further discussion of the information found in a Policy Tree™ see Table 3-3.

You will now compare the Risk Profile you just created to the one you created when you ran the model before adding the decision.

- Double-click on the item for Risk Profile chart called Expected Value1 (\(\mathcal{E}\)) in the Workspace Manager to activate the window. You may also select it and press Enter. The Expected Value1 Risk Profile chart becomes active.

- Select Format | Series. The Format Diagram dialog appears with the Series tab selected as shown in Figure 4-62.
Un-check "Display risk profile data from this model only." You want to compare risk profiles from two different models.

Select With Consulting from the Series 2 dropdown box as shown in Figure 4-63.
Select the Legend tab.

Click the From Series button on the Legend tab. DPL inserts the names of the series into the legend edit boxes for Series 1 and Series 2 as shown in Figure 4-64.
Select the Display tab.

Check Expected Values / Certain Equivalent lines.

Click OK.

DPL updates the Risk Profile chart to display both Risk Profile datasets and to display a legend for each series as shown in Figure 4-65. The Expected Value1 series (which comes from the model with the decision) represents the distribution of outcomes for the No alternative, which is the optimal alternative as indicated by the Policy Tree™ in Figure 4-61. The With Consulting series represents the distribution of outcomes of the Yes alternative. This is because the Excel model was initially set up such that the revenues and costs associated with consulting were included in the calculations of NPV. Therefore the distribution of outcomes from the DPL model without the decision is the same as the distribution of outcomes for the Yes alternative in the model with the decision.
Figure 4-65. Risk Profile Chart Displaying Two Series

The distribution for the No alternative lies below and to the right of the distribution for the Yes alternative. The vertical line representing the expected value of the distribution of the No alternative is to the right of the expected value line for Yes alternative. These two facts indicate that the No alternative probabilistically dominates the Yes alternative. The No alternative results in a higher expected value, and for any value on the x-axis there is a lower probability than the Yes alternative that the objective function under the No alternative is less than the value on the x-axis (or equivalently there is a higher probability than the Yes alternative that the objective function under the No alternative exceeds the x-axis value). Of course, there may be some combinations of uncertain outcomes for which the Yes alternative has a higher value.

Note that the Risk Profile chart in Figure 4-65 still displays the Risk Profile dataset called Expected Value1, which gets replaced each time you run a model. If you want to ensure that you save the Risk Profile chart as it is, you should rename Expected Value1 (to say, Without Consulting) and then select it on the Series tab of the Format Diagram dialog. You could also rename the Risk Profile chart to say, Comparison. Even if you do not
rename the Risk Profile chart, DPL will not replace it the next time you run; instead, it will create a Risk Profile chart called Expected Value2 since a Risk Profile chart called Expected Value1 already exists and is displaying something other than the expected value dataset from the model.

If you make changes to the formatting of a Risk Profile chart but do not change the series it is displaying from the default expected value series that gets created when you run a model, DPL will re-use the chart and preserve the formatting of the chart. If you turn on expected value / certain equivalent lines or add titles, these will appear on the chart with the new Risk Profile dataset when DPL re-uses it.

The technique of comparing Risk Profile datasets described above is useful for comparing datasets from different models. This can be helpful when you want to compare the risk and reward for projects that might be competing for the same funds.

As mentioned previously in the example you have just seen, the cash flow – prob model is the same as the Yes alternative of the cash flow – decision model. In essence when you compared the datasets from the two different models, you were comparing two datasets from different alternatives of the decision in the cash flow – decision model. There is a much quicker way of comparing the Risk Profile datasets from different alternatives of an initial decision (an initial decision is a decision that appears before any chance nodes in the decision tree). When you run a Decision Analysis, in addition to checking Risk Profile, depress the Initial decision alternatives button in the Distributions section of the Decision Analysis Options dialog.

⇒ Try this now with the current model.

You will see that DPL creates a Risk Profile chart called Initial Decision Alternatives and Risk Profile datasets called Yes and No (DPL names the datasets after the initial decision alternatives). The Initial Decision Alternatives Risk Profile chart and corresponding datasets behave the same way the Expected Value chart and dataset do. That is, the chart will be re-used the next time you run unless you change the datasets it displays and the datasets will be deleted the next time you run unless you rename them.
Finally, you may also wish to run an Initial Decision Alternatives Tornado diagram on this model. Initial Decision Alternatives tornadoes are also discussed in Section 2.8. See also Section 2.7, Base Case Tornado Diagram.

Select Run | Tornado Diagram or press F8. The Select Tornado Type dialog appears as shown in Figure 4-66.

![Select Tornado Type Dialog](image)

**Figure 4-66. Select Tornado Type Dialog**

Select Initial Decision Alternatives.

Click OK. The Initial Decision Alternatives Tornado Setup table appears as shown in Figure 4-67.
Figure 4-67. Initial Decision Alternatives Tornado Setup

- Leave the settings as they are.
- Click OK. An Initial Decision Alternatives tornado appears as shown in Figure 4-68.
Figure 4-68. Initial Decision Alternatives Tornado Diagram

The Initial Decision Alternatives Tornado is essentially two Base Case tornado diagrams shown on one chart. See Sections 2.7 and 2.8. Initial Decision Alternatives tornadoes are helpful for comparing the impact of each chance event on the objective function across the possible states of the initial decision in the model.

To create an Initial Decision Alternatives tornado, DPL sets the initial decision (Pursue Consulting) to each of its possible alternatives, and runs a Base Case tornado for each alternative. The resulting Base Case tornadoes are then shown on one diagram. A Base Case Tornado Diagram sets all discrete chance nodes to a state that you define to be Nominal for each node, to calculate a Base Case objective function value. It then varies each discrete chance node individually to a state you specify to be Low and to a state you specify to be High, while keeping all other discrete chance nodes at their Nominal states.
Figure 4-68 shows that the chance events in this model have similar impacts on the objective function, regardless of which initial decision is pursued. The widths of the two bars for each chance event are about equal. The bars for the Pursue Consulting: No alternative are consistently shifted to the right, compared with the bars for the Pursue Consulting: Yes alternative, because the No alternative is optimal (higher in value). You can conclude that none of the chance events has a dramatically different impact on the objective function when comparing the two decision alternatives.

You have now built a DPL model from Excel, added nodes to it and examined the Policy Tree™ and Risk Profile outputs from DPL. You also created an Initial Decision Alternatives tornado diagram to see how the various uncertainties you built into the model affect the uncertainty in the objective function for each decision alternative. For a further discussion of DPL outputs, see Chapter 3.

The model you have created in this chapter has several nodes that are linked to Excel. All of the links thus far have been calculation links. As you have seen, the linked chance nodes are used to take assumptions (values) from DPL and export them to Excel for calculation. The linked value node (NPV) is used to import the calculated NPV values back to DPL. Any time you create a DPL model that is linked to Excel, you will typically have at least two calculation links: at least one for an export node and at least one for an import node. However, as you may have noticed in the Node Definition | Links dialog, there is also another type of DPL-Excel link, called initialization links.

The final section of this chapter demonstrates how to use initialization links so that you can initialize quantities used in your DPL model (values and/or probabilities) in the linked Excel spreadsheet instead of in DPL. Using initialization links is optional, but you will probably find them useful as you become more proficient with building DPL models and linking them to Excel.
4.7 Adding Initialization Links to the Model

In this section you will modify the model of the previous section so that two of the chance nodes, Marketing phase 1 and Marketing phase 2, are "initialized" (obtain their data) from the Excel spreadsheet that is already linked to your model.

Like calculation links, initialization links require that you have named the range in Excel before linking it to DPL. The linked spreadsheet, Cash Flow with Decision, already has these ranges set up and named for you.

Switch to Excel and click on the Initialization sheet. See Figure 4-69.

![Figure 4-69. Initialization Sheet in Excel](image)
There are four named ranges in this sheet. You can see in the spreadsheet and in Figure 4-69 that there is a range named Mkt_ph1_probs, containing the probability data for the Marketing phase 1 chance node. Similarly, there are also three other named ranges: Mkt_ph1_values, Mkt_ph2_probs, and Mkt_ph2_values, corresponding to the rest of the probability and value data for the Marketing phase 1 and Marketing phase 2 chance nodes. The data contained in these ranges is currently identical to the assumptions you have seen in the DPL model.

⇒ Switch back to DPL.
⇒ Right-click on the cash flow - decision model and duplicate it.
⇒ Rename the copy of the model to cash flow - init links.
⇒ In the newly renamed model, open the Marketing phase 1 chance node and click on the Links tab.
⇒ In the Initialization links box, click the Microsoft Excel radio button. The "Same as calc links workbook" box should already be checked; if not, check it. The dialog should look like Figure 4-70.
Figure 4-70. Enabling Initialization Links in Node Definition

Note: you can specify initialization links to a spreadsheet other than the calculation workbook. If you uncheck Same as calc links workbook, the Initialization Links Workbook edit box is enabled and you can use the Browse button in the Initialization Links section to specify another spreadsheet.

⇒ Click on the Data tab.
⇒ Click the Links button ( ) to the right of the Probability input cell. You will see the Range Names dialog as in Figure 4-71.
Figure 4-71. Range Names Dialog for Initialization Links

⇒ Select Mkt_ph1_probs from the Range Names list.
⇒ Click Select.

The Node Definition | Data dialog will look like Figure 4-72.
The chance node now has an initialization link to the probabilities specified in the Excel range Mkt_ph1_probs. This range contains all three of the probabilities that you need for the node definition. You will delete the ".4" and ".3" from the other two branches of the node definition, because they are no longer needed.

⇒ Arrow down twice to edit the probability of the Nominal branch.
⇒ Delete it.
⇒ Arrow down twice again to delete the probability of the High branch.
Note that when defining initialization links in DPL, the initialization link information is always specified in the first (top) branch of the node. The data for the remaining branches must be left blank. You may have noticed that when a branch other than the first branch is selected for editing on the Data tab, the Links button is disabled.

Next you will follow similar steps to define the initialization link for the values for this chance node.

⇒ Click on the value 5000 for the Low branch of the node.
⇒ Click on the Links button (l) to the right of the Value input cell. You will again see the Range Names dialog.
⇒ Select Mkt_ph1_values from the Range Names list, as shown in Figure 4-73.
Click Select.
Click on the value 8000 for the Nominal branch of the chance node.
Delete it.
Click on the value 15000 for the Nominal branch of the chance node.
Delete it.

With initialization links and other lengthy node data (such as when you enter formulas), you may need more room on the data input tree branches to see the node data. You can do this via the Node Data context menu.

Right-click in the data input tree window. The Node Data context menu appears.
Select Lengthen Branch. See Figure 4-74.
Zoom Full the data input tree window (either by right mouse clicking again and using the context menu or clicking the Zoom Full button on the Data tab). Your data input tree should now look like Figure 4-75.

Click OK.

In the Workspace manager, right-click on cash flow - init links and make it Main.

Select Run | Decision Analysis or press F10 to run the model.
The model results should be identical to the results in the previous section, since the probabilities and values being used for initialization are identical to the previous. However, now if you wished to change these assumptions for the Marketing phase 1 chance node, you would make the changes in the Initialization sheet of the Cash Flow with Decision spreadsheet. DPL would then use the revised assumptions to initialize the node.

⇒ Repeat the steps above to initialize the Marketing phase 2 node with the ranges Mkt_ph2_probs and Mkt_ph2_values; run the model and verify that the results are still the same.

⇒ Optional: If you like, change any of the values or probabilities in Excel for one of these nodes, and verify that the results are no longer the same as before. Note: If you change the probabilities, make sure that the new probabilities sum to 1.0.

For additional information about initialization links and spreadsheet linking in general, please consult Appendix A of this manual.
This tutorial focuses on building an Excel-linked DPL model for a financial risk analysis application. It assumes familiarity with cash flow spreadsheets and with the analysis of uncertainty by Monte Carlo simulation. This chapter discusses how to do Monte Carlo simulation in DPL.

To begin, load DPL by double-clicking the icon on your desktop, double-clicking the icon in Windows Explorer or launching it from the Start Menu.

DPL will load in a maximized state, and will create a blank Workspace. See Figure 5-1.
The window on the right-hand side of the screen is the Model window. The left-hand pane is the Workspace Window. For more information about the DPL Workspace Window, see Chapter 1. At the moment, Model1 is the only document in your Workspace.

The risk analysis model you will build will consist of a DPL Model used to characterize uncertainties, and an Excel model used to calculate cash flows.

5.1 The Excel Cash Flow Model

Before creating the DPL model, take a brief tour of the Excel model provided for this tutorial.

→ Load Excel as you normally do.
→ Open the file "Enlightify1.xls". This file will normally be found in the "Examples" folder where DPL was installed (C:\Program Files\Syncopation\DPL7, if the default location was used during installation).

![Figure 5-2. Excel Cash Flow Model for Enlightify: Assumptions Sheet](image-url)
This simple cash flow model calculates the value of Enlightify Consulting LLC, a troubled business unit whose financial performance is of concern. The Excel model is built on two sheets, one for key assumptions and value drivers, and another for the actual calculations.

In Figure 5-2, you can see that eight of the value drivers have already been identified as sources of uncertainty; the cells are shaded in light green. Each of these cells has been assigned a range name. When using an Excel model with DPL, you should make sure to name the cells you intend to link to DPL. If you select a named cell in Excel, the name will appear in the drop-down list to the left of the formula bar. In Figure 5-3 you can see that cell C17 has a current value of $895, and has been given the name "Total_Value". Please consult your Excel documentation if you are not familiar with named ranges, as they are essential for using DPL with Excel.
Chapter 5: Building and Analyzing Monte Carlo Models

Syncopation Software

The calculations sheet (DCF) is shown in Figure 5-4. In this sheet, the model calculates the total value of the Enlightify Consulting business unit by the discounted cash flow method. These calculations are connected to the input cells on the Assumptions sheet. For example, if the Trendline Revenue Growth Rate (cell C22) is changed from 8% to 5%, the total value of Enlightify falls from $895 million to $690 million. You may want to spend a few minutes getting familiar with the spreadsheet.

![Microsoft Excel - Enlightify.xls](image)

Figure 5-4. Cash Flow Model: DCF Calculations

5.2 Creating Linked Values

⇒ Switch back to DPL.

To begin building a DPL model linked to the Enlightify spreadsheet, you’ll first need to create some linked values.

⇒ Choose Node | Create Linked Values | From Excel.

⇒ In the Create Values from Excel dialog, click the Browse... button and find "Enlightify1.xls". See Figure 5-5.

![Spreadsheet snapshot](image)
Click OK to continue.

Figure 5-5. Create Values from Excel Spreadsheet Name dialog

DPL will display a second dialog box listing all the named cells in Enlightify1.xls. You want to create value nodes for all of these cells except Discount_Rate, Interest_Rate_on_WC, NPV and Valuation_Date.

Select the cells as shown in Figure 5-6. To select or de-select cells in the list, you need to hold down the Ctrl key while clicking each one.

Figure 5-6. Named Cells in Enlightify1.xls
Click OK.

DPL will create a value node for each of the selected cells. A value node is a blue rounded rectangle representing a constant or calculated quantity. See Figure 5-7.

![Figure 5-7. Value Nodes Created from Enlightify1.xls Named Cells]

The top pane of the Model Window is called the Influence Diagram Pane. The Influence Diagram is where you define nodes and their relationships. The bottom pane of the Model window is the Decision Tree Pane, which is covered later in this chapter.

Next, you'll look at how DPL has established the links with Excel.

Double-click on Gross Margin.
In Figure 5-8, you can see that DPL has brought over the data (0.35 or 35%) from the Excel cell. Right now this may seem like a lot of space for one number, but you'll be using it as you start to incorporate uncertainty into the model.

Click on the Links tab.

In Figure 5-9, you can see that DPL has recorded the path, file name, sheet name and cell name for the Gross Margin node.

DPL also tells you that this is an "export" node. When spreadsheet inputs or drivers are linked to DPL nodes, they are always DPL export nodes, whereas spreadsheet outputs (e.g., NPV) are DPL import nodes. Export nodes are typically linked to cells containing data, whereas import nodes are typically linked to cells containing formulas. See Chapter 4.
If you are unsure whether a DPL node is linked to the correct cell, you can have DPL activate the cell in Excel.

Figure 5-9. Node Definition Links for Gross Margin

- Click the Go to Cell button. This takes you to Excel and selects the linked cell (Gross Margin in this case).
- Switch back to DPL.
- Click Cancel to close the dialog.
5.3 Arranging the Influence Diagram

Before you begin to analyze the model, take a moment to organize the Influence Diagram.

⇒ Double-click on the splitter bar between the two panes of the Model window. This maximizes the Influence Diagram Pane.

⇒ Select Model | Options. In the Influence Diagram grid section, check Snap to grid (Figure 5-10). This option centers nodes on the drawing grid squares when they are moved.

![Figure 5-10. Model Options Dialog]

⇒ Click OK.
Drag the Total Value node to the right.

Click in the Influence Diagram to un-select it.

While holding down the Ctrl key, click on the Share of Revenue at Risk value node and the Share of at Risk Revenue Lost node. Both nodes should now be magenta because they are selected.

Drag both nodes to the left.

Use this same technique, or just move nodes one at a time, so that the nodes in your diagram are arranged in a circle with Total Value on the right.

Arcs (arrows) in Influence Diagrams show relationships. In our model, Total Value depends on all the other value nodes. Adding an arc from each node to Total Value would be tedious, so you'll let DPL do the work.

Select Influence | Construct from Formulas. DPL draws arcs from each of the other eight value nodes to Total Value.

Your model should now look something like Figure 5-11.
At this point, you've put enough effort into building your DPL model that you should save it.

⇒ Select File | Save Workspace As and give your Workspace a name (such as Enlightify.da).

5.4 Running a Value Tornado Diagram

A Tornado Diagram is typically the first analysis done on a new model. At this point, your model is deterministic (consists only of value nodes), so the Value Tornado Diagram is the only tornado analysis available.

⇒ Select Run | Tornado Diagram.

DPL displays the Model Get/Pay dialog (Figure 5-12). This gives you an opportunity to tell DPL which value you would like to calculate. In your model, Total Value is the only non-constant value and hence the only reasonable choice.

![Figure 5-12. Model Get/Pay Dialog](image)

⇒ Click OK to accept the default (Total_Value). Next, DPL displays the Value Tornado setup dialog.
Chapter 5: Building and Analyzing Monte Carlo Models

Syncopation Software

Figure 5-13. Value Tornado Setup Dialog

The Value Tornado Setup dialog provides a table in which to enter the low and high settings (range) for each value node that is a constant in the current model. DPL has also filled in the Current setting for each variable in the table.

You will now enter the range for each of the value nodes shown in Figure 5-13.

- Click the blank cell in the Low column of the first value node, Bad Debt Allowance.
- Type 0.02 for the Low value of Bad Debt Allowance.
- Press Enter.
- Click the blank cell in the High column of Bad Debt Allowance.
- Type 0.04 for the High value.
- Press Enter.
Continue to fill in the Value Tornado Setup table with the rest of the High and Low values shown in Table 5-1. Note that you can use the arrow keys to move around the Value Tornado Setup table.

<table>
<thead>
<tr>
<th>Name</th>
<th>Low</th>
<th>High</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gross Margin</td>
<td>0.30</td>
<td>0.40</td>
</tr>
<tr>
<td>Other Cost Growth Rate</td>
<td>0.09</td>
<td>0.12</td>
</tr>
<tr>
<td>RMC_Lawsuit_Settlement</td>
<td>50</td>
<td>250</td>
</tr>
<tr>
<td>Share of Revenue at Risk</td>
<td>0.09</td>
<td>0.11</td>
</tr>
<tr>
<td>Share of at Risk Revenue Lost</td>
<td>0.50</td>
<td>0.95</td>
</tr>
<tr>
<td>Trendline Revenue Growth Rate</td>
<td>0.05</td>
<td>0.10</td>
</tr>
<tr>
<td>Working Capital</td>
<td>100</td>
<td>150</td>
</tr>
</tbody>
</table>

Table 5-1. Data for Value Tornado Diagram

Your completed Value Tornado Setup dialog should look like Figure 5-14.
Click OK.

DPL displays a Value Tornado diagram (Figure 5-15) for the eight value nodes tested. The bars are sorted so the widest one (corresponding to the highest impact value) is at the top. This diagram will help decide which value drivers need to be modeled probabilistically (as chance events). See Section 2.5 for more information on Value Tornadoes.
5.5 Using the Workspace Manager

DPL allows you to store any number of Models in a Workspace. Before continuing, you'll make a copy of your model as it now stands, so that you'll have it if you need to update the tornado diagram later. Most actions in the Workspace Manager window are accomplished by right-clicking an item and choosing a command from the context menu. First, you will make a copy of the current model.

In the Workspace Manager window, right-click on "Main: Model1" and select Duplicate (Figure 5-16).
Chapter 5: Building and Analyzing Monte Carlo Models  
Syncopation Software

Figure 5-16. Using the Workspace Manager to Duplicate a Model

DPL makes an identical copy of Model1.

 dez Rename the first model "Deterministic" by right-clicking on it and selecting Rename.
 dez Rename the second model "Risk Analysis" in the same way.

When a Workspace file contains more than one model, DPL needs to know which one to run when you ask for a run. The model that will be used for runs is called the Main Model. You want to make the new model Main.

 dez Right-click on Risk Analysis and choose Make Main.
 dez Double-click on the splitter bar to maximize the Influence Diagram pane.
 dez Click Zoom Full (see Table 1-2) on the toolbar or press Ctrl+L. Your Workspace should look like Figure 5-17.
You may notice that the tornado diagram is under Deterministic in the hierarchy -- DPL keeps track of which model was used to create each output window. It’s good practice to save your Workspace from time to time.

⇒ Select File | Save Workspace.

5.6 Running a Monte Carlo Simulation

The tornado diagram indicates which values have the highest impact on Total Value. The next step in our risk analysis is to model the uncertainty in those factors. You’ll start with Gross Margin, since it’s at the top of the tornado.

⇒ Right-click on Gross Margin and select Change Node Type from the context menu. DPL will bring up the Node Type dialog.

⇒ Click on the Continuous Chance button and click OK. The Node Definition dialog appears as shown in Figure 5-18.
Gross Margin is now a chance node, meaning that it is uncertain. DPL has two types of chance nodes, discrete and continuous. Discrete nodes are used for uncertainties which have a finite number of outcomes, such as single events (e.g., regulatory approval) or fixed scenarios (Low, Base Case, High). Continuous nodes can have infinitely many outcomes sampled from named probability distributions (normal, triangular, poisson, etc.) In this chapter, you'll be using continuous chance nodes. DPL draws discrete chance nodes in bright green and continuous chance nodes in dark green.

Next, you'll need to edit the data for Gross Margin.

⇒ Click on the Data tab of the Node Definition Dialog.

By default, DPL initializes the node as a normal distribution with the original value (0.35) as the mean. You need to supply the standard deviation.
Click the edit box next to stddev.
Delete "1".
Type "0.04". The node definition dialog should look like Figure 5-19.
Click OK.

Figure 5-19. Node Definition Data for Gross Margin

Now that your model has uncertainty, you can run a Monte Carlo simulation.

Select Run | Monte Carlo Simulation, or press F11.
DPL checks your model for completeness whenever you run any kind of analysis. DPL will give you an error message if you’ve mistyped a formula or forgotten a value.
In the Monte Carlo Simulation Options dialog (Figure 5-20), change the initial number of samples to 100.

Make sure Risk Profile is checked.

Click OK.

DPL runs the Monte Carlo simulation with 100 samples, which is a very small number, but useful for illustration. When the simulation run is complete, DPL displays a Risk Profile Chart (Figure 5-21). The sample is random, so your results will be slightly different, but the general shape will be similar. In this simulation, each sample has a weight (probability) of 1/100 or 1%. In the graph, you can see how the histogram bars represent single samples (probability 1%) at the high and low extremes.
To continue the risk analysis, you need to make the other key value drivers uncertain.

⇒ Switch back to the main Model Window by pressing Ctrl+F12 or double-clicking its item in the Workspace Manager.

⇒ Change Trendline Revenue Growth Rate, Share of at Risk Revenue Lost and RMC Lawsuit Settlement to continuous chance nodes.

⇒ Enter their probability distributions and parameters as given in Table 5-2.
Table 5-2. Probability Distribution Parameters for Continuous Chance Nodes

- Run a Monte Carlo Simulation with the same settings as Figure 5-20. Note: DPL will issue a warning about deleting unsaved output results.
- Click OK to the warning.
- Click OK in the Monte Carlo Simulation options dialog. DPL brings up a new Risk Profile Histogram.

Finally, you will examine the statistics available for the Risk Profile.

- Select View | Statistics. The Statistics dialog appears as shown in Figure 5-22.

The Statistics dialog gives you a standard statistical description of the results of your Monte Carlo simulation, including the minimum and maximum values, the variance and standard deviation, the higher moments (skewness and kurtosis), and selected percentiles of the distribution. You may enter other percentiles into the Percentile list box and then click Update Percentile Values.
Click Close to close the Statistics dialog.

Note that because each simulation run will produce somewhat different results and you have run only 100 samples, your results will not match Figure 5-22 exactly, but they should be similar. The Risk Profile statistics are also written to the Log. To see this, click the Log tab in the Workspace Window. Click the Manager tab to go back to the Workspace Manager.

5.7 Comparing Risk Profiles

DPL allows you to show up to eight risk profiles in a single chart window. You'll use this capability to show how increasing the number of samples increases the accuracy of the results.

In the Workspace Manager, right-click on the Risk Profile Dataset item called "Expected Value" (Expected Value) in curly braces.

Choose Rename.
Call this Risk Profile Dataset "100 Samples".

DPL reuses the "Expected Value" dataset each time an analysis is run. If you want to save a distribution, you need to rename it. You can see that rather than renaming Expected Value, DPL made a copy of it. For more information on saving Risk Profile Datasets, see the end of Section 4.6.

The second item called "Expected Value" is the Risk Profile Chart. Risk Profile Charts and Risk Profile Datasets are separate items in the Workspace Manager because one chart can display several datasets.

Next, you'll run simulations with larger numbers of samples.

Run a Monte Carlo Simulation with 1000 initial samples.

Rename the "Expected Value" Risk Profile Dataset (✓) "1000 Samples".

Repeat the process specifying 10000 samples in the Monte Carlo Simulation Options dialog and renaming the Risk Profile Dataset "10000 samples."

The run with 10000 samples may take a minute or two. You can take the opportunity to switch over to Excel and watch the numbers change. Excel needs to recalculate Total Value 10000 times.

Now you have three Risk Profile Datasets, which you can display in a single Risk Profile Chart.

In the Workspace Manager, rename the "Expected Value" Risk Profile Chart to "Sample Size Comparison".

Double-click the Sample Size Comparison chart to make the window active.

Initially, the chart will display the Expected Value risk profile dataset from the last simulation run. You want it to display all three of the saved risk profiles.

Choose Format | Series from the menu. The Series tab of the Format Diagram dialog will be displayed.

In the dropdown list for Series 1, select 100 Samples.

Select 1000 Samples and 10000 Samples for Series 2 and Series 3, respectively.
Click OK. See Figure 5-23.

Figure 5-23. Format Diagram Dialog, Series tab

The chart window displays all three of the risk profiles in histogram form (Figure 5-24). When several risk profiles are displayed at once, it's usually easier to see the differences if they are in cumulative form.
Figure 5-24. Sample Size Comparison, Frequency Histogram

Choose Format | Display from the menu. See Figure 5-25.
Choose Cumulative for the Graph Type.

You will also add a legend to indicate which color goes with which graph.

Click the Legend tab.

Click the From Series button.

Click OK. DPL displays the three risk profiles in cumulative (CDF) form. See Figure 5-26.
Figure 5-26. Sample Size Comparison, Cumulative

It's clear that the three risk profiles are similar in a general sense, but that the 100 Samples curve deviates from the other two.

If you like, you can compare the statistics and percentiles of the risk profiles by selecting View | Statistics again. Use the drop-down box to select from the three distributions. You may enter other percentiles into the Percentile list box and then click Update Percentile Values.

5.8 Modeling an Up-Front Decision

Thus far, your analysis has focused on the risks to the business, without considering any decisions management might be able to make to mitigate those risks. Enlightify's parent organization has considered spinning off Enlightify. Doing so would alleviate regulatory pressure, but would probably reduce its rate of growth because cross-selling opportunities ("synergy") would be lost. Next, you'll add this decision to your model. Before making this change, you want to make a copy of the model as it is.
In the Workspace Manager window, right-click on "Main: risk analysis" and select Duplicate.

Rename the new model "Decision Analysis" by right-clicking on it and selecting Rename.

Right-click on the new model and choose Make Main. Your Workspace should look like Figure 5-27.

Assume you've prepared a spreadsheet which includes two new input drivers, one for the spinoff decision and one for its effect on the growth rate. You'll need to link the decision analysis model to the new spreadsheet.

Select Model | Links. The Model Links dialog is displayed (Figure 5-28).

Click the Browse button.

Select "Enlightify2.xls".

Click Open. The Model Links dialog will appear again.
If you can’t see the full path and name of the newly linked spreadsheet (Enlightify2), drag the Name column separator to the right. You should see that Enlightify2.xls is now linked to the model.

Click Close.

![Model Links Dialog](image1)

Figure 5-28. Model Links Dialog

Next, you’ll create two new DPL nodes for these new inputs in the spreadsheet.

Select Node | Create Linked Values | From Excel.

![Create Values from Excel dialog](image2)

Figure 5-29. Create Values from Excel dialog
In the Create Values from Excel dialog (Figure 5-29), click OK to confirm the location of the spreadsheet (Enlightify2.xls). The Cell Names dialog is displayed.

Select Spin_off and Loss_of_Synergy (hold down the Ctrl key while clicking the second item -- Figure 5-30).

Click OK.

DPL initially adds the new nodes to the right.

Move them so they are positioned as in Figure 5-31.
Figure 5-31. Influence Diagram with Spin off and Loss of Synergy added

Next, you need to change Spin off into a decision node.

⇒ Right click on Spin off.
⇒ Select Change Node Type.
⇒ Choose Decision.
⇒ Click OK.

DPL displays the Node Definition dialog. The default decision alternatives, Yes and No, are fine, but you need to edit the data. In the spreadsheet, a value of 0 for Spin off means that no action is taken, and a value of 1 means that Enlightify is sold.

⇒ Click on the Data tab in the dialog.
⇒ Press the down arrow to navigate to the No branch (Figure 5-32).
⇒ Type "0".
⇒ Click OK.
Select Influence | Construct from Formulas so that DPL will add arcs for the new nodes.

Your model should look like Figure 5-33.
Figure 5-33. Model with Spin off decision

Note: Loss of Synergy is simply a linked value node that is set to 0.06 for now. You are linking this value to the model because in the next section, you will see how to perform sensitivity analysis on the assumed value.

You are ready to run the decision analysis model. You may want to save your workspace at this point.

- Select Run | Monte Carlo Simulation (or press F11). The Monte Carlo Simulation Options dialog is displayed.
- Choose Cumulative for the Graph type.
- Change the initial number of samples to "1000".
- Make sure Risk Profile is checked.
- Click the Initial Decision Alternatives button.

The dialog should look like Figure 5-34.
Click OK.

The analysis will take a few seconds. Excel has to recalculate the spreadsheet 2000 times; 1000 for each decision alternative. When the run is finished, DPL will show you the outcome distributions for both alternatives.

Select Format | Display.

Check Expected Value | Certain Equivalent Lines.

Check EV / CE Values. A line is added to each risk profile to show the expected value (with its value beneath it) for each alternative. See Figure 5-35.
Figure 5-35. Risk Profile Chart Comparing Initial Decision Alternatives

From this Risk Profile Chart, you can see that the risk profile for the No alternative generally lies below and to the right of the risk profile for the Yes alternative. This means that for almost any outcome value on the x-axis, there is a lower probability of the No alternative outcome being less than the x-value than there is of the Yes alternative being less than the x-value. Also, the No alternative has a higher expected value than the Yes alternative.

For most decision makers, the No alternative would be preferable to the Yes alternative. It appears that the parent organization should not spin off Enlightify.

5.9 Performing a Sensitivity Analysis

In the previous section, you concluded that it was better not to spin off Enlightify. However, you didn't test the assumption about the loss of synergy that would result from a spin off.
DPL's Rainbow Diagram feature allows you to run a model for several settings of an input variable. Since you earlier linked the value Loss of Synergy to your model, you can use this feature now.

- Select Run | Rainbow Diagram. DPL displays the Run Rainbow Diagram dialog.
- Click Select. DPL displays the Select Value for Rainbow Diagram dialog (Figure 5-36).
- Choose Loss_of_Synergy from the Value for sensitivity drop list.
- Click OK.

You would like to know how low Loss of Synergy would have to be, in order for spinning off Enlightify to be the optimal alternative.

- Type "0.03" for From.
- Type "0.06" for To.
- Type "0.01" for the Step size.

While you could run the sensitivity analysis with 1000 samples, the randomness of the simulation "draw" might obscure the effect of changing the Loss of Synergy value. For better results, increase the sample size to 5000.

- Click Change. The Options Run dialog appears.
- Change the Initial number of samples to 5000.
- Click OK. The Run Rainbow Diagram dialog appears.
Click OK to run the Rainbow Diagram.

DPL will run a full simulation for each of the four steps (0.03, 0.04, 0.05, 0.06), a total of 40,000 recalculations of the spreadsheet. This may take a few minutes.

The Rainbow Diagram (Figure 5-38) shows the model's expected value for each of the steps. The color change between 0.04 and 0.05 indicates that the best (highest expected value) decision alternative changed between these two points. This tells you that if you knew Loss of Synergy would be only 4%, it would be better to spin off Enlightify. If you wanted to find the threshold more precisely, you could run another rainbow diagram with a range of 0.04 to 0.05 and a smaller step size.
This Rainbow Diagram only has two colors, and the model only has one decision with two alternatives, so it's not hard to figure out the alternative represented by each color. In a more complex diagram, you can use DPL's policy tip feature to see the optimal alternative for each step. If you hold the mouse cursor over the green circle for 0.04 (as has been done in Figure 5-38), DPL will tell you that Spin off is Yes in that step. For more information on reading policy tips, please see Section 3.6. Note: Show Tips in Tools | Options | General must be checked in order for policy tips to work.

5.10 Modeling a Downstream Decision

The decision analysis model used in the previous two sections assumes that the Spin off decision will be made at a time when the four uncertainties are not known. In Figure 5-33, the decision comes first in the decision tree sequence. You might ask how the results would differ if the decision could be made later, after the uncertainty Share of at Risk
Revenue Lost is resolved. To answer this question, you will change the sequence of the nodes so that the decision is preceded by this uncertainty. A decision that comes after one or more uncertainties is called a downstream decision or a real option.

In the Workspace Manager, right-click on "Main: decision analysis".

Select Duplicate.

Right-click on the new model.

Select Rename and call it "Real Option Analysis".

Right-click and select Make Main to make the new model the Main Model.

To make the Spin off decision a real option triggered by the Share of at Risk Revenue Lost uncertainty, you will need to tell DPL that the uncertainty comes first in the decision tree sequence. The easiest way to do this is by adding an arc.

Click the Create Influence arc icon. The cursor changes to the begin arc cursor ( ).

Click on Share of at Risk Revenue Lost. The cursor changes to the end arc cursor ( ).

Click on the Spin off decision. DPL reorders the Default Tree to reflect the new arc (Figure 5-39).
Figure 5-39. Reordered Decision Tree

⇒ Select Run | Monte Carlo Simulation (or press F11).
⇒ Type "500" for the Initial number of samples.
⇒ Type "100" for the Minimum at decisions.
⇒ Check the Policy Summary™ box (Figure 5-40).
⇒ Type "3" for Number of Levels.
Click OK.

The run may take several minutes. DPL must sample each alternative of the downstream decision 100 times, and the decision itself will be sampled 500 times, so the run will require 100,000 recalculations of the spreadsheet.

When the run completes, DPL displays the Policy Summary™.

The Policy Summary™ shows that the option to spin off the business is exercised in about 12% of the scenarios. For more information on Policy Summaries™, see Section 3.3.
Figure 5-41. Policy Summary™ for the Spin off option

For continuous chance nodes in the Policy Summary™, DPL creates two pseudo-states: s1 and (does not occur). The probabilities (or percentages) displayed on these two states indicate how often the chance node occurs in the optimal set of scenarios. In Figure 5-41, the percentage for s1 is 100%. This means that the chance node occurs in all optimal scenarios. This makes sense because the decision tree is symmetric (every node occurs on every path). In an asymmetric tree (see Chapter 7), a continuous chance node might not appear in all optimal scenarios.

If you'd like, you can compare this risk profile dataset, its expected value and other statistics with one from the model without the downstream decision, as described in Section 5.7.
www.syncopation.com
6 Asymmetric Trees

This chapter will walk you through the process of building an asymmetric decision tree. Asymmetric decision trees are important because many business decisions are asymmetric in nature: different strategic alternatives are often influenced by different sources of uncertainty. Modeling that asymmetry directly usually improves computational efficiency, and results in a model which reveals the structure of the problem and is useful for communication.

This chapter assumes you have already been through at least one of the earlier tutorials (Chapters 1 through 5) in this manual, or that you are already familiar with DPL. Therefore, basic procedures such as starting DPL and opening and saving workspaces will not be explained in detail here.

Note that in the tutorials in Chapters 1 through 5, you worked mainly in the Influence Diagram Pane of the Model Window. In this chapter, you will be working mainly in the Decision Tree Pane because asymmetries are modeled in the decision tree. Refer to Chapter 1 if you need a refresher on how to move around the Model Window.

6.1 Eliminating Redundant Paths

You will begin with a simple symmetric model for a pharmaceutical R&D project.

⇒ Start DPL.
⇒ Open the file AsymmetricTrees.da. If the default installation folder was used when installing DPL, then the file should be in the C:\Program Files\Syncopation\DPL7\Examples folder. See Figure 6-1.
Chapter 6: Asymmetric Trees

Syncopation Software

Figure 6-1. Simple Model with a Symmetric Tree

This DPL model and its associated spreadsheet (AsymmetricTrees.xls) are set up to calculate the value of a pharmaceutical R&D project. The project is in an early stage, so there is uncertainty about whether it will succeed and result in a drug with regulatory approval (FDA Approval). If it does succeed, its revenues will be influenced by three factors: Price, Market Share and Market Size. These three factors are all modeled as uncertainties (Price is assumed to be set by a regulatory process, so it is not under management’s control in this example). First, run the model and look at the results.

- Select Run | Decision Analysis (or press F10). DPL will launch Excel and open AsymmetricTrees.xls. If you did not install DPL in the default installation directory, you will be prompted to tell DPL where the spreadsheet is.
- Check Policy Tree™.
- Uncheck all the other results (Figure 6-2).
- Click OK.
From the Policy Tree™ (Figure 6-3), you can see that the optimal alternative is to continue to develop the drug. If you do so, the expected NPV is approximately $75 million, whereas if you abandon it, the value is zero.

Expand the Policy Tree™ by shift-double-clicking on both instances of the FDA Approval chance node.
If the decision is made to abandon the project, then FDA Approval does not matter -- the value is zero in either case. If you expand down further into the don't develop half of the tree, you'll see that all the values are zero.

This tree has 108 scenarios or paths (to calculate this multiply the number of branches of the nodes: $2^2 \times 3 \times 3 = 108$), but half of them have an objective function value of zero. These redundant paths increase runtime and make the tree harder to read.

- Right-click the Symmetric model in the Workspace Manager and choose Duplicate.
- Right-click the Symmetric – copy model you just created.
- Select Rename.
- Rename the new model "Asymmetric".
- Right-click the item for the new model.
- Select Make Main.
To eliminate the redundant paths under the No branch of "Develop?", you will make the decision node asymmetric in the tree.

⇒ Double-click on the Develop? node in the decision tree (not in the influence diagram) to open the Node Definition dialog.

⇒ Select Asymmetric for the Alternative Grouping (Figure 6-4).

![Node Definition dialog, Tree Instance tab](image)

Figure 6-4. Node Definition dialog, Tree Instance tab

⇒ Click OK.
Figure 6-5. Decision Tree with Asymmetric Decision

DPL detaches the node from the rest of the tree and changes the decision node instance so that each alternative branch of the decision can have a different subtree follow it. In Figure 6-5, the two blue triangles on the branches of the decision represent "attachment points" where other nodes can be connected. You want to attach the FDA Approval node to the Yes branch.

⇒ Select FDA Approval by clicking it with the mouse.
⇒ Without releasing the mouse button, drag the node until the crosshairs are over the blue triangle for the Yes alternative (Figure 6-6).
Figure 6-6. Moving the FDA Approval Node

Release the mouse button (Figure 6-7).
This model represents the same decision as the symmetric model, but it has only about half as many paths (55 rather than 108).

Run a decision analysis selecting only Policy Tree™.

The results, approximately $75 million for the Yes alternative and $0 for the No alternative, are the same. Note that DPL assumed a value of zero for the No alternative since no get/pay was specified on that branch.

Right-click on the FDA Approval node in the Policy Tree™.
Select Expand to Level.
In the Expand Policy Tree™ dialog, type "4" (Figure 6-8).
Click OK.
DPL expands the Policy Tree™ two more levels down -- enough to show you the expected values on the branches of Market Share (Figure 6-9).

When FDA Approval is No, all three values on the branches of Market Share are the same: -$174 million. This is the cost of developing the drug all the way to an FDA submission and being rejected. If the drug is not approved, Market Share, Market Size and Pricing are all irrelevant. The spreadsheet correctly handles this in calculating NPV in the disapproval scenarios. As with the Develop? decision, this is another situation where asymmetry can make the model more efficient and intuitive.
Return to the main model. You can double-click on its icon in the Workspace Manager window or press Ctrl+F12.

Double-click on FDA Approval in the decision tree.

Choose Asymmetric for the Outcome Grouping in the Node Definition dialog.

Click OK.

Drag the Market Share node and drop it on the Yes branch of FDA Approval. Your model should look like Figure 6-10.

![Figure 6-10. Decision Tree with FDA Approval Asymmetric](image)

Unlike the decision to halt development, an outcome of No for FDA Approval does not result in a value of zero. The correct value is -$174 million, the cost of R&D up to that point. To tell DPL to put a value on that branch you use a Get/Pay expression.

Double-click on the No branch of FDA Approval. The Branch Definition dialog appears.
Click the Select Variable button, (¶) in the lower right-hand corner.

Double-click NPV in the list in the Select Variable dialog (Figure 6-11). DPL inserts NPV into the Get or pay expression for this branch edit box (Figure 6-12) and highlights it in magenta.

Click OK.
Figure 6-12. Branch Definition Dialog with NPV Specified

The decision tree (Figure 6-13) now indicates that DPL should add the value of NPV to the objective function if FDA Approval is No. The tree has a Get/Pay expression equal to NPV on the branches of the Pricing node, so DPL was already adding NPV to the objective function in paths leading all the way through the tree.
There is another way to add the NPV to the Get/Pay expression on the branch. Instead of using the Branch Definition dialog, you could simply drag and drop the NPV value from the Influence Diagram onto the No branch of FDA Approval. You will use this method later in this chapter.

Now you will try to run the decision analysis.

- Select Run | Decision Analysis (or press F10). Click OK if you get a warning message.
- DPL will issue an error message as shown in Figure 6-14. (Do not be alarmed.)
Chapter 6: Asymmetric Trees

Syncopation Software

Figure 6-14. Influencing Event Error Message

DPL gives you the error message to tell you that not all of the dependencies shown in the Influence Diagram are satisfied for the Get/Pay expression you just added. Following the arcs in the Influence Diagram, one would expect NPV to depend on all four of the uncertainties, but three of them are not known when NPV is calculated on the branch where FDA Approval is No. The three omitted uncertainties all affect revenues, and the spreadsheet knows to turn off all revenues in the disapproval case, so there isn't really a problem. You just need to tell DPL that the tree is valid and that the dependencies in the Influence Diagram don't apply to every scenario.

⇒ Click OK.
⇒ Click Cancel when DPL displays the Branch definition dialog for FDA Approval. DPL is allowing you to fix the error by changing the branch definition, however, as discussed above you will correct the problem another way.
⇒ Select Model | Options.
⇒ Click the Spreadsheet tab.
⇒ Check Tree-based dependency checking (Figure 6-15).
Click OK.

Warning: To safely use this switch, you must make sure that the nodes that are skipped do not affect spreadsheet calculations in the scenarios where they are not known. In those scenarios, the values for the "default" state (decision alternative or chance outcome) will be sent to the spreadsheet. For example, when FDA Approval is No, DPL sends the default (in this case the middle or Nominal) values for Market Share, Market Size and Pricing to Excel before telling Excel to recalculate NPV. The Excel model must be coded to ignore these values when FDA Approval is No.

You will now look at how to set default states.

⇒ Open the Pricing chance node in the influence diagram
⇒ Click on the General tab. The Nominal outcome is designated as the default state for Pricing.
Select another state and press the Default button. The default changes.

Click Cancel to discard the change.

Each chance node and decision node should have one of its outcomes assigned as the default in the General tab of Node definition. In particular if you are building an asymmetric model such as the example used here, you should ensure that each node has a default state set.

You can now run an analysis.

Select Run | Decision Analysis (or press F10).

The results are the same as before, although the tree is now much smaller and the analysis runs more quickly. To see how many paths there are in the model, you can look in the session log.

In the Workspace Window, click the Log tab (or press Shift+F12).

Look for the "Number of paths" entry near the bottom. The end of the session log will look something like this:

11:00:00 Compiling: Asymmetric
Number of paths = 29
11:00:01 Complete
11:00:01 Analyzing ... Full tree enumeration
11:00:02 Complete

The tree now has only 29 paths, compared with 108 when you started. Since the tree is quite small either way, this may not seem to make much difference, but in much larger models, incorporating asymmetries in the tree will result in improved performance and clearer communication of the decision structure.
6.2 Using Multiple Get/Pay Expressions

Currently, the model only imports data from Excel via one cell: DCF!Total_NPV. This is the simplest way to set up a linked model, and for many situations it's the best way. However, it is also possible to import data from several places in the spreadsheet. Doing so may result in a model which is more flexible and efficient, and can also help communicate the model's logic. In this section, you'll construct a "Pay as You Go" (PAYG) model, where costs and revenues are placed in the tree to reflect when they occur. Instead of using one value, NPV, for all cash flows associated with the project, you'll separate cash flows into three components: development costs, launch costs and revenues/marketing costs once the product is on the market.

You will start by creating two new value nodes for development and launch costs.

⇒ Switch back to the Main Model (Ctrl + F12 or double-click on its item in the Workspace Manager.)

⇒ Click in the Influence Diagram pane.

⇒ Select Node | Create Linked Values | From Excel. The Create Values from Excel dialog appears.

⇒ In the Create Values from Excel dialog, click OK to confirm the location of the spreadsheet. The Cell Names dialog appears.

⇒ In the Cell Names dialog, select PV_Development and PV_Launch (hold the Ctrl key when clicking on the second value). See Figure 6-16.
Chapter 6: Asymmetric Trees

Click OK.

Initially, DPL will place the nodes to the right of NPV; you may have to scroll the Influence Diagram pane to the right to see them.

Move the nodes so that they are positioned as in Figure 6-17.

Add two new arcs as shown in Figure 6-17.
You also need to change the NPV node so it includes only revenues and costs associated with a product on the market.

⇒ Double-click on NPV in the Influence Diagram Pane. The Node Definition dialog appears.
⇒ Click on the General tab.
⇒ Change the node name to "PV Market".
⇒ Click on the Links tab.
⇒ Click the Cell Names button.
⇒ Select PV_post_launch from the list.
⇒ Click Select. The Node definition dialog is updated (Figure 6-18).
Figure 6-18. Node Definition dialog, Links Tab

⇒ Click OK.

Now you need to place the three import nodes in the appropriate decision tree paths as Get/Pay expressions. This time, you will use the drag-and-drop method.

⇒ Click OK again.

⇒ In the Decision Tree Pane, double-click on the branches of Pricing (where "NPV" appears).

⇒ In the Branch Definition dialog, click on NPV (highlighted in magenta) and delete it.

⇒ Click OK. The decision tree now has no Get/Pay expression for Pricing.

⇒ Select the PV Market value node in the Influence Diagram.
Drag it down to the Decision Tree pane. The cursor changes to the add get/pay cursor (\textsuperscript{\textregistered}).

Drop it on the branches of Pricing in the Decision Tree Pane.

DPL adds PV Market to the Get/Pay expression for Pricing, as shown in Figure 6-19.

Figure 6-19. Get/Pay Expression Revised by Drag/Drop Method

Development costs are only paid if the Develop? decision is Yes; launch costs are only paid if FDA Approval is Yes.

Again using the drag and drop method, drag the PV Development value node to the Yes branch of the Develop? Node in the decision tree and release the mouse button. DPL adds PV Development to the Get/Pay expression for this branch.

Repeat the drag/drop procedure to place PV_Launch on the Yes branch of FDA Approval.

Double-click on the No branch of FDA Approval and remove "NPV" from the Get/Pay expression.
Click OK.

Note: If you drag and drop a value from the Influence Diagram Pane to an existing Get/Pay expression on the branches of the decision tree, DPL will add that value to the existing Get/Pay expression; e.g., the Get/Pay expression Value1 will become Value1+Value2.

Your tree should now look like Figure 6-20 (you may need to Zoom Full to see the whole tree).

Select Run | Decision Analysis (or press F10).

The results, $75 million for Yes and zero for No, are as before.

Shift-double-click on the FDA Approval node in the Policy Tree™ to expand the tree. See Figure 6-21.

DPL displays the values for get/pay expressions below the node branch on which they occur in the Policy Tree™. In Figure 6-21, you can now see the values for development cost ($174 million -- below the Yes branch of...
Develop?) and launch costs ($123 million -- below the Yes branch of FDA Approval).

![Figure 6-21. Policy Tree™](image)

With NPV split into its components, you are adhering to all the arcs in the influence diagram. You no longer need to suppress DPL's influence checking.

- Select Model | Options.
- Select the Spreadsheet tab.
- Uncheck Tree-based dependency checking.

If you run the model again, you should see the same results but no warnings about influencing events.
6.3 Adding a Downstream Decision

Asymmetric trees often involve downstream decisions that represent risk mitigation options. In our model, the launch costs are significant ($123 million), and one might ask whether there are situations in which you suspect the product will perform poorly and you would like to know whether you are better off not launching it. In this section, you'll add a chance node and a decision node to model one such exit option.

⇒ As before, switch back to the Main Model and click in the Influence Diagram pane to activate it.
⇒ Select Node | Create Linked Values | From Excel. The Create Values from Excel dialog appears.
⇒ In the Create Values from Excel dialog, click OK to confirm the location of the spreadsheet. The Cell Names dialog appears.
⇒ Select Key_competitor_outcome.
⇒ Click OK. The new node is initially placed to the right.
⇒ Move the new node so that it is above FDA Approval.
⇒ Right click on Key competitor outcome.
⇒ Select Change Node Type.
⇒ In the Node Type dialog, select Discrete Chance.
⇒ Click OK. The Node Definition dialog appears with the General tab selected.
⇒ Change the outcomes to Failure, Disappointment and Breakthrough.
⇒ Click on the Data tab of the Node Definition dialog and enter values of 1, 2, 3 (Figure 6-22). Leave the default probabilities of .3, .4 and .3.
Click OK. Your model should look like Figure 6-23.
Chapter 6: Asymmetric Trees
Syncopation Software

The previous model assumed you would launch the product if you obtained FDA Approval. You'll now add an explicit launch decision.

⇒ Click Create Decision (see Table 1-2) in the toolbar. The mouse cursor changes to a crosshair.
⇒ Click in the Influence Diagram Pane. The Node Definition dialog appears.
⇒ Name the decision Launch. Leave the default alternatives, Yes and No, as is.
⇒ Click OK.
⇒ Rearrange the influence diagram so it looks like Figure 6-24. You'll need to remove and add several influence arcs.
In the spreadsheet, the Key competitor outcome influences the size of the market -- if the competitor has a breakthrough, the market for drugs like the one being considered for development will shrink. Next, you need to incorporate the new nodes in the decision tree.

- Right-click on Market Share in the Decision Tree Pane.
- Select Detach.
- Click on Market Share and drag it off to the right. See Figure 6-25.

The three chance nodes will move as a group. You now have room to add the new nodes.
Select Key competitor outcome in the Influence Diagram pane.

Drag it down to the Decision Tree pane. The mouse cursor changes to a crosshair.

Position the crosshairs over the blue triangle attached to the Yes branch of FDA Approval and release the mouse button.

Select Launch in the Influence Diagram Pane.

Drag it down and drop it on the blue triangle attached to the branches of Key competitor outcome.

Your decision tree should look like Figure 6-26.
Figure 6-26. Decision Tree with Launch Decision

Note you can also add decisions or chances to the Decision Tree by clicking the Add Decision/Chance to Tree icons in the toolbar (see Table 1-2). This brings up the Select Decision/Chance dialog and allows you to select what you would like to add to the Decision Tree.

You now need to make the launch decision asymmetric and put the tree back together.

⇒ Double-click on the Launch decision in the Decision Tree Pane. The Node Definition dialog appears.

⇒ Select Asymmetric for the Alternative Grouping.

⇒ Click OK.

⇒ Drag the Market Share node and attach it to the Yes branch of the Launch decision.

Your decision tree should look like Figure 6-27.
Finally, you need to make sure that the launch costs are only paid if you decide to launch (the whole point of the launch decision is to avoid those costs if the project looks unattractive).

- Double-click on the Yes branch of FDA Approval.
- Delete the Get/Pay expression (press the delete key).
- Click OK.
- Drag the PV_Launch value node to the Yes branch of Launch in the Decision Tree pane, and release the mouse button.
Your decision tree should now look like Figure 6-28. You are now ready to run an analysis.

- Select Run | Decision Analysis (or press F10).
- Click OK again.
Figure 6-29. Policy Tree™ with Launch decision

In the Policy Tree™ (Figure 6-29), the expected value has changed significantly. Previously, you were assuming a Key competitor outcome of Disappointment, but now the outcome can be either better or worse than that. The bad outcome, a competitor breakthrough, has more of an effect than the good outcome, competitor Failure.

You can also see that the optimal decision alternative for Launch is always Yes. Although a Key competitor outcome of Breakthrough gives you a negative expected value of -$104 million, this is still better than quitting and losing $174 million.

You will make one more change to the decision tree to make it even more asymmetric. Suppose that management wants to know the impact on the overall expected value of the Develop? decision, if they were to decide that they will not launch the product if the Key competitor outcome is Breakthrough. You can very easily answer this question using a simple modification to the decision tree.

⇒ Activate the current model again.
⇒ Click in the Decision Tree Pane.
⇒ Double-click on the Key competitor outcome node to open the Node Definition dialog. See Figure 6-30.

![Node Definition: Key competitor outcome dialog]

**Figure 6-30. Tree Instance Dialog, Mixed Outcome Grouping**

⇒ Click the Edit button. The Select Groups dialog appears.
⇒ Select both the Failure and Disappointment outcomes by using your mouse button and the Shift key. Click on Group. These two outcomes become the first outcome group.
⇒ Select the Breakthrough outcome and click on Group again. The dialog should look like Figure 6-31.
Figure 6-31. Mixed Outcome Group Definitions

- Click OK twice. DPL has detached the Launch decision from the Key competitor outcome node.
- Drag the Launch decision (and its subtree) to the blue endpoint for the Failure and Disappointment outcomes. Release the left mouse button to attach the subtree to these two outcomes.

The decision model should now look like Figure 6-32.
The tree structure now assumes that management will not launch the product if the key competitor has a breakthrough. You will run the decision analysis to see how much this assumption reduces the value of the Develop? decision.

⇒ Select Run | Decision Analysis (or press F10).
⇒ Click OK for the warning.
⇒ Click OK again.

The results should look like Figure 6-33. The value of the overall Develop? decision has dropped to about $11 million, a loss of $10 million. Note that because this tree is small, it should be easy to explain to management exactly why this is the case. There is a 15% chance of ending up in the situation in which the competitor has a Breakthrough, and if this happens, about $70 million is lost by not launching the product anyway. The overall loss in expected value is 15% x $70 million, or about $11 million.
Figure 6-33. Policy Tree™ for Revised Model
7 Conditioning and Learning in Decision Models

The main purpose of an Influence Diagram is to show the relationships among the different factors relevant to a decision. DPL's Influence Diagram modeling environment provides a rich set of features to give you flexibility in defining these relationships.

A Decision Tree provides an intuitive, map-like representation of the sequence (order) and structure of a decision problem. In DPL, Influence Diagrams and Decision Trees work together to provide a complete definition of the decision problem.

When a decision is preceded by a chance node that provides information, we say that the model contains learning. For example, before deciding whether to carry an umbrella, you may look out the window and see if there are clouds. Learning about the "clouds" uncertainty provides imperfect information about the main uncertainty: whether or not it will rain later that day.

Other typical examples of learning in decision models include medical tests, market research, and sampling of the physical environment. Test drilling for oil is a classic example of learning and is the basis for the tutorial in this chapter.

This chapter assumes you have already been through at least one of the earlier tutorials (Chapters 1 through 5) in this manual, or that you are already familiar with DPL. Therefore, basic procedures such as starting DPL and opening and saving workspaces will not be explained in detail here.

This chapter also assumes some familiarity with basic probability theory and Bayes' Rule. The example in this chapter demonstrates DPL's capability to perform Bayesian revision, which can be simply described as reversing the order of conditioning among chance nodes to take advantage of the data available. Please consult online Help and/or a probability theory or decision analysis textbook if you need further explanation of these topics.
7.1 Incorporating Imperfect Information in a Model

In this section, you will enhance a simple decision model by adding a node that represents imperfect information about an important value driver. You will see how the "learning" associated with such nodes can significantly change the measured value of an asset.

⇒ Start DPL.
⇒ Open the workspace Learning.da. It should be in the Examples folder underneath where DPL is installed (C:\Program Files\Syncopation\DPL7\Examples if the default installation location was used). See Figure 7-1.

![Figure 7-1. Simple Wildcat Decision Model](image-url)
This model represents the decision problem faced by a "Wildcatter" exploring for oil. In a given field, s/he must decide whether or not to drill. If oil is found, uncertain costs are incurred. If a "dry hole" is drilled, nothing is gained. If oil is struck, then an amount of revenue is gained which depends on the price of oil and the reserves found.

⇒ Select Run | Decision Analysis.
⇒ In the Decision Analysis Options dialog, check Risk Profile and Policy Tree™ (Figure 7-2).
⇒ Click OK.

![Decision Analysis Options - Wildcat simple](image)

Figure 7-2. Decision Analysis Options dialog

The Policy Tree™ tells you that you should drill, and that the expected value of this opportunity is $26.5 million (Figure 7-3).
Navigate to the Risk Profile Chart (double-click on the item for it in the Workspace Manager, press Ctrl+Tab, or select it from the Window menu).

Figure 7-3. Policy Tree™
While this opportunity has positive value, it is risky. There is a about a 51% chance of losing money (see Figure 7-4).

In reality, the wildcatter has more choices than just whether or not to drill. S/he can conduct one of several tests intended to tell him/r about the likelihood of finding oil and then decide whether or not to drill. You will add a decision and a learning uncertainty for one such test.

⇒ Add a decision node to the Influence Diagram.
⇒ Place it above the Drill decision.
⇒ Call the decision node "Test".
⇒ Name its alternatives "None" and "Core sample".
⇒ Add a value node called "Test Costs".
⇒ Place it above Revenues.
If you need more room in the window, click the Zoom Out button or drag the splitter bar between the Influence Diagram and the Decision Tree. Your diagram should look like Figure 7-5.

![Figure 7-5. Influence Diagram with Test decision](image)

Test Costs depend on whether the wildcatter decides to test.

- Double-click on the Test Costs node.
- In the Node Definition dialog, click the Conditioning button.
- Check the box next to Test (Figure 7-6).
Click OK.

DPL changes the data input tree to reflect the new conditioning. You can now enter two data expressions, one for each alternative of the Test decision (Figure 7-7).
Figure 7-7. Node Definition Data for Test Costs

- Type "0" for the None branch.
- Type "-6" for the Core sample branch.
- Click OK.

In this model, you'll use an additive convention, so all costs will be entered as negative numbers. In your Influence Diagram, DPL has drawn an arc (arrow) from Test to Test Costs to reflect the conditioning you specified in the Node Definition dialog. The arrowhead is blue, which means that the Test Costs have different value expressions for each state of the conditioning event Test. The color codes for arcs are summarized at the end of this chapter.

- Double click on the arrowhead. DPL displays the Value Influence Type dialog (Figure 7-8).
Unchecking the "Different values" box would negate the conditioning you just added. In DPL, you have the choice of specifying conditioning in the Node Definition dialog when you're entering data, or on the Influence Diagram itself by changing arc types. If you are developing a model in which you know that influence arcs into nodes will mainly be of one type, you can check the "Make this the default" check box. Future arcs will be of the same type. You may have a different default arc type for each node type in DPL (decision, chance, value and controlled).

⇒ Click Cancel to close the dialog without making changes.

You'll now add the learning node associated with the core sample test.

⇒ Add a new Discrete Chance Node to the Influence Diagram.
⇒ Place it below Amount of Oil.
⇒ Name the node "Seismic Structure".
⇒ Name its outcomes "None", "Open" and "Closed".
⇒ Click OK to close the Node Definition dialog.

Your model should look like Figure 7-9.
You know from geological data the relationship between Seismic Structure and Amount of Oil. You need to add an arc from Amount of Oil to Seismic Structure.

- Hold down shift and click on Amount of Oil. The cursor changes to the end arc cursor (\(\bigcirc\)).
- Click on Seismic Structure. The new arc will initially have a black arrowhead.

Note: you can also add influence arcs by clicking the Add Influence Arc button (see Table 1-2), clicking on the predecessor node and then clicking on the successor node.

- Double-click on the arrowhead to change the type of the arc. DPL displays the Chance Event Influence Type dialog (Figure 7-10).
- Check Different probabilities for each conditioning event state.
- Make sure Different values for each conditioning event state is not checked.
Figure 7-10. Chance Event Influence Type dialog

⇒ Click OK.

Now you are ready to enter data for Seismic Structure.

⇒ Double-click on Seismic Structure.

The Node Definition dialog now has separate tabs for Values and Probabilities. You don't need to enter values for this node.

⇒ Click the Probabilities tab. Enter the probabilities as shown in Table 7-1.

<table>
<thead>
<tr>
<th>Amount of Oil</th>
<th>Seismic Structure</th>
<th>Probability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry</td>
<td>None</td>
<td>0.6</td>
</tr>
<tr>
<td></td>
<td>Open</td>
<td>0.3</td>
</tr>
<tr>
<td></td>
<td>Closed</td>
<td>0.1</td>
</tr>
<tr>
<td>Wet</td>
<td>None</td>
<td>0.3</td>
</tr>
<tr>
<td></td>
<td>Open</td>
<td>0.4</td>
</tr>
<tr>
<td></td>
<td>Closed</td>
<td>0.3</td>
</tr>
<tr>
<td>Soaking</td>
<td>None</td>
<td>0.1</td>
</tr>
<tr>
<td></td>
<td>Open</td>
<td>0.4</td>
</tr>
<tr>
<td></td>
<td>Closed</td>
<td>0.5</td>
</tr>
</tbody>
</table>

Table 7-1. Probability Data for seismic structure.

Your probability input tree should look like Figure 7-11.
Figure 7-11. Node Definition dialog, Probabilities Tab for Seismic Structure

⇒ Click OK.

An expert geologist gave you the probability distributions for different seismic structures given different oil reservoir sizes. Had the expert given us the converse, you would have made an arc from Seismic Structure to Amount of Oil. DPL automatically performs Bayesian revision if the nodes are placed in the tree in the opposite of arc order, so you can accept the data in either form.
Note: To define probabilities and values separately in the Node Definition dialog, Advanced chance/value node features must be checked in Model | Options | Edit | Advanced Settings. This option was already on in the model Wildcat simple in Learning.da. By default, it will initially be off in any new models you create. You can change the default so that it is on.

The Influence Diagram is now complete. You now need to update the Decision Tree.

- You may wish to drag the splitter up to give you more room to work in the Decision Tree pane but make sure you can also see the Influence Diagram.
- Select Test in the Influence Diagram pane.
- Drag it down to the Decision Tree pane and drop it to the left of the Drill decision in the existing tree (not attached to anything).
- Double-click on the Test decision to bring up the Node Definition dialog.
- Select Asymmetric for the Alternative Grouping.
- Click OK.
- Drag the Drill decision and drop it on the blue triangle for the None branch of the Test decision. Your model should look like Figure 7-12.
Chapter 7: Conditioning and Learning in Decision Models

Syncopation Software

Figure 7-12. Decision Tree with Test Decision Added

If the Wildcatter decides to conduct the Core sample test, s/he will know the Seismic Structure before making the decision about whether to drill. Therefore, the Seismic Structure chance node needs to be added to the Core Sample branch of the Test decision.

- Drag the blue triangle on the Core sample branch down to make some room.
- Select Seismic Structure in the Influence Diagram pane.
- Drag it down to the Decision Tree pane and drop it on the blue triangle on the Core Sample branch.

Your decision tree should now look like Figure 7-13.
Figure 7-13. Decision Tree with Seismic Structure Uncertainty Added

Note you can also add decisions or chances to the Decision Tree by clicking the Add Decision/Chance to Tree icons in the toolbar (see Table 1-2). This brings up the Select Decision/Chance dialog and allows you to select what you would like to add to the Decision Tree.

On the Core sample path through the tree, the Seismic Structure uncertainty is followed by the Drill decision and from there on the structure is the same as the top part of the tree. Rather than repeat that sequence, you'll use the Perform Subtree feature.

- Right-click on the Drill decision in the tree and select Perform Subtree.
- Place the crosshairs over the blue triangle after the Seismic Structure uncertainty.
- Click the left button.
Chapter 7: Conditioning and Learning in Decision Models

DPL labels the Drill decision node with an "a". This is called a Perform Target. DPL also changes the blue triangle after the seismic structure uncertainty to be a yellow decision node and labels it "a". This is called a Perform Reference. Perform Subtrees can also be headed by a chance node (i.e., the Perform Target can be a chance node). If the Perform Target is a chance node, then the Perform Reference is drawn as a chance node. Multiple Perform Subtrees are allowed in a DPL Decision Tree.

Note: you can also create a Perform Subtree by Ctrl-Shift-dragging from the Perform Target to the Perform Reference. To do this for the example above, you would hold down both Ctrl and Shift and drag the Drill decision to the blue triangle after Seismic Structure. Further, you can also use the Perform Subtree button on the tool bar (see Table 2-1) by clicking on it, clicking on the Perform Target and then clicking on the Perform Reference.

Finally, you need to add a Get/Pay expression to the tree for Test Costs.

1. Select the Test Costs node in the Influence Diagram pane.
2. Drag it down to the Decision Tree pane. The cursor changes to the add get/pay cursor (\[set\]).
3. Drop it on the Core Sample branch of the Test decision.

Note: as an alternative to the above steps, double-clicked the Core Sample branch of the Test decision. This brings up the Get/Pay tab of the Branch Definition dialog. You may then specify the get/pay expression via that dialog.

Your decision tree should now look like Figure 7-14.
Select Run | Decision Analysis.
Click OK to the warning.
Check Risk Profile.
Click the Initial decision alternatives button.
Check Policy Tree™.
Click OK.

The Policy Tree™ in Figure 7-15 shows that the Core sample test is the optimal alternative. Even including the $6 million cost of the test, the Core sample alternative has an expected value of $31 million, $4.5 million more than drilling without a test.
When there is no seismic structure, the optimal policy is not to drill, since doing so has an expected value of -$31.5 million. The imperfect information about Seismic Structure is valuable because it changes the Drill decision in that scenario.

Navigate to the Risk Profile Chart (labeled Initial Decision Alternatives in the Workspace Manager). See Figure 7-16.
Figure 7-16. Risk Profiles for the Initial Decision Alternatives

The Risk Profile shows how the seismic structure information has a risk mitigation effect. The probability of an NPV outcome of -$50 million or worse is 20% with the Core sample test and 50% without it.

The slight difference between the two alternatives at the higher end of the chart (upper right) simply reflects the cost of the test, which reduces the value of the Core sample alternative slightly in the best-case scenarios.
7.2 Summary of DPL Influence Arcs

DPL influence arcs are color coded. Table 7-2 summarizes what each color means.

<table>
<thead>
<tr>
<th>Color</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>No conditioning</td>
</tr>
<tr>
<td>Blue</td>
<td>Values conditioned</td>
</tr>
<tr>
<td>Green*</td>
<td>Probabilities conditioned</td>
</tr>
<tr>
<td>Burgundy</td>
<td>Both values and probabilities conditioned</td>
</tr>
</tbody>
</table>

Table 7-2. Arc Arrowhead Color Meanings

Arc arrowheads appear magenta when selected, so you may need to press Esc to see the actual arc arrowhead color.

The "from" node is known as the predecessor and the "to" node is called the successor. Because not all predecessors have states, and not all successors have probabilities, some arc types may not be available between a given pair of nodes.

Even when an arc is black and there is no conditioning, there can still be dependence in the calculations if the value of the predecessor node is used in a formula in the successor node. This is the case with the arc from Oil Price to Revenues in the Learning.da model.
Table 7-3 summarizes which type of arc is available between each of the node types in DPL.

<table>
<thead>
<tr>
<th>From (predecessor)</th>
<th>To (successor)</th>
<th>Continuous change</th>
<th>Discrete change</th>
<th>Decision</th>
<th>Value</th>
<th>Controlled</th>
</tr>
</thead>
<tbody>
<tr>
<td>Continuous change</td>
<td>Black</td>
<td>Black</td>
<td>Black</td>
<td>Black</td>
<td>Black</td>
<td>Black</td>
</tr>
<tr>
<td>Discrete change</td>
<td>Black, burgundy</td>
<td>Black, green*, blue*, burgundy</td>
<td>Black, blue</td>
<td>Black, blue</td>
<td>Black, blue</td>
<td></td>
</tr>
<tr>
<td>Decision</td>
<td>Black, burgundy</td>
<td>Black, green*, blue*, burgundy</td>
<td>Black, blue</td>
<td>Black, blue</td>
<td>Black, blue</td>
<td></td>
</tr>
<tr>
<td>Value</td>
<td>Black</td>
<td>Black</td>
<td>Black</td>
<td>Black</td>
<td>Black</td>
<td>Black</td>
</tr>
<tr>
<td>Controlled</td>
<td>Black, burgundy</td>
<td>Black, green*, blue*, burgundy</td>
<td>Black, blue</td>
<td>Black, blue</td>
<td>Black, blue</td>
<td></td>
</tr>
</tbody>
</table>

* Advanced chance/value node features must be checked in Model | Options | Edit for this arc type to be available.
8 Risk Tolerance

While there are theoretical arguments for making decisions based on expected value alone, often decisions are made with some consideration of the degree of risk involved in the different alternatives. In many cases, good risk visualization is enough and a judgment about risk can be made after looking at Risk Profiles, Time Series Percentiles, Tornado Diagrams, and other results.

In situations where explicitly modeling attitudes toward risk is appropriate, DPL gives you the ability to model your risk aversion (or risk seeking) in terms of a utility function. To model attitudes toward risk using an exponential utility function (a standard form well supported by research), you need only specify a single number: the risk tolerance coefficient.

This chapter assumes you have already been through at least one of the earlier tutorials (Chapters 1 through 5) in this manual, or that you are already familiar with DPL. Therefore, basic procedures such as starting DPL and opening and saving workspaces will not be explained in detail here.

8.1 Incorporating a Risk Tolerance

You’ll start with the License vs. In-house model introduced in Chapter 2.

⇒ Start DPL.
⇒ Open RiskTolerance.da in the Examples folder underneath where DPL is installed (C:\Program Files\Syncopation\DPL7\Examples if the default location was used during installation). This file contains the completed model from Chapter 2.

DPL opens the Workspace as shown in Figure 8-1.
Figure 8-1. License vs. In-house Model

Run the model to review the current results from this model.

⇒ Select Run | Decision Analysis (or press F10).
⇒ Check Risk Profile.
⇒ Click the Initial decision alternatives button.
⇒ Check Policy Tree™.
⇒ Click OK.
The Policy Tree™ (Figure 8-2) shows that In-house is the optimal alternative. The expected value of In-house is $2.9 million more than the expected value of License.

Navigate to the Risk Profile Chart called Initial Decision Alternatives.
The Risk Profiles of the two alternatives show a more ambiguous result (Figure 8-3). In-house is better in terms of expected value, but it is also more risky. Would a decision maker's attitude toward risk ever lead him/her to choose License?

✦ Return to the Model window.
✦ Click the Create Value toolbar button (see Table 1-2) to create a new node which will contain data for your risk tolerance.
✦ Place the node near Profit.
✦ Name it Risk Tolerance.
✦ Click the Data tab.
✦ Type "50" for the value.
✦ Click OK.
✦ Select Model | Risk Tolerance. The Risk Tolerance dialog appears.
✦ Click the Select Variable button next to the Risk tolerance coefficient box.
Select Risk_Tolerance.
Click OK. The Risk Tolerance dialog should look like Figure 8-4.
Click OK.

You might ask where the 50 comes from. In rough terms, it’s the amount you (or your company) are willing to put at risk. You can assess your risk tolerance coefficient directly using the following rule. Imagine that a fair coin will be tossed. If you call it correctly, you win R, if not, you lose half of R. What is the largest R for which you would be willing to play this game? The largest R for which you would be willing to play is the risk tolerance coefficient.

Risk tolerance coefficients are difficult to assess and are never very precise. You should always test your risk tolerance coefficient using sensitivity analysis (as you will below). For this reason, it is good to define a value node for your risk tolerance rather than specifying the number directly in the Risk Tolerance dialog. If you did the latter, you would not be able to run a sensitivity analysis on it.

You’ll now run the model and observe how the results have changed.

Select Run | Decision Analysis.
Click OK for the warning.
Click OK.
Chapter 8: Risk Tolerance

Syncopation Software

In-house is still the preferred alternative, but the gap has narrowed. The results in Figure 8-5 are Certain Equivalents, which are being shown because risk tolerance is now incorporated in your model. Pursuing the In-house alternative might result in an outcome better or worse than 29.336, but a decision maker with a risk tolerance of 50 would be indifferent between the investment and a perfectly safe 29.336. If, as is usually the case, the decision maker is risk averse, the Certain Equivalent will be less than the Expected Value.

If you would like to see the Expected Value results (Figure 8-2) again, select View | EV. DPL changes the Policy Tree™ to show the EV results.

In a model with a risk tolerance, DPL always calculates both EV (Expected Value) and CE (Certain Equivalent) results. With a risk tolerance coefficient of 50, the optimal decision is unchanged. How much lower would it have to go (i.e., how much more risk averse would you have to be) for the License alternative to have a higher certain equivalent than the In-house alternative?
Select Run | Rainbow Diagram.
Click Select.
Select Risk_Tolerance from the Value for sensitivity drop-down list.
Click OK.
Type "10" for From.
Type "50" for To.
Type "5" for Step size.
The Run Rainbow Diagram dialog should look like Figure 8-6.

Figure 8-6. Run Rainbow Diagram dialog

Click OK.

The rainbow diagram in Figure 8-7 shows that the optimal decision policy would change if your risk tolerance dropped to 35. The precise threshold is between 35 and 40. You could run another Rainbow Diagram with a smaller step size if you need to know more precisely the value at which the policy changes.
Chapter 8: Risk Tolerance

8.2 Advanced Utility Functions

If you want to specify a utility function other than the standard exponential, you can do so in the Model | Risk Tolerance dialog. You need to specify both the function and its inverse, using the dummy variable "$". Utility functions cannot depend on the state of events although they can (and generally should) depend on or use constant values such as Risk Tolerance. Figure 8-8 shows the definition of a user-defined utility function equivalent to the built-in exponential utility function.

Figure 8-7. Rainbow Diagram on Risk Tolerance
Figure 8-8. User-defined Utility Function

Note: Most applications that require modeling risk aversion can be done so by specifying a single risk tolerance or utility function for the entire Decision Tree. However, there is a theoretical argument for changing the degree of risk aversion throughout the tree as the company’s situation changes. DPL provides this capability, although it is hidden by default since it is so seldom used. To use this feature, turn on Risk tolerance and utility functions by branch in Tools | Options | Advanced. The Branch Definition Dialog will then have a Risk Tolerance tab.
9 Sensitivity Analyses

Four types of sensitivity analyses (Value Tornado, Base Case Tornado, Initial Decision Alternatives Tornado, and Rainbow Diagram) were discussed in Chapters 2 and 3 and other earlier chapters. This chapter covers two further types of sensitivity analysis that DPL offers and provides some guidance on when it is most appropriate to use each of DPL's sensitivity analysis outputs.

9.1 Two-Way Rainbow Diagrams

A Two-Way Rainbow Diagram is a sensitivity analysis that is run on two selected values from a model. The diagram displays the policy changes for each combination of the two values selected. In addition, you can use the Show Tips feature to see the change in the objective function of the model for each combination of the two values.

You will now run a Two-Way Rainbow Diagram.

⇒ Select File | Open Workspace.
⇒ Navigate to the Examples folder underneath where you installed DPL. If you used the default location, the path is C:\Program Files\Syncopation\DPL7\Examples.
⇒ Select Product.da.

DPL opens the Workspace as shown in Figure 9-1.
This model is the same as the completed model that is built in Chapters 2 and 3.

Select Run | Two-Way Rainbow Diagram. The Run Two-Way Rainbow Diagram dialog appears as shown in Figure 9-2.
Chapter 9: Sensitivity Analyses

Figure 9-2. Run Two-Way Rainbow Diagram Dialog

Click the Select button in the First Variable (x-axis) section. The Select Value dialog appears as shown in Figure 9-3.

Figure 9-3. Select Value Dialog for Two-Way Rainbow

Select Per_Unit_Costs in the Value for sensitivity dropdown box.

The Select Value dialog updates to show you that the value Per_Unit_Costs is conditioned as shown in Figure 9-4. In this instance Per Unit Costs is a discrete chance node that has probability and value data. Therefore the value for Per_Unit_Costs is conditioned by which state (or outcome) the Per Unit Costs discrete chance node is in. To run a Two-Way Rainbow
Diagram on a value that is conditioned, you must specify the conditioning states for each conditioning event. For example, if value node C were conditioned by discrete chance node A and decision B, in the Conditioning section of the Select Value dialog you would need to specify an outcome for A and an alternative for B in order to run a Two-Way Rainbow Diagram on C.

**Figure 9-4. Select Value Dialog Displaying Conditioning for Per_Unit_Costs**

- In the dropdown box in the Conditioning section, select High.
- Click OK.

The Run Two-Way Rainbow Diagram dialog updates to indicate the value and the conditioning states (if any) that you have selected. DPL displays a value and its conditioning using the notation value\|event.state. You have selected the Per_Unit_Costs value for the High state of the Per_Unit_Costs chance event, so DPL displays Per_Unit_Costs\|Per_Unit_Costs.High in the Variable name label box. If the value you have chosen is conditioned by multiple events, this is indicated by separating each event.state with commas, i.e., value\|event1.state, event2.state, etc.

In the Current value label box, DPL displays the current value for the variable given its conditioning. See Figure 9-5.
In the From: edit box in the First Variable (x-axis) section, type "0.8".

In the To: edit box, type "1.05".

In the Step Size edit box, type "0.025". Note that the Step Size radio button becomes selected.

Click the Select button in the Second Variable (y-axis) section. The Select Value dialog appears again.

Select License_Fee in the Value for sensitivity dropdown box.

Click OK.

In the From: edit box in the Second Variable (y-axis) section, type "0.7".

In the To: edit box, type "0.9".

In the Step Size edit box, type "0.025".
The Run Two-Way Rainbow Diagram dialog should look like Figure 9-6.

![Two Way Rainbow Diagram Dialog](image)

Figure 9-6. Run Two-Way Rainbow Dialog after Specifying Values

- Click OK to run the Two-Way Rainbow Diagram.

DPL produces the Two-Way Rainbow shown in Figure 9-7. DPL creates a Two-Way Rainbow Diagram by running the model for each combination of the two values selected for the diagram. To create the Two-Way Rainbow Diagram in Figure 9-7, DPL ran the model 99 times.
Figure 9-7. Two-Way Rainbow Diagram

A Two-Way Rainbow Diagram displays policy regions for the values on the x- and y- axes. The policy within a region of the same color is the same. A color change indicates a change in policy. The Two-Way Rainbow Diagram in Figure 9-7 indicates that the optimal policy depends on both the value of Per_Unit_Cost.High and License_Fee. This can be seen because the change in policy as License_Fee increases occurs at lower and lower values as Per_Unit_Costs.High increases. For example, when Per_Unit_Costs.High is 0.8, 0.825, or 0.85, a change in policy occurs as License_Fee increases from 0.85 to 0.875, but when Per_Unit_Costs.High is 0.875, a change in policy occurs as License_Fee increases from 0.825 to 0.85.

To see which policy is optimal in each region and what the expected value of the model is at each marker in the Two-Way Rainbow Diagram, you must have Show Tips turned on.

⇒ To check if you have Show Tips turned on, select Tools | Options.
⇒ On the General tab of the Options dialog, make sure Show Tips is checked.
Click OK to close the Options dialog.
Move your mouse over one of the markers that indicate the combinations of the two values tested in the Two-Way Rainbow Diagram.

A policy tip appears as shown in Figure 9-8.

The policy tip tells you the expected value of the model given the values of the two variables that the marker represents. For example, the policy tip in Figure 9-8 indicates that the expected value of the model is 33.9 when License_Fee is 0.825 and Per_Unit_Cost.High is 0.875. The policy tip also tells you the policy dependent probabilities for each decision in the model given the values of the variables that the marker represents. The decision alternatives are displayed in the policy tip by using the decision node name followed by a colon followed by the decision alternative. E.g., "Product Strategy: License".
The policy dependent probability for the alternative follows the equal sign. As Figure 9-8 indicates, the policy when License_Fee is 0.825 and Per_Unit_Cost.High is 0.875 is to produce the product in-house and downstream to raise the price in 30% of the scenarios and to keep price the same in 70% of the scenarios. To keep the policy tip compact, decision alternatives with a policy dependent probability of zero are not displayed.

The information displayed in the policy tip is also available in the Session Log for all the points.

- Click the Log tab of the Workspace Window.
- Make the Workspace Window wider by dragging its edge.

The expected value of the objective function and the policy information is written to the Session Log for each point. See Figure 9-9.

![Figure 9-9. Session Log with Policy Information from Two-Way Rainbow Diagram](image-url)
Click the Manager tab of the Workspace Window.

Make the Workspace Window narrower again by dragging its edge.

9.2 Event Tornadoes

Event tornadoes provide information about how much each chance node in a model contributes to the overall uncertainty in the outcomes of the objective function of the model. There are three types of Event Tornadoes in DPL: Deterministic, Probabilistic and Combination.

DPL creates a Deterministic Event Tornado by running the model once to establish the minimum amount of uncertainty in the model (called the Minimum Model Range). DPL does this by replacing all the chance events in the model with their expected values. Then, DPL runs the model one additional time for each chance event in the model (call this event the sensitivity event). In each of these subsequent runs, DPL replaces all of the chance events in the model except the sensitivity event with their expected values. It leaves the sensitivity event unchanged. In effect, in each sensitivity event model run the only uncertainty left in the model is the uncertainty associated with the sensitivity event (unless Always Gamble has been set for chance events, see below).

DPL follows an analogous procedure to create a Probabilistic Event Tornado. DPL runs the model once to establish the original amount of uncertainty in the model (called the Original Model Range). Then, DPL runs the model one additional time for each chance event in the model (the sensitivity event). However, for Probabilistic Event Tornadoes, in these subsequent runs DPL leaves all of the chance events in the model unchanged except for the sensitivity event. The sensitivity event is replaced with its expected value. In effect, in each sensitivity event model run the reduction in uncertainty from the Original Model Range is due to the removal of the uncertainty associated with the sensitivity event.

If either Don't Gamble or Always Gamble is set for a chance event, this has an impact on how the Event Tornado is run. To set Don't Gamble or Always Gamble for an event, Advanced chance/value node settings must be checked in Model | Options | Edit. The Don't Gamble and Always Gamble checkboxes are found on the Tree Instance tab of the Node Definition.
To access the Tree Instance tab for a chance node, double-click the chance node in the Decision Tree Pane (or select Node | Edit Definition while the node is selected in the Decision Tree Pane).

For Probabilistic and Deterministic Event Tornadoes, Don't Gamble and Always gamble have the following effects. If Don't Gamble is set for a chance event, then it is not gambled on regardless of whether or not it is the sensitivity event (i.e., it is always replaced with its expected value in the Event Tornado). If Always Gamble is set for a chance event, then it is gambled on regardless of whether or not it is the sensitivity event (i.e., it is never replaced with its expected value in the Event Tornado).

A Combination Event Tornado (which is only available if Advanced chance/value node features are on) is the same as a Probabilistic Event Tornado except that it toggles the Don't Gamble setting for each node. Chance events with Always Gamble set are never replaced with their expected values. When DPL runs the model the first time to establish the Original Model Range, any chance events with Don't Gamble set are left as such and are replaced with their expected values. All other chance events are gambled on. For each sensitivity event model run, DPL sets Don't Gamble for the sensitivity event if it was not set in the Original Model Range run (assuming Always Gamble has not been set for the sensitivity event) or removes the Don't Gamble setting if it was set in the Original Model Range run.

Note: because a Deterministic Event Tornado replaces chance events with their expected value, it may not be appropriate to use for models that use a risk tolerance and hence have certain equivalents. For such models, consider using a Probabilistic Event Tornado.

You will now run a Deterministic Event Tornado.

⇒ If Product.da is not already open, select File | Open Workspace.
⇒ Navigate to the Examples folder underneath where you installed DPL. If the default location was used for installing, the path is C:\Program Files\Syncopation\DPL7\Examples.
⇒ Select Product.da.
⇒ Press F8 (or select Run | Tornado Diagram).

The Select Tornado Type dialog appears as shown in Figure 9-10.
Figure 9-10. Select Tornado Type Dialog

⇒ Click the Event radio button.
⇒ The Deterministic radio button in the Event Tornado Type section should be selected. If it is not, click it.
⇒ Click OK.

DPL produces the Deterministic Event Tornado shown in Figure 9-11.
Figure 9-11. Deterministic Event Tornado

The width of each bar indicates the difference between the 10th percentile and the 90th percentile of the risk profile of the objective function for the model when the sensitivity event labeling the bar is the only uncertainty in the model (unless chance events have been set to Always Gamble). The change in color occurs at the 50th percentile. The bar is yellow between the 10th and the 50th percentiles, and red between the 50th and 90th percentiles. The black vertical line running through all the bars indicates the expected value established in the run for the Minimum Model Range.

A bar may not change color if the risk profile is highly skewed for a particular chance event. For example, if the 50th percentile were equal to the 90th percentile, then the entire bar would be yellow.

The narrower a bar is for a chance event in a Deterministic Event Tornado, the less impact the chance event has on the overall uncertainty in a model. Bars nearer the top of a Deterministic Event Tornado contribute more to the overall uncertainty in a model.
Chapter 9: Sensitivity Analyses

If a chance event appears in a Deterministic Event Tornado with a "bar" of no width, then the 10th and 90th percentiles are equal. The most likely reason for this is that Don't Gamble has been set for the event, though it could be because the 10th and 90th percentiles are truly equal. The latter may happen in an asymmetric tree when an uncertainty only occurs for a particular decision alternative, and that alternative is never optimal.

You will now run a Probabilistic Event Tornado.

✦ Press F8 (or select Run | Tornado Diagram). The Select Tornado Type dialog appears.
✦ Click the Event radio button.
✦ Click the Probabilistic radio button in the Event Tornado Type section.
✦ Click OK.

DPL produces the Probabilistic Event Tornado shown in Figure 9-12.

![Figure 9-12. Probabilistic Event Tornado](image)

Figure 9-12. Probabilistic Event Tornado
The width of each bar indicates the difference between the 10th percentile and the 90th percentile of the risk profile of the objective function for the model when the sensitivity event labeling the bar is the only uncertainty removed from the model (unless other chance events have been set to Don't Gamble). The change in color occurs at the 50th percentile. The bar is yellow between the 10th and the 50th percentiles; red between the 50th and 90th percentiles. The black vertical line running through all the bars indicates the expected value established in the run for the Original Model Range.

As in a Deterministic Event Tornado, a bar may not change color if the risk profile is highly skewed for the model with the sensitivity event replaced by its expected value.

The narrower a bar is for a chance event in a Probabilistic Event Tornado, the greater the reduction in uncertainty is due to the "removal" of the chance event. Bars nearer the top of a Probabilistic Event Tornado contribute more to the overall uncertainty in a model.
## 9.3 When to Use Which DPL Sensitivity Output

Tables 9-1 and 9-2 provide a summary of when it is most appropriate to use each of DPL's sensitivity outputs as well as when to be careful using a particular sensitivity output.

<table>
<thead>
<tr>
<th>Output</th>
<th>Particularly good for:</th>
<th>Things to be aware of:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value Tornado</td>
<td>Determining which values in a deterministic model should be treated as uncertainties, understanding the probabilistic impact of changes to values in probabilistic models.</td>
<td></td>
</tr>
<tr>
<td>Base Case Tornado</td>
<td>Understanding the deterministic impact of chance events, comparing the deterministic impact of changes to values to chance events.</td>
<td>Can be difficult to interpret for highly asymmetric models. All conditioning and probabilities are ignored. Results are sensitive to the definition of the Nominal state for each chance event.</td>
</tr>
<tr>
<td>Deterministic Event Tornado</td>
<td>Understanding the probabilistic contribution of each chance event to overall model uncertainty. Understanding the impact of a chance event while preserving conditioning.</td>
<td>Inappropriate to use for models with risk tolerance.</td>
</tr>
<tr>
<td>Probabilistic Event Tornado</td>
<td>Same as Deterministic Event Tornado.</td>
<td>Appropriate to use for models with risk tolerance. Can be difficult to explain.</td>
</tr>
<tr>
<td>Combination Event Tornado</td>
<td>Understanding how changing the treatment of a chance event from Gamble to Don't Gamble impacts a model.</td>
<td></td>
</tr>
</tbody>
</table>

**Table 9-1. Summary of When to Use Each of DPL's Tornado Diagrams**
Output | Particularly good for: | Things to be aware of:
--- | --- | ---
Rainbow Diagram | Understanding the impact on the objective function of varying a single value across a number of settings, determining if policy changes occur as a result of varying a single value across a number of settings. | 

Two-Way Rainbow Diagram | Understanding how the interaction between two variables impacts the objective function, determining if policy changes occur as a result of varying two values simultaneously. | 

**Table 9-2. Summary of When to Use Each of DPL's Rainbow Diagrams**
A Overview of Spreadsheet Linking

DPL provides a complete set of features for linking to Excel spreadsheets. Most real-world DPL analyses involve spreadsheet linking at some point. This Appendix summarizes DPL's main spreadsheet linking features and gives suggestions on when and why to use each feature.

A.1 Types of Spreadsheet Links in a DPL Model

Calculation Links are appropriate when the value measures being used for the analysis are calculated in a spreadsheet model, usually a financial model producing NPV, IRR, etc. Most DPL analyses employ calculation links, and there are several ways to set them up.

Initialization Links are used when it is more convenient to keep the numbers initializing DPL nodes (probabilities and values) in a spreadsheet, rather than within DPL node data. With initialization links, you can design your DPL model as a template to be used with several input data spreadsheets.

A DPL model can have either or both types of links. IMPORTANT: If a model has both types of links to the same Excel workbook, the initialization links must be on a sheet which does not contain any calculation links. When you are building a model that requires both initialization links and calculation links, it is usually easiest to set up the calculation links first.

DPL's linking features are intended to work with input and output cells that are named ranges in Excel. In general, when developing an Excel spreadsheet that you intend to link to DPL, you should make a habit of creating range names for any cells or ranges that may later become value, chance, or decision nodes in DPL. You may also find it helpful to adopt standard conventions for your range names, although DPL does not require this.
When a DPL model is linked to a spreadsheet, DPL uses Excel to recalculate the outputs (e.g., NPV) in each scenario. This approach is easy and simple, and works well with spreadsheets of moderate complexity and size. Very large or complex spreadsheets may require a long time to recalculate. Solutions for using DPL with spreadsheets of advanced complexity, such as spreadsheet conversion and linking to multidimensional value nodes, are provided in the DPL 7 Professional version and are described in the *DPL Professional Manual*.

### A.2 Calculation Links

There are three ways to establish calculation links between a DPL model and an Excel spreadsheet. A table summarizing the three methods is given at the end of this section.

#### A.2.1 Method 1: Creating a New Calculation-linked Model from Excel

When you are starting with a more or less complete Excel spreadsheet but have not yet developed a DPL model for the spreadsheet, you may want to use the command:

Model | Create from Excel.

This command creates a DPL Influence Diagram from the named cells in an Excel spreadsheet (all or a specified selection of them). This is a smart import, where DPL processes all the data and calculations in the Excel .xls file, so it is able to generate influence arcs based on the formulas. When you do this, you will typically select several export values and at least one import value (formula) from a list of cells/range names in your Excel spreadsheet.

Note: If you have built the DPL model in this way, you will usually be able to use the command Model | Update from Excel if the spreadsheet changes and/or you need to add linked nodes later on.
The basic steps are as follows:

⇒ Select Model | Create from Excel.
⇒ Browse to locate the spreadsheet you wish to use.
⇒ Select the names of the ranges you wish to use.

DPL creates an influence diagram with arcs representing the relationships in your spreadsheet. This provides you a starting point for your linked model. See Figure A-13 and Figure A-2 below.
Appendix A: Overview of Spreadsheet Linking

Syncopation Software

Figure A-2. Cell Names Dialog for Creating Model from Excel

When you use this method you will see that DPL includes all of the named cells in the Cell Names dialog, so that you can choose to use any or all of the cells in your linked model.

Note: Method 1 may fail if the spreadsheet contains functions DPL does not support. If this happens, use Method 2 as explained below.

Also see Section 4.1 of this manual, Creating a Model from Excel, for an example of Method 1.
A.2.2 Method 2: Adding Calculation-linked Nodes to an Existing Model

Often you will build a model in DPL and a separate spreadsheet in parallel and link the two at some point in the process, adding new nodes to DPL that are linked to the spreadsheet. In this situation you may wish to use the command:

Node | Create Linked Values | From Excel.

This command adds linked values to the influence diagram. The nodes are created as values, but (as with Method 1) they can be changed later to decision nodes or chance nodes as desired.

The basic steps for this method are as follows:

⇒ Select Node | Create Linked Values | From Excel.
⇒ Browse to locate the spreadsheet you wish to use.
⇒ Select the names of the values you wish to use.

See Figure A-14 and Figure A-15.

![Create Values from Excel Dialog](image)
Appendix A: Overview of Spreadsheet Linking

Syncopation Software

Figure A-15. Cell Names Dialog for Creating Linked Values from Excel

DPL adds the new values to your model as value nodes, but does not add influence arcs. You may need to add influence arcs as well as changing the node type(s) to decision or chance nodes. See Section 5.2, Creating Linked Values for an example of this method.

When you use this method you will notice that DPL lets you check whether to show cells that are already linked (the default is no), and whether to show cells with formulas (the default is yes). DPL assumes that since you are adding a new linked node, you probably do not want to choose a cell that is already linked to another node, and you probably do want to consider cells with formulas, since they could become new import nodes. You can check or un-check these options if needed and the contents of the Cell Names list will be updated.
The Create Linked Values from Excel method can be used in conjunction with the Create Model from Excel method. You might start by using Create Model from Excel and subsequently decide that existing named cells within Excel need to be linked to DPL or you may modify the Excel spreadsheet and then need to link these new named ranges to DPL.

A.2.3  Method 3: Establishing Calculation Links for an Existing Node

You may already have a node created in your DPL model that needs to be linked to your spreadsheet. In this situation, simply edit the node as usual or use the command:

Node | Edit Definition | Links.

This command gives you access to the Links tab of the Node Definition dialog so you can link an existing Influence Diagram node to an Excel cell.

From the Links tab:

- Specify Excel as the Calculation Link type;
- If needed, use the Browse button to select the spreadsheet;
- Click Cell Names;
- Select the desired cell from the list;
- Click OK.

Alternatively, once you have specified Excel as the Calculation link type, you can copy the cell in Excel (using the Excel command Edit | Copy or Ctrl+C), switch back to DPL and click the Paste Link button on the Links tab of Node Definition dialog.

See Figure A-5 and Figure A-16.
Figure A-5. Cell Names Dialog when Linking an Existing Node
Figure A-16. Node Definition with Link Defined

With this method, DPL will also adjust which cell names appear in the dialog depending on whether the node you are linking has data in it. If it has data, you will see that "Show cells with formulas" is not checked, because DPL assumes it will be an export node. Conversely, if the node has no data, by default DPL checks "Show cells with formulas" because DPL assumes the node will be an import node which is typically linked to a cell with a formula in it. You can check or un-check these options to see the full set or restricted set of cell names if you need to.

Also see Section 4.5 of this manual for an example of adding a linked decision node using this method.
A.2.4 Summary of Calculation Links Methods

Table A-1 summarizes when each method is appropriate.

<table>
<thead>
<tr>
<th>Situation</th>
<th>Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Building a spreadsheet-linked DPL model from scratch</td>
<td>Method 1, or Method 2 if you have unsupported functions</td>
</tr>
<tr>
<td>Adding a node to the DPL model for a new driver cell in the spreadsheet</td>
<td>Method 2 (unless you have started with Method 1 then either 1 or 2)</td>
</tr>
<tr>
<td>Linking an existing or newly created node to a cell in the spreadsheet</td>
<td>Method 3</td>
</tr>
</tbody>
</table>

Table A-1. Summary of Methods for Establishing Calculation Links

A.3 Initialization Links

Initialization links are appropriate when you wish to store probabilities and values for DPL node data in a spreadsheet. DPL uses the initialization links to set the probabilities and values for the linked node(s). Initialization links are completely separate from calculation links. The named ranges for initialization links must be on a sheet or sheets that contain no calculation links.

To use initialization links, first define a range in Excel that contains the probability or value data you wish to link to the node in DPL. The way you define the range will vary depending on the chance node and its conditioning. For a simple 3-state chance node, you define a 3-cell range containing the probabilities and/or another 3-cell range containing the values. Probabilities and values are initialized separately in chance nodes and must be stored in separate named ranges in Excel.
For a chance node that is conditioned by another event, you define a two-dimensional cell range (e.g., 3 by 3) in which the rows correspond to the states of the conditioning node, and the columns correspond to the probabilities or values for the branches of the conditioned node. An example of this is given below for a conditioned 3-state chance node.

To establish initialization links for a node, you need to do the following.

⇒ In the Influence Diagram pane, edit the node that you wish to link.
⇒ Turn on initialization links by clicking Microsoft Excel in the Initialization Links section of the Links tab of the Node Definition dialog.
⇒ If needed, browse for the spreadsheet workbook you wish to use for the link.

Note that in the dialog shown in Figure A-17, the initialization link is established with a node that already has calculation links. The Same as calc links option is checked, so you are linking this node to the same workbook. However, if the node did not already have calculation links or if you want to link it to a different workbook for initialization, you would un-check the Same as calc links option and use the Browse button to find the new workbook.
In the Excel spreadsheet, make sure that you have named a range containing the data you wish to link.

In Figure A-18, the range Mkt_ph2_probs has been defined and it contains the probabilities 0.3, 0.4, 0.3. For unconditioned nodes, the range can be a row or a column.
Select the Data tab.
Select the first branch of the node.
Click the Links button (i).

DPL displays a list of the range names in the spreadsheet that you selected in Node Definition | Links.
Select the appropriate range.
Click OK.

The range appears in the edit box as a reference in "=Sheet!Cell" notation. See Figure A-19.
Suppose in the example above that the node Marketing phase 2 is conditioned by the 3-state chance node, Marketing phase 1. In this case, you need to specify 9 probabilities and 9 values for the Marketing phase 2 node since it is conditioned. The Data tab for the Marketing phase 2 node would initially look like Figure A-20.
In Figure A-21, the range Mkt_ph2_cond_probs has been defined and it contains the probabilities for each state of Marketing Phase 2 conditioned on each state of Marketing Phase 1. Note that the probabilities sum to 1.0 across the rows.
To use this named range to initialize the Marketing phase 2 node, you follow the same steps as before, linking the first (top) branch of the node to the range Mkt_ph2_cond_probs. The Data tab of the Node Definition dialog will look like Figure A-22 once the initialization link has been established.
As noted above, in a discrete chance node definition, probabilities and values are initialized separately, so if both will be initialized using links you need to define two range names in the spreadsheet: one for probabilities and one for values. In the examples above, only the probabilities are linked. Values can be linked in the same way; simply use the Links button to fill in the Value data in the Node Definition dialog. An example of this appears in Section 4.7 of this manual, in which both the probabilities and values for a chance node are initialized using links.

Initialization links can be very useful if you are developing large models, especially if you are using your DPL model as an "engine" for multiple Excel templates. If you have further questions about initialization links, consult online Help or contact Support.
A.4 Managing Spreadsheet Links

Once you've established links for your individual nodes, you can make changes to all the links as a group using the Model Links dialog by selecting Model | Links. See Figure A-23. From this dialog you can:

- Change the spreadsheet name or location.
- Remove all links to the spreadsheet.
- Browse the nodes linked to the spreadsheet.
- Convert the spreadsheet to a DPL Calculation Program (DPL Professional and Enterprise only).

![Model Links Dialog](image)

**Figure A-23. Model Links Dialog**

The Model Links dialog also tells you how many nodes are linked to the spreadsheet. The number of nodes with calculation links is displayed first in the Nodes column of the Linked Spreadsheets list. The number of nodes with initialization links is displayed second, and the total number of nodes...
is also given. The linked spreadsheet in Figure A-23 has 15 calculation links nodes and 8 initialization links nodes out of 17 nodes in the model. Several of the nodes in this model are both calculation links and initialization links nodes.

After you've set up the links in your model, it's a good idea to use Show Nodes to check that all the nodes are linked to the correct cells; see Figure A-24. This is particularly true if you used Method 3 to establish the links, since you could have chosen the wrong cell by mistake. The dialog shows each linked node, its sheet and range name, and its links type. A node is shown twice if it is both a calculation links node and an initialization links node.

![Figure A-24. Show Linked Nodes Dialog](image-url)
www.syncopation.com
B System Requirements and Compatibility with Older Releases

DPL 7 is compatible with Windows 2000, XP and Vista.

In order to be able to link to spreadsheets, you need to have Excel for Office 2000, XP, 2002, 2003 or 2007.

A minimum of 20 MB of free disk space is required. For a complete install with all documentation, approximately 200 MB is required.

A display with resolution 1024 by 768 (XGA) or higher is required. A larger, higher resolution screen gives a better modeling experience.

256 MB of RAM or more is recommended. More memory and faster processors improve runtime.

DPL 7 is compatible with previous releases of DPL. Decision Analysis Project files (.da) from DPL 4.0, 5.0 and 6.0 can be loaded into DPL 7. If the file contains an Endpoint Database\(^\text{TM}\), it will not be loaded. Note that .da files are called Decision Analysis Workspace files in DPL 7.

You can import DPL Influence Diagram files (.inf) from DPL 3.x into a DPL 7 Workspace using File | Import. You can also import DPL Program files (.dpl) in the same manner.

You can "back save" a DPL 7 Workspace file to either a DPL 4.0, 5.0 or 6.0 Decision Analysis Project file using File | Save As. Some information for new features in DPL 7 may be lost. In particular, if you have an Endpoint Database\(^\text{TM}\) in the DPL 7 Workspace file, it will not be saved to the earlier version file.
www.syncopation.com
## Appendix C: Keyboard Shortcuts

### Table of Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Action</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Conditioning</td>
<td>Ctrl+Y</td>
</tr>
<tr>
<td>Change Node Type</td>
<td>Ctrl+T</td>
</tr>
<tr>
<td>Clear Memory (delete unsaved Endpoint Database™, Policy Tree™, Risk Profile, etc.)</td>
<td>F9</td>
</tr>
<tr>
<td>Clear All Output associated with Model</td>
<td>Ctrl+Shift+F9</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl+C; Ctrl+Insert</td>
</tr>
<tr>
<td>Copy picture</td>
<td>Ctrl+I</td>
</tr>
<tr>
<td>Cut</td>
<td>Ctrl+X; Shift+Delete</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete</td>
</tr>
<tr>
<td>Find</td>
<td>Ctrl+F</td>
</tr>
<tr>
<td>Go to Main Model</td>
<td>Ctrl+F12</td>
</tr>
<tr>
<td>Go to Node</td>
<td>F5</td>
</tr>
<tr>
<td>Graphics/Text Mode in Policy Tree™ and Policy Summary™</td>
<td>Tab</td>
</tr>
<tr>
<td>Help</td>
<td>F1</td>
</tr>
<tr>
<td>New Workspace</td>
<td>Ctrl+N</td>
</tr>
<tr>
<td>Open Workspace</td>
<td>Ctrl+O</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl+V; Shift+Insert</td>
</tr>
<tr>
<td>Play Endpoints</td>
<td>Alt+F10</td>
</tr>
<tr>
<td>Print</td>
<td>Ctrl+P</td>
</tr>
<tr>
<td>Redraw</td>
<td>Ctrl+R</td>
</tr>
<tr>
<td>Repeat Find</td>
<td>F3</td>
</tr>
<tr>
<td>Replace</td>
<td>Ctrl+H</td>
</tr>
<tr>
<td>Run Decision Analysis</td>
<td>F10</td>
</tr>
<tr>
<td>Run Monte Carlo Simulation</td>
<td>F11</td>
</tr>
<tr>
<td>Run Portfolio Analysis</td>
<td>Shift+F10</td>
</tr>
<tr>
<td>Run Tornado</td>
<td>F8</td>
</tr>
<tr>
<td>Save Workspace</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Snap to Grid</td>
<td>Ctrl+G</td>
</tr>
<tr>
<td>Switch Pane in Model Window</td>
<td>Tab</td>
</tr>
<tr>
<td>Undo</td>
<td>Ctrl+Z; Alt+←</td>
</tr>
<tr>
<td>View Workspace Manager</td>
<td>Alt+F12</td>
</tr>
<tr>
<td>View Properties</td>
<td>Alt+Enter</td>
</tr>
<tr>
<td>View Session Log</td>
<td>Shift+F12</td>
</tr>
<tr>
<td>View/Hide Project Window</td>
<td>F12</td>
</tr>
<tr>
<td>Zoom Full</td>
<td>Ctrl+L; Ctrl+Shift+R</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Ctrl+&gt;</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Ctrl+&lt;</td>
</tr>
<tr>
<td>Zoom Previous</td>
<td>Ctrl+E</td>
</tr>
</tbody>
</table>
www.syncopation.com
D Glossary of DPL and Decision Analysis Terms

Alternative: A state of a decision node or decision event. DPL chooses among alternatives during tree rollback to maximize (or minimize) the objective function. The set of alternatives for a decision is the range of possible actions to take for that decision.

Always Gamble: Tells DPL to always gamble on the outcome of a chance event overriding the "Don't Gamble" specification, which is used during the creation of an Event Tornado Diagram. Events with "Always Gamble" specified are never replaced by their expected values. See "Don't Gamble."

Arc: See Influence Arc.

Array: A one- or two-dimensional set of numbers. Arrays can be used to store related numbers, much as a look-up table is used in a spreadsheet. The syntax for a one-dimensional array is arrayname[column_subscript]. The syntax for a two dimensional array is arrayname[row_subscript][column_subscript]. Row and column subscripts start at zero, i.e., the first element of a two-dimensional array is arrayname[0][0].

Array Formulas: Operations in DPL ordinarily take scalars (single values) as operands and return scalars as results. When an operand that is ordinarily required to be a scalar is replaced with an array, the containing formula is said to be an array formula. An array formula must be enclosed in the special symbols { = and } (the notation used by Microsoft Excel).

Array Subscripts: Numbers or formulas used to reference the elements of an array. For example, arrayname[1][3] has subscripts of 1 and 3. Array subscripts can also be formulas.
**Arrowheads:** In the influence diagram, the color of an arc's arrowhead indicates the type of conditioning the arc implies. Black arrowheads indicate timing only; blue arrowheads indicate values only; green arrowheads indicate probabilities only; burgundy arrowheads indicate both values and probabilities.

**Asymmetric Node:** A decision tree node with branches that lead to different nodes.

**Attribute:** A measure of value (Profit, Health Effects, Environmental Effects) tracked for each path of a decision tree during an evaluation. Attributes are usually combined at each endpoint by an objective function, generating a single measure of value that is used during tree rollback. Probability distributions for each attribute and the objective function may be graphed separately.

**Base Case Tornado Diagram:** Used with probabilistic models; a diagram generated by evaluating the outcome of a model when each chance event is individually set to a high and a low state while all other chance events are set to a nominal state. The Base Case that the results are compared to is the result when all chance events are set to a nominal state.

**Base Result:** The expected value (and certain equivalent, if risk tolerance is used) of the objective function for the initial run of the model in a Value Tornado before any of the sensitivity variables are tested, i.e., with the model as currently defined in the Model Window. The Base Result also establishes the optimal policy for the model.

**Bayes' Rule:** A mathematical method for reversing the order of conditioning in chance events (e.g., used to assign probability when you have the probability of A given B, but need the probability of B given A). The formula for Bayes' Rule is:

\[
P(A_i|B) = \frac{P(A_i) \times P(B|A_i)}{P(A_1) \times P(B|A_1) + P(A_2) \times P(B|A_2) + \ldots + P(A_n) \times P(B|A_n)}
\]

**Beta Distribution:** A named distribution supported by DPL. For a detailed description see On-Line Help.
**Binomial Distribution:** A named distribution supported by DPL. For a detailed description see On-Line Help.

**Branch:** An element in a decision tree representing one state of an event. Decision node branches represent alternative choices and chance node branches represent possible outcomes.

**Branch Block:** A modeling option that temporarily removes one or more alternatives from consideration in a given decision node instance.

**Branch Control:** A modeling option that forces the outcome (or branch) of an event to a particular state in a decision tree.

---

**Certain Equivalent (CE):** The certain amount equivalent to the expected utility of the model, taking risk attitude into account. Specifically, the minimum guaranteed amount a decision-maker would accept in place of an uncertain lottery. When a utility function is specified, the certain equivalent is provided in addition to the expected value.

**Chance Node:** A node in the influence diagram or decision tree that represents an event whose outcomes are uncertain. Chance nodes can be either discrete or continuous.

**Chi Distribution:** A named distribution supported by DPL. For a detailed description see On-Line Help.

**Chi-Square Distribution:** A named distribution supported by DPL. For a detailed description see On-Line Help.

**Code:** A model, or part of a model, written in the DPL programming language. Can be viewed in a Program Window.

**Command Window:** A testing and debugging environment in which you can display or temporarily change any value or calculation in a model.
**Compilation:** Before running an analysis on a model, DPL compiles the model. During compilation, DPL checks for syntax and other errors and prepares the model for evaluation by the DPL engine.

**Conditional Decision Policy:** A policy containing decisions which will be made after initial uncertainties are resolved. The optimal alternative may depend on the state of the uncertainties, and may therefore be different in different parts of the decision tree.

**Conditioned:** When a value or event has separate numbers or formulas for either its values or probabilities or both depending upon the states of one or more other events. For example, if Costs = 0 if Develop Drug is No and Costs = Development Costs + Launch Costs if Develop Drug is Yes, then Costs is conditioned by Develop Drug. See also Dependency.

**Constraint Function:** An "if-then-else" expression that tests a condition and specifies different objective functions for true or false outcomes or prunes the tree, eliminating any further branches.

**Continuous Chance Node:** A node in an influence diagram or decision tree that represents an event whose outcomes are uncertain. A continuous chance node does not have a discrete number of states. To generate a distribution of outcomes for a continuous chance node, samples are continuously drawn from a named distribution. The graphical symbols for a continuous chance node are dark green ovals in the Influence Diagram and dark green circles in the Decision Tree.

**Control, Branch:** See Branch Control.

**Controlled Node:** A node in the influence diagram representing an event whose states are set as an action on a branch in a decision tree. Controlled nodes do not appear in the decision tree. The graphical symbol for a controlled node is a dark gray rectangle in the Influence Diagram. A controlled node is different from a controlled branch on a node (see Branch Control).

**Conversion:** DPL can convert spreadsheet models to blocks of DPL code. The resulting code can be included in DPL models or edited and run as a stand-alone DPL program.
**Cumulative Distribution:** a graph generated by DPL whose X-coordinates represent outcome values and whose Y-coordinates represent the sum of the probabilities of all possible outcomes less than or equal to the associated outcome value. In the Decision Analysis Options dialog box, you can choose to have DPL generate and display cumulative distributions for the optimal policy or all initial decision alternatives. Also, if you have defined more than one attribute for the model, a separate cumulative distribution for each of the attributes can be generated. The cumulative distributions are displayed in a Risk Profile Chart.

**Cycle:** A set of nodes and influence arcs that create a loop in which a node depends directly or indirectly on itself. An influence diagram may not include cycles.

**DDE:** See Dynamic Data Exchange.

**Decision Alternative:** See Alternative.

**Decision Node:** A node in the influence diagram or decision tree representing an event that the decision-maker has control over, i.e., an event with alternative choices for the decision-maker to choose among. During evaluation, the alternative that maximizes (or minimizes) the objective function is chosen. The graphical symbols for a decision node are a yellow rectangle in the influence diagram and a yellow square in the decision tree.

**Decision Sensitive:** A variable in a model such that when its value is changed, a different decision policy is optimal from that which is optimal for the variable at its current setting.

**Decision Tree:** A graphical representation of a decision model that displays the sequence of events including the order of decisions and uncertainties and when get/pay expressions occur.

**Decision Tree Pane:** A pane of the Model Window that provides a graphical interface to manipulate the decision tree in a model.
Default State: The state of an event that is user-defined as the "default" setting for purposes of linking to an Excel spreadsheet. If the state of an event is unknown for a particular path on an asymmetric tree, DPL assumes the event is in its default state. In versions of DPL prior to DPL 7.0, the first state of an event was the default. In DPL 7.0, the user defines the default state.

Default Tree: The decision tree that DPL builds automatically in the Decision Tree as you develop a model in the Influence Diagram. DPL builds the Default Tree based on the decision nodes, chance nodes, value nodes and influence arcs you define in the Influence Diagram. The Default Tree is always symmetric. DPL will continue to build the Default Tree until you edit the decision tree yourself directly in the Decision Tree.

Definition Section: A section of a DPL program which specifies and initializes the elements of a decision model — decisions, uncertainties, variables, values, series, arrays, etc. The influence diagram is a graphical representation of a definition section.

Dependency: Node B depends on node A if one of the data expressions for B includes A, but B does not have a separate data expression for each state of A. For example, if Revenues = Units * Price, then Revenues depends on Units and Price. See also Conditioned.

Deterministic Model: A model that only has deterministic relationships — there are no uncertainties. The model contains only value and decision variables, and yields a single output for a single set of inputs or setting of each variable. A spreadsheet is an example of a deterministic model.

Discrete Chance Node: A node in the influence diagram or decision tree that represents an event whose outcomes are uncertain. A discrete chance node models the uncertainty of the event with a discrete number of states (or outcomes). Probabilities are specified for each state or a named distribution is given. The graphical symbols for a discrete chance node are bright green ovals in the Influence Diagram and bright green circles in the Decision Tree.

Discrete Tree Simulation: Simulation method of evaluating models utilizing random sampling of discrete or discretized probability distributions (chance nodes) with a finite number of outcomes. See also Monte Carlo.
Display Function: A function that enables you to write text or formatted numbers to the Session Log during an analysis, allowing the writing of custom reports.

Distributed Sampling: A method of evaluating models based on Discrete Tree Simulation. In Distributed Sampling, the probabilities of nodes in the tree are represented exactly until the number of samples remaining at a node is small. At this point, normal Discrete Tree Simulation (selecting chance node outcomes randomly) is used for the rest of the tree.

Distribution: There are two types of probability distributions in DPL: 1. Chance node data specified as set of discrete states and associated probabilities. 2. Chance node data specified as a named distribution. See Named Distributions.

DLL: See Dynamic Link Library.

Don’t Gamble: A property assigned to a chance node that effectively reduces it to one branch. DPL replaces a chance event with its expected value if the "Don't Gamble" specification has been set. Subsequent variables depending on the state of this event will be assigned values calculated by taking the expected value over the event, where feasible.

Downstream Decision: A decision which occurs in a decision tree after initial uncertainties are resolved. Downstream decisions are sometimes called real options.

DPL Program: A description of a decision model in DPL's own language (i.e. DPL Code). It contains all the structure and data necessary to analyze a model and can be used in place of an influence diagram and decision tree, or as documentation for a graphic model.

Dummy Node: A node that represents an intermediate calculation in a model. It contains no data and is ignored during analysis. The graphical symbol for a dummy node is the same as a value node: a blue rounded rectangle in the Influence Diagram. Dummy nodes are included for clarity or communication only. Dummy nodes usually represent intermediate calculations in a linked spreadsheet. Dummy nodes do not appear in decision trees.
**Dynamic Data Exchange:** A Microsoft Windows communications protocol that allows Windows applications to communicate with each other. DPL optionally uses DDE to communicate with Excel. See also OLE Automation.

**Dynamic Link Library:** A file containing functions, instructions or programs for use by DPL during analysis.

**Enumerate Full Tree:** An evaluation method that evaluates each path of the tree completely. This is in contrast to Fast Sequence Evaluation.

**Endpoint:** The terminal point of each path through a decision tree. The number of endpoints (or leaf nodes) of a decision tree equals the number of paths through the tree. Endpoints are represented as blue triangles:

1. Each blue triangle in a Policy Tree™ is an endpoint.

2. In the Decision Tree because the decision tree is schematic, blue triangles can represent more than one endpoint. In the Decision Tree, an endpoint triangle serves as the point of connection when you add a node to the tree.

**Endpoint Database™** The complete set of endpoints that result from running a decision model. The Risk Profile for the best alternative of the initial decision of a model is created from the subset of endpoints in the Endpoint Database™ that are part of the optimal policy. Certain additional outputs can be created from the Endpoint Database™ without the need to re-run the entire model.

**Endpoint Database™, Displaying:** The process of displaying a recorded Endpoint Database™ in a spreadsheet-like tabular grid. Displaying of the Endpoint Database™ can take a significant amount of memory and may not be possible with very large models. Occasionally with large models, there is enough computer memory available to record, but not to display the Endpoint Database™.
**Endpoint Database™ Grid:** The spreadsheet-like tabular grid that displays the Endpoint Database™. The grid is a separate document from the Endpoint Database™ itself. A grid can be deleted and later regenerated from a recorded Endpoint Database™.

**Endpoint Database™, Recording:** The process of saving the Endpoint Database™ from a model run in order to re-use it later. Recording of the Endpoint Database™ can take a significant amount of memory and may not be possible on some computers with very large models. Recording the Endpoint Database™ is most appropriate and useful with models that have complex value models, and therefore have relatively long runtimes per endpoint calculation.

**Erlang Distribution:** A named distribution supported by DPL. For a detailed description see On-Line Help.

**Event:** A variable or node with a set of possible outcomes or alternatives. In DPL, decision nodes and chance nodes are events.

**Event Tornado Diagram:** a sensitivity analysis that compares the range of uncertainty of each chance event in a model.

**Expected Value (EV):** The probability-weighted average of all possible outcomes.

**Exponential Distribution:** A named distribution supported by DPL. For a detailed description see On-Line Help.

**Export Node / Export Variable:** A node linked to a specific cell in a spreadsheet to provide input for the spreadsheet model. DPL exports data to the cell. Data exported by DPL will overwrite any information contained in the cell.

**F**

**Fast Sequence Evaluation:** The default method of calculation DPL uses for an analysis. This is the fastest evaluation method that calculates the exact expected value. Certain model structures are not suitable for Fast Sequence Evaluation and should instead be analyzed using Enumerate Full Tree.
**Fat Policy™**: The capability of DPL to display in the Policy Tree™ the expected values of all attributes in addition to the objective function at any point in the tree.

**Frequency Histogram**: A view option in the Risk Profile Chart. It plots the probability of occurrence for intervals of outcome values as a vertical bar.

---

**Gamble**: An evaluation action taken by DPL for a chance event when evaluating a decision tree. When DPL gambles on a chance event, it creates the alternative outcomes of the chance event, assigns them a probability and determines the value of the objective function for each outcome.

**Gamma Distribution**: A named distribution supported by DPL. For a detailed description see On-Line Help.

**Gaussian Distribution**: (Also called Normal Distribution.) A named distribution supported by DPL. For a detailed description see On-Line Help.

**Geometric Distribution**: A named distribution supported by DPL. For a detailed description see On-Line Help.

**Get/Pay Expressions**: Expressions specified on branches of the decision tree to associate values with branches and endpoints. "Get" expressions are added to the value function and "Pay" expressions are subtracted. If a model has multiple attributes, the get/pay expression must contain expressions separated by commas for each attribute.

**Grid**: See Endpoint Database™ Grid.
Hide Intermediates: An option when creating a model from Excel that prevents intermediate cells from being displayed in the Cell Names dialog used to select which spreadsheet cells to include in the model. If intermediate are included, the linked nodes will be Dummy Nodes.

Hyperexponential Distribution: A named distribution supported by DPL. For a detailed description see On-Line Help.

Import Node / Import Variable: A node linked to a specific cell in a spreadsheet that retrieves the output of spreadsheet model calculations for use in DPL analysis. A DPL Import Node does not contain any data in DPL.

Influence Arc: an arc drawn from one node to another in an influence diagram. An influence arc indicates timing or conditional dependence of nodes. An arc from node A to node B means A influences B.

Influence Diagram: a graphical representation of the components of a decision problem — decisions, uncertainties, and values — and the relationships among them. Comprised of nodes and influence arcs.

Influence Diagram Pane: A pane of the Model Window that provides a graphical interface to manipulate the influence diagram in a model.

Initial Decision: A decision in a decision tree that occurs before any chance events.

Initial Decision Alternatives Tornado: A diagram that displays a Base Case Tornado for each alternative of the first decision node in the decision tree.

Initial Uncertainties: Chance events in a decision tree that occur before a downstream decision.
**Interval:** A subset within a Series in which (one or more) elements are given by the same expression. For example, a series defining the number of days in each year from 2005–2008 would have an Interval from 2005–2007 in which each element would have a value of 365. The Interval for 2008 would be a single element Interval with a value of 366.

**Joint Probability:** The probability associated with a particular set of outcomes for multiple separate events. The joint probability is calculated by taking the marginal probability for the selected outcome of each event and multiplying them together.

**Laplace Distribution:** A named distribution supported by DPL. For a detailed description see On-Line Help.

**Links:** Connections to spreadsheets, databases or DPL programs that allow DPL to perform calculations or obtain data.

**Local Variables:** Nodes that are not linked to a cell or cells in a spreadsheet; to a record in a database; nor to a DPL program.

**Logistic Distribution:** A named distribution supported by DPL. For a detailed description see On-Line Help.

**Lognormal Distribution:** A named distribution supported by DPL. For a detailed description see On-Line Help.

**Lottery:** An event whose outcome depends on chance.
**Main Model:** The Main Model in a Workspace is the model that will be run when you select any of the analyses in the Run menu. If you delete the Main Model from a Workspace and select an analysis from the Run menu, DPL will find the first model in the Workspace, set it to be the Main Model and do the run.

**Marginal Probability:** The probability that a given outcome of a chance event will occur. For example, if there is an even chance of sun or rain, the Marginal Probability of rain is 0.5.

**Maximize:** Instructs DPL to choose the decision policy that returns the maximum expected value for the Objective Function.

**Maxwell Distribution:** A named distribution supported by DPL. For a detailed description see On-Line Help.

**Minimize:** Instructs DPL to choose the decision policy that returns the minimum expected value for the Objective Function.

**Model Window:** Graphical interface for designing decision models and running analyses. Contains both the Influence Diagram Pane and the Decision Tree Pane.

**Modified Monte Carlo Simulation:** method of evaluating models based on Discrete Tree Simulation. In Modified Monte Carlo, samples are first allocated to branches of chance events using the branch probabilities rather than completely random sampling.

**Monte Carlo Simulation:** Method of evaluating models utilizing random sampling of continuous probability distributions (chance nodes) with a set sample size. See also Discrete Tree Simulation.
Multi-attribute Utility Analysis (abbreviated MUA or MAU): A method for making decisions where the value function depends on more than one factor, such as cost and schedule. DPL allows you to track multiple attributes using independent value expressions and combine them in a single utility function.

Multidimensional Value Nodes: Value nodes that refer to one- or two-dimensional arrays or a series in a DPL model.

Name: A string of characters used to identify a node, string or constant. Nodes will be referenced by their names when used as variables.

Named Distributions: Pre-defined probability distributions which can be assigned to chance events in DPL based on input for one or more parameters. DPL supports 21 different Named Distributions, such as the Normal Distribution and the Beta Distribution.

Negative Binomial Distribution: A named distribution supported by DPL. For a detailed description see On-Line Help.

Node: A graphical representation of a decision, value, uncertainty, strategy table, or controlled event.

Normal Distribution: (Also called Gaussian Distribution.) A named distribution supported by DPL. For a detailed description see On-Line Help.

Objective Function: An expression defining the quantity to be optimized during the analysis. Generally used to express the relationship between multiple attributes.

OLE Automation: A Microsoft Windows protocol that allows one Windows application to control another. DPL normally uses OLE Automation to communicate with Excel. OLE Automation may be slower than DDE but is more robust.
**Optimal Policy:** A set of decision alternatives that optimize the Objective Function.

**Optimization:** Allows DPL to take advantage of special structural properties of the model to reduce computation time.

**Option Value Chart:** A chart that displays the "option value", or incremental value added by flexibility in each downstream decision in the tree.

**Outcome:** A state of a chance node or chance event that DPL evaluates during rollback by combining together the probability associated with the outcome and the value associated with the outcome to calculate its expected value.

---

**Pascal Distribution:** A named distribution supported by DPL. For a detailed description see On-Line Help.

**Perform Subtree:** A technique allowing you to repeat a section of a decision tree in more than one place in the decision tree. Allows the subtree to be drawn once and performed several times.

**Poisson Distribution:** A named distribution supported by DPL. For a detailed description see On-Line Help.

**Policy Summary™:** An output generated by DPL which displays each event and its associated distribution under the optimal policy resulting from the analysis. You can also use the Policy Summary™ to compare the optimal policy distributions to distributions associated with a range of the Risk Profile or to when a decision or chance is in a particular state.

**Policy Tree™:** A graphical representation of the optimal policy for every decision in a model given the outcomes of all the uncertainties in the model. Shows all possible paths through a decision tree and indicates the value of all expressions in the model, the probabilities associated with each chance event outcome, the rollback values (EV or CE) for each node, and the optimal policy choices for each decision.
**Prob Function:** A function that returns the probability of an event at any point in an analysis at which the state of the event is unknown. This function is useful in decision problems in which the probability of an event is itself a major consideration in making decisions.

**Probabilistic Model:** A model in which some inputs are described with probability distributions and which generates probability distributions as outputs. A probabilistic model in DPL has at least one chance event. If the model has been developed graphically in the Model Window then a probabilistic model will have either continuous or discrete chance nodes or both.

**Program Window:** Provides an interface for creating, editing and compiling DPL program files. Converted spreadsheets can be viewed in this window.

**Promoting Terms:** Moving elements of get/pay expressions to nodes which are encountered earlier in the evaluation. The advantage to this approach is that terms can be calculated in the tree as soon as all conditioning events are in known states, rather than waiting until the end of the path to calculate all the terms at once. In general, promoting terms reduces run time.

**Rainbow Diagram:** An analysis tool which varies a single value over a user specified range and displays the impact on the expected value or certain equivalent and changes to the optimal decision policy.

**Rayleigh Distribution:** A named distribution supported by DPL. For a detailed description see On-Line Help.

**Real Option:** See Downstream Decision.

**Reduction:** A DPL tool used to reduce an output probability distribution (Risk Profile) to a single chance event. The reduced event will be described by a discrete probability distribution with a user specified number of states. The output in the form of DPL code is written to the Session Log or pasted as a discrete chance node to a specified model.
**Risk Attitude:** Decision-maker’s willingness to gamble relative to the expected value. One who is not willing to gamble in the face of a positive expected value is ''risk averse,'' while one who is willing to gamble in the face of a negative expected value is ''risk seeking.'' One who makes decisions based on expected value is ''risk neutral.''

**Risk Profile:** The probability distribution for a specified policy comprised of the entire range of outcomes that are possible given the policy.

**Risk Profile Chart:** A window displaying a probability distribution for a specified policy. A Risk Profile Chart displaying a cumulative probability distribution of the optimal policy is a typical output of a DPL decision analysis.

**Risk Profile Dataset:** The underlying probability distribution data for a specified policy, which is typically displayed in a Risk Profile Chart. Risk Profile Datasets may be saved in a Workspace without being displayed in a Risk Profile Chart.

**Risk Tolerance Coefficient:** Measure of the decision-maker’s attitude towards risk. Common definition for risk tolerance $r$ is the highest value for which you would accept a gamble in which you could win $r$ or lose $r/2$ with equal probability. In DPL, the Risk Tolerance Coefficient describes the incorporation of risk when the built-in exponential utility function is used.

**Roll Forward:** The first phase of a DPL decision analysis run, in which DPL calculates an outcome value and joint probability for each path in the decision tree. As each path is traversed, get or pay expressions are evaluated and combined to provided the path outcome value. If the model uses multiple attributes, each endpoint will have multiple outcome values.

**Roll Back:** The third phase of a DPL decision analysis run, in which DPL uses the outcome values and joint probabilities of each endpoint to calculate expected values or expected utilities at each node in the decision tree. At each chance node in the Rollback procedure, DPL determines the expected utility/value by calculating the probability-weighted average of outcome values. At each decision node in the Rollback, DPL determines the alternative providing the maximum or minimum value, as appropriate. The aggregate of these optimal decision alternatives comprises the optimal decision policy.
Rolled-back Expected Value: The value of the objective function at a node in the Policy Tree™ given the states of all preceding events on the path leading into the node, and the expected value of all subsequent outcomes of chance events and the optimal selection of alternatives for all subsequent decision events.

Root Node: The node on the decision tree that does not have any branches leading into it (the first node on the far left of the decision tree). Every tree contains a root node.

Sampling: Approximating a full range of outcomes by evaluating a subset number of paths.

Scenario: A path through the tree, from the root to an endpoint, that is a combination of specific decision alternatives and chance event outcomes. This path, a Scenario, represents a single possible state of the world.

Scenario Risk Profile™: A Risk Profile in which the scenarios included in the Risk Profile are restricted to a particular subset of the optimal scenarios, e.g., a particular combination of states of one or more events. A Scenario Risk Profile™ can be specified from either the Policy Tree™ or via a dialog.

Schematic Diagram: A type of decision tree diagram that does not show a full representation of the tree. Most decision trees appear as schematic diagrams in the Model Window.

Sensitivity Analysis: Allows you to investigate the impact of a node or group of nodes on the Expected Value and/or Optimal Policy of a model. There are many types of Sensitivity Analyses. See Rainbow Diagram, Two-Way Rainbow Diagram, Value Tornado Diagram, Base Case Tornado Diagram, Initial Decision Alternatives Tornado Diagram, and Event Tornado Diagram.

Separable Value Model: A model whose value function contains terms that are combined together by addition and subtraction. It is possible to promote terms in these models, which may allow for faster calculations.
**Sequence Section:** Systematic English-language descriptions of decision tree structures written in DPL code. The Sequence Section tells DPL in what order to evaluate nodes and get/pay expressions.

**Series:** A type of variable that allows you to define a one-dimensional set of values/formula using intervals. Subsequent elements of a series can depend upon earlier elements. Similar to a set of formulas in a row in Excel where column n + 1 depends upon column n.

**Session Log:** A window which maintains a record of the DPL session. Error messages and DPL commands performed in the Model Window will be automatically written to the Session Log. Information from an analysis can also be written to the Session Log (see Display Function).

**Spreadsheet Model:** A spreadsheet which contains a set of calculations which evaluates one scenario of a decision analysis. DPL links to the spreadsheet model in order to rapidly evaluate a wide range of scenarios based on specified levels of uncertainty.

**Spreadsheet Conversion:** See Conversion.

**State:** One of a discrete number of possible settings for an event. The states of a decision event are referred to as alternatives. The states of chance event are referred to as outcomes. Each branch of an event in the decision tree represents a state.

**State Function:** A function that returns a numerical value representing the state of an event. It can be used to process and test any event's state.

**Statename Function:** Returns the name of a state of an event as a string ("High", "Low", etc.)

**Strategy:** A single set of alternatives for all of the decisions contained in a Strategy Node.
**Strategy Node:** A node which represents a set of decisions to be made at one point in time. The different alternatives in a strategy node are called strategies. The complete set of strategies in a strategy node is referred to as a strategy table. Each strategy is defined by an alternative for each decision included in the strategy node. The graphical symbol for a strategy node is a yellow rectangle in the Influence Diagram with attached yellow rectangles for each decision node that is contained in the strategy node. In the Decision Tree, the graphical symbol is a yellow square. During evaluation a strategy node is evaluated in the same manner as a decision node, i.e., one alternative is chosen that maximizes (or minimizes) the objective function.

**Strategy Table:** A collection of decision nodes and a set of defined strategies in a strategy node.

**Subscript:** Used to reference particular elements of an array or series. For a series a subscript ranges between the lower and upper boundaries of the series. For using subscripts with arrays, see Array Subscripts.

**Subtree:** A section of decision tree from a given node in the tree forward (i.e., to the right).

**Symmetric Node:** A node in a decision tree whose branches all lead to the same subsequent event.

**Symmetric Tree:** A decision tree in which every node is symmetric.

**Time Series Percentiles:** A graph that displays the range of outcomes over several time periods (e.g., yearly cash flows over a 10 year period).

**Tolerance:** See Risk Tolerance Coefficient.

**Tornado Diagram:** A sensitivity analysis that displays the value and policy impacts of varying input values. See Value Tornado Diagram, Base Case Tornado Diagram, Initial Decision Alternatives Tornado Diagram, and Event Tornado Diagram.

**Triangular Distribution:** A named distribution supported by DPL. For a detailed description see On-Line Help.
Two-Way Rainbow Diagram: An analysis tool which varies two values over user-specified ranges and displays the impact on the expected value, or certain equivalent, and changes to the optimal decision policy.

Uncertainty: See Chance Nodes.

Uniform Distribution: A named distribution supported by DPL. For a detailed description see On-Line Help.

User Library: A Dynamic Link Library (DLL) file which contains a set of functions or a program (to be run during a DPL analysis) and language that allows communication with DPL. User Libraries are called from commands in the decision tree or program file.

User Library Function: An external set of commands which perform a routine or calculation during a DPL analysis. User Library Functions are stored in a User Library, which has a file extension of .DLL.

Utiles: The unit of measurement for the transformation performed by the Utility Function. In a model incorporating risk tolerance, DPL selects the policy which maximizes the expected utility (i.e. greatest utile value). The inverse of the utility function converts utiles to certain equivalents.

Utility Function: A mathematical expression which captures the decision-maker’s Risk Attitude. The Utility Function translates the outcomes of a value model into utiles. In DPL, the built-in exponential utility function is defined as: \( u(x) = -e^{-x/r} \), where \( x \) is the value to be converted to utiles and \( r \) is the risk tolerance coefficient. Alternatively, you may specify a user-defined utility function.

Value Correlations Chart: A chart that displays the correlation coefficient between each value in the model (including values associated with decision and chance events) and the objective function. Value Correlations Charts help you determine which variables may be driving your objective function in either a positive or negative direction.
**Value Model:** A model that defines a particular value of interest (e.g., costs, profits, social welfare) from other data. A DCF (discounted cashflow) valuation spreadsheet is an example of a value model.

**Value Node:** A node in the influence diagram representing a number or an expression. Its graphical symbol is a blue rounded rectangle.

**Value of Control:** The difference between the expected value of the model and the expected value of the model when a particular uncertainty is changed into a decision.

**Value of Perfect Information:** The difference between the expected value of the model and the expected value of the model when the outcome of a particular uncertainty is known before a decision is made.

**Value Tornado Diagram:** Evaluates the outcome of a model when a selected set of variables are each set individually to high and low values while all other variables are treated in the way in which they are defined in the base model. If the model is deterministic than all other variables are held at their current value. If the model is probabilistic, then all other variables are allowed to take on their full range. The low and high results for each variable are compared to the results of the full model run (called the Base Result). When used on a deterministic model, the diagram is used to help determine which variables have the greatest effect on the objective function and/or are decision sensitive, if applicable. Those variables with the greatest impact or which are decision sensitive may subsequently be modeled as uncertainties. When used with probabilistic models, Value Tornado Diagrams can only be run on individual states of events or conditioned values. For probabilistic models, Value Tornado Diagrams may not be as useful as Event Tornado Diagrams or Base Case Tornado Diagrams.
Weibull Distribution: A named distribution supported by DPL. For a detailed description see On-Line Help.

Workspace Manager: A window in DPL that lists all documents and stored Risk Profile data associated with the current Workspace. The Workspace Manager can be used to rename or delete items, access saved data or switch to another window. The Workspace Manager in DPL7.0 replaces the Project Manager window in earlier versions of DPL.
Index

alternative/outcome grouping
  asymmetric ........................................... 253
  mixed .................................................. 281
asymmetric alternative/outcome grouping ................. 253
asymmetric tree .......................................... 249
attachment points ..................................... 254
Base Case Tornado ...................................... 59
Bayesian revision ....................................... 285
blue triangle ............................................. 254
calculation links ....................................... 131
  establishing ........................................... 336
Cell Names dialog ....................................... 171
certain equivalent ..................................... 312
change node types... See node types, changing
compatibility ............................................. 355
Conditioning
  via arc type ........................................... 37
  via Node Definition ................................... 32
continuous chance node ................................ 222
data input tree
  selection in ......................................... 33
Decision Analysis Options ............................. 67
decision node ............................................. 29
decision sensitive ....................................... 49
decision tree
  adding nodes (drag/drop method)
    ...................................................... 276
  attaching nodes ..................................... 254
  detaching nodes ..................................... 275
  moving nodes ......................................... 254
Decision Tree Pane ..................................... 7
default arc types ....................................... 293
default state .......................................... 263
Default Tree ........................................... 31, 35, 104
deterministic ........................................... 136
discrete chance node ................................... 50
default probabilities ................................... 54
default values .......................................... 54
Distribution Output Options ............................ 68
downstream decisions
  adding .................................................. 272
DPL variable names ..................................... 20
error
  Influencing event not in a known state ................... 262
Evaluation Method ...................................... 67
event tornadoes ......................................... 326
  combination .......................................... 327
deterministic .......................................... 326
  probabilistic ......................................... 326
exit option ............................................... 272
expected value of perfect information
  / control .............................................. 107
export nodes ............................................. 125
Get/Pay expressions
  adding to tree ........................................ 258
  deleting ............................................... 278
  drag/drop method .................................... 268
  using multiple ....................................... 265
imperfect information ................................... 286
import nodes ............................................. 125
influence arc
  create short cut ...................................... 32
  timing .................................................. 104
influence arcs .......................................... 24
  arrowhead colors ...................................... 304
  bending ............................................... 36
  changing types ....................................... 294
default types .......................................... 293
summary .................................................. 304
Influence Diagram Pane .................................. 7
Initial Decision Alternatives tornado
  .......................................................... 64, 194
initialization links ..................................... 131
  adding .................................................. 196
  establishing .......................................... 344
  for conditioned nodes ............................... 348
intermediates ............................................ 125
keyboard shortcuts ...................................... 357
learning ................................................. 285
Main Model ............................................... 58
mixed alternative/outcome grouping .................................................. 281
Model Get/Pay Dialog .......................................................... 134
Model Toolbar Buttons ......................................................... 9
Model Window ................................................................. 7
    splitter ................................................................. 7
models
    building .......................................................... 15
    duplicating .................................................. 142
    spreadsheet-linked ............................................. 121
Monte Carlo simulation .................................................. 205
named cells ........................................................ 126
naming models ........................................................ 23
node
    links ..................................................................... 131
node data
    viewing lengthy ...................................................... 202
Node Definition dialog ................................................... 17
    data input tree .................................................. 18
node types
    changing ........................................................ 50
nodes
    creating linked values from Excel ........................................ 265
Perform Reference ......................................................... 300
    perform subtree .................................................. 299
Perform Target ............................................................... 300
policy dependent probability .......... 106
Policy Output Options .................................................. 69
Policy Summary™ ......................................................... 106
Policy Tree™ ............................................................... 71
data elements .......................................................... 75
    expand to level .................................................. 256
Format | Display .............................................................. 77
    introduction ........................................................ 42
    node expansion .................................................. 73
probabilistic ................................................................. 142
rainbow diagrams
    policy changes .................................................. 323
Rainbow Diagrams .......................................................... 112
results
    View | EV(CE) .................................................. 312
Risk Profile
    cumulative ........................................................ 79
Formatting ................................................................. 80
initial decision alternatives .......... 303
number of intervals ......................... 79
reading cumulative ................................. 79
statistics .............................................................. 83
Risk Profile dataset
    renaming .......................................................... 161
Risk Profiles
    charts .............................................................. 78
    datasets .......................................................... 186
    initial decision alternatives .......... 191
    risk tolerance .................................................. 307
    coefficient ..................................................... 311
    sensitivity analysis
        comparison of types .................................. 332
        types ........................................................ 317
Session Log ................................................................. 6
    spreadsheet links .............................................. 335
    calculation .................................................... 335
    initialization .................................................. 335
    managing ......................................................... 352
    types ............................................................ 335
    spreadsheet-linked models ................. 121
subtree
    performing ..................................................... 299
    system requirements ....................................... 355
    Tree-based dependency checking ........ 262
two-way rainbow diagram ................. 317
utility function ......................................................... 314
Value Correlations ......................... 109
    value node ...................................................... 15
    create ........................................................... 16
    value of perfect information / control
        ............................................................. 107
Value Tornado ............................................................. 43, 47
    color changes ................................................ 47
    setup ............................................................. 44
    View | Values ................................................ 49
    variable names ............................................... 127
Workspace Manager ................................................. 5
    non-window items ........................................ 78